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Preface

Welcome to the Mutation Surveyor User’s Manual. The purpose of the Mutation Surveyor 
User’s Manual is to answer your questions and guide you through the procedures necessary 
to use the Mutation Surveyor application efficiently and effectively.

Using the manual
You will find the Mutation Surveyor User’s Manual easy to use. You can simply look up the 
topic that you need in the table of contents or the index. Later, in this Preface, you will find a 
brief discussion of each chapter to further assist you in locating the information that you 
need.

Special information about the manual
The Mutation Surveyor User’s Manual has a dual purpose design. It can be distributed 
electronically and then printed on an as-needed basis, or it can be viewed online in its fully 
interactive capacity. If you print the document, for best results, it is recommended that you 
print it on a duplex printer; however, single-sided printing will also work. If you view the 
document online, a standard set of bookmarks appears in a frame on the left side of the 
document window for navigation through the document. For better viewing, decrease the 
size of the bookmark frame and use the magnification box to increase the magnification of 
the document to your viewing preference.

Conventions used in the manual
The Mutation Surveyor User’s Manual uses the following conventions:

• Information that can vary in a command—variable information—is indicated by 
alphanumeric characters enclosed in angle brackets; for example, <Mutation ID>. Do not 
type the angle brackets when you specify the variable information.

• A new term, or term that must be emphasized for clarity of procedures, is italicized.

• Mutation Surveyor provides multiple ways of accessing the same Mutation Surveyor 
functions (for example, a main menu option and a toolbar button). For brevity and ease of 

If you do print the document using a single-sided printer, you might see a single 
blank page at the end of some chapters. This blank page has been added solely to 
ensure that the next chapter begins on an odd-numbered page. This blank page in 
no way indicates that your book is missing information.
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use, this manual references only one method—the main menu—for accessing functions; 
however, you can use whatever method best suits your working needs.

• Page numbering is “online friendly.” Pages are numbered from 1 to x, starting with the 
cover and ending on the last page of the index.

• This manual is intended for both print and online viewing.

• If information appears in blue, it is a hyperlink. Table of Contents and Index entries 
are also hyperlinks. Click the hyperlink to advance to the referenced information.

Assumptions for the manual
The Mutation Surveyor User’s Manual assumes that:

• You are familiar with windows-based applications and basic Windows functions, 
navigational elements, and icons such as the Printer Setup icon on a Print Preview page.

• References to any third party standards or third party software functions were current 
during the development and release of this version of Mutation Surveyor. 

Organization of the manual
In addition to this Preface, the Mutation Surveyor User’s Manual contains the following 
chapters and appendices:

• Chapter 1, “Getting Started with Mutation Surveyor,” on page 21 details the Mutation 
Surveyor installation requirements, and the procedures for installing and upgrading the 
application. It also describes how to launch Mutation Surveyor and it provides an 
overview of the major navigational elements in the application.

• Chapter 2, “Project Setup,” on page 53 guides you through the necessary steps for setting 
up a project in Mutation Surveyor.

• Chapter 3, “Graphical Analysis Display,” on page 79 details the layout and functions of 
the Graphical Analysis Display, which visually presents mutation project data.

• Chapter 4, “Mutation Surveyor Graphical Reports,” on page 101 details the variety of 
graphic-based standard reports that are available in Mutation Surveyor for providing 
detailed information about a mutation project. The chapter contains a summary of 
descriptions, report field labels, report functions, and report caveats for all the various 
standard mutation reports.

Although numbering begins on the cover page, this number is not visible on the 
cover page or front matter pages. Page numbers are visible starting with the first 
page of the table of contents.
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• Chapter 5, “Mutation Surveyor Standard Reports,” on page 127 details the variety of text-
based standard reports that are available in Mutation Surveyor for providing detailed 
information about a mutation project. The chapter contains a summary of descriptions, 
report field labels, report functions, and report caveats for all the various standard 
mutation reports.

• Chapter 6, “Mutation Surveyor Custom Report,” on page 165 details the Custom report, 
which contain options for building a tailored report that provides detailed information 
about your mutation projects in a format that best suits your specific working needs. 

• Chapter 7, “Mutation Surveyor Customer Reports,” on page 185 details the various 
customer report templates in Mutation Surveyor. Each report was initially developed as a 
template to provide custom content that met a specific customer’s needs. All these report 
templates are now available from the Reports > Customer Reports option on the Mutation 
Surveyor main menu.

• Chapter 8, “GenBank File Editors,” on page 227 details the tools that are specifically 
designed for editing GenBank files and Sequence files.

• Chapter 9, “Mutation Surveyor Tools,” on page 263 details the variety of tools that are 
available in Mutation Surveyor for optimizing input data and analyzing results.

• Chapter 10, “Mutation Surveyor Specialized Applications,” on page 327 details the use 
of Mutation Surveyor for some specialized applications.

• Chapter 11, “Multiple Projects,” on page 341 details Mutation Surveyor’s capabilities for 
modifying existing projects and for working with multiple projects.

• Chapter 12, “Reviewing and Editing Mutation Projects,” on page 355 details the functions 
and the tools that are available in Mutation Surveyor for adding and editing mutation calls 
in a project.
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Chapter 1
Getting Started with Mutation 
Surveyor

The Mutation Surveyor software application uses patented anti-correlation technology to 
provide highly accurate discovery of DNA variants from Sanger sequencing traces. This 
software is ideal for the analysis of data from Applied Biosystems, Beckman-Coulter and 
MegaBACE systems. This chapter details the installation requirements, and the procedures 
for installing and upgrading the application. It also describes how to launch Mutation 
Surveyor and it provides an overview of the major navigational elements in the application. 
It also details how to configure user management for your Mutation Surveyor instance.

This chapter covers the following topics:

• “Mutation Surveyor System Requirements” on page 23.

• “Installing Mutation Surveyor” on page 24.

• “Starting Mutation Surveyor” on page 26.

• “Mutation Surveyor Conventions” on page 27.

• “The Mutation Surveyor Main Window” on page 29.

• “Configuring User Management” on page 34.

• “Managing Groups in Mutation Surveyor” on page 42.

• “Managing Users in Mutation Surveyor” on page 47.
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Mutation Surveyor System Requirements
Mutation Surveyor is supported only on Windows and Intel-powered Macintosh operating 
systems. It is not supported on Linux or UNIX-based operating systems. Mutation Surveyor 
recognizes only PC file formats. If you are running Mutation Surveyor on an Intel-powered 
Macintosh OS, you must use the ABI PRISM 3100 Genetic Analyzer Conversion Utility to 
convert the Macintosh files formats to PC file formats before you can analyze the files with 
Mutation Surveyor. You can download this utility at http://www.appliedbiosystems.com/
support/software/3100/conversion.cfm.

System Requirements

Windows PC • Operating System—Mutation Surveyor can function on Windows 32- 
or 64-bit systems with x86 architecture. Mutation Surveyor is 
compatible with the following Windows operating systems: Windows 
Vista, Windows 7, Windows 8, Windows Server 2008 R2, Windows 
Server 2012 R2.   

• Processor—Dual core with 1.8 GHz

• RAM: 2 GB

• Available hard drive space: 60 GB       

Intel Powered 
MacIntosh

• Operating System—Parallels desktop for Mac (Mac OS/virtual 
machine dependent) or Apple, Boot Camp or VMware Fusion (Mac 
OS/virtual machine dependent) 

• RAM: 2 GB

• Available hard drive space: 60 GB       
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Installing Mutation Surveyor

Mutation Surveyor is licensed in three different ways, each of which follow slightly different 
installation procedures—Validation, Local, and Network:

• Validation license—The Validation license is a trial license that provides all the 
functionality of a purchased license. You can load data, create and save new files, analyze 
and visualize data, and so on. The Validation license does not require an operating key 
and you can install this version on an unlimited number of computers. The Validation 
license expires 35 calendar days from installation.

• Local license—The Local license is for installation on a a single computer.

• Network license—The Network license is for installation on multiple client computers 
that are connected to a license server computer.

To install Mutation Surveyor

The Mutation Surveyor Installation wizard guides you through the steps that are necessary to 
install a Mutation Surveyor license. The default installation location is 

C:\Program Files (x86)\SoftGenetics\Mutation Surveyor

but you can always select a different installation directory.

When you are installing Mutation Surveyor, keep in mind the following:

You must have Administrator rights for the computer on which you are installing 
Mutation Surveyor. 

You must contact SoftGenetics to receive a disc that contains a fully functional, 35 
day trial of the software.

Version Comments

Validation Accept the default Program Manager Group to ensure that program 
operability is not negatively affected.

Local • An operating key is supplied with a Local license. Make sure that you 
follow the specific installation instructions that are included with the 
key.

Note: After you have installed the operating key on a computer, you 
should not remove it; otherwise, you might need to reset the 
computer to accept the operating key again.

• Accept the default Program Manager Group to ensure that program 
operability is not negatively affected.

• At the prompts to enter your registration information, enter the 
information exactly as SoftGenetics supplied it to you.
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Network • If you have a USB dongle and a 32-bit OS, then you can use the 
NetDog License Manager; otherwise, you must the SoftGenetics 
License Server Manager.

• At the prompts to enter your registration information on the server 
computer, enter the information exactly as SoftGenetics supplied it to 
you.

Version Comments
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Starting Mutation Surveyor
After Mutation Surveyor has been installed on your computer, a shortcut icon for the 
application is placed on your desktop. An option for the application is also available from 
your Start menu. You can double-click the desktop icon to open Mutation Surveyor, or you 
can select the option from your Start menu.

Figure 1-1:  Mutation Surveyor desktop icon

Figure 1-2:  Mutation Surveyor main window

If your Mutation Surveyor administrator has configured User Management for 
your Mutation Surveyor instance, then you are prompted to enter a user name and 
password before Mutation Surveyor opens. Contact your administrator if you need 
assistance.
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Mutation Surveyor Conventions
Mutation Surveyor uses conventions in both its terminology (genomic terms and mutation 
terms) and its output to ensure consistency and accuracy when you are manipulating and 
analyzing mutation project data. 

Genomic terms

In genomics, the same term or definition can have multiple meanings or interpretations. As a 
result, you must know how specific genomic terms are defined for use in Mutation Surveyor. 
Figure 1-3 shows a sequence region which contains a gene model. Mutation Surveyor uses 
the following terms to define the different areas of a gene:

• (A)—The sequence, which is the complete order of nucleotides in a gene. 

• (B)—mRNA, which is a region in a gene that contains part of the reading frame that codes 
for a specific portion of the complete protein. mRNA regions can include sequences that 
code for amino acids (red fill in Figure 1-3) and untranslated sequences (no fill in Figure 
1-3). 

• (C)—CDS, or the coding sequence, which is a DNA region in a gene that is translated into 
protein.

• (D)—Intron, which are the regions of the precursor mRNA that are spliced out to make 
the mature mRNA. These introns might be within the untranslated region of the mRNA 
or they might be between CDS regions of mRNA.

Figure 1-3:  Mutation Surveyor genomic terms

Mutation terms

The following list details how specific types of mutations are defined in Mutation Surveyor:

• Silent—Coding and non-coding mutations that do not affect the amino acid sequence.

• Synonymous—Mutations found only in the coding region that do not affect the amino 
acid sequence.
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• Non-synonymous—Mutations found only in the coding region that affect the amino 
acid sequence.

• Nonsense—A non-synonymous mutation that results in a stop codon.

• Mosaic—Might be used in place of somatic mutations (2D small peak) or 
heteroplasmy.

Reports and graphical output

• When analyzing samples from a polyploid organism, Mutation Surveyor displays the 
results for only the two dominant alleles (the alleles with the two highest frequencies) in 
any report or graphical display.

• Mutation Surveyor supports both standard and non-standard genetic codes as defined in 
Version 3.9 of the NCBI Genetic Code table. (See ftp://ftp.ncbi.nih.gov/entrez/misc/data/
gc.prt.) To analyze samples that require translation using a non-standard genetic code, the 
GenBank file must contain the correct Translation table number. If the GenBank file does 
not contain this information, Mutation Surveyor defaults to using standard genetic code.
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The Mutation Surveyor Main Window
The Mutation Surveyor main window is your starting point for the Mutation Surveyor 
application. The window provides quick access to all the Mutation Surveyor functions and 
system tools. The Mutation Surveyor main window has five major components—the title 
bar, the main menu, the toolbar, the Browser pane, and the Viewing and Reporting pane.

Figure 1-4:  Mutation Surveyor main window

Title bar

The name “Mutation Surveyor” appears in the title bar at the top of the Mutation Surveyor 
main window.

Figure 1-5:  Title bar

Main menu

The main menu is set up in a standard Windows menu format with menu commands grouped 
into menus (File, Process, Display, Reports, Tools, and Help) across the menu bar. Some of 
these menu commands are available in other areas of the application.

Figure 1-6:  Main menu
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Main window toolbar

The toolbar provides quick access to all the Mutation Surveyor functions. Figure 1-7 below 
shows the Mutation Surveyor toolbar after the application first opens. The Mutation 
Surveyor toolbar is updated dynamically with other toolbar buttons based on the files that 
you load and/or the post-processing steps that you select. Place your mouse pointer over a 
toolbar button to open tooltip text for the button.

Figure 1-7:  Mutation Surveyor Toolbar

Browser pane

The Browser (left) pane is arranged in a classic Windows Explorer-style folder structure. The 
top-level folders are the File folder and the Contig folder. The File folder contains up to three 
sub-level folders—GenBank File, Reference File, and Sample File—which contain the 
GenBank files, the reference files, and the sample files, respectively. The Contig folder 
contains subfolders for each of the contigs that were created from the analysis. After you run 
a project for the first time, an entry also exists for the Mutation Report. (See Figure 1-8 on 
page 31.)

Button Description

Open Files—Opens the Open Files dialog box which you use to load GenBank files, 
references files, and sample files for a project.

Save Project—Saves all the project files to a single file mutation project file with an .sgp 
extension. You can open an entire project in a single step by opening this .sgp file. 

Raw Data to Processed Data—Enabled when AB1/ABI files without base call 
information are uploaded and Load Raw Data is selected for the Mutation Project 
settings. Converts the raw files so that base call information is displayed. 

Run—Runs the currently loaded project in Mutation Surveyor.

Restart—Opens the Options dialog box which you use to modify the current project 
settings. You can then run the project again using these new settings.

Show/Hide Browser—Shows/hides the Browser pane in the Mutation Surveyor main 
window.
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Figure 1-8:  Browser pane

To navigate the Browser pane

• To open a folder, click the Expand icon  next to the folder, or double-click the folder. 
To close a folder, click the Collapse icon  next to the folder.

• To view the raw trace for a file, double-click anywhere on the file entry. (The icon for the 
selected file turns green .) The trace opens in the Viewing and Reporting (right) pane. 
To clear the trace for a file, double-click anywhere on the file entry again. 

Figure 1-9:  Viewing a trace for a single file

For a detailed discussion about contigs and the Browser pane, see “Contig 
directory for a Mutation Surveyor project” on page 76.

CTRL-click to select multiple files to view their corresponding traces at the same 
time. 
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Figure 1-10:  Viewing traces for multiple files

• To view the Mutation report, double-click the Mutation Report entry. The Mutation report 
opens in the Viewing and Reporting pane. (See “Mutation Report” on page 129.)

Figure 1-11:  Mutation Report in the Viewing and Reporting pane
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Viewing and Reporting pane

The Viewing and Reporting (right) pane displays graphics, reports, and other information 
depending on the post-processing options that you have selected. 

Figure 1-12:  Viewing a trace in the Viewing and Reporting pane

Reports and views are discussed in the appropriate chapters in this manual.
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Configuring User Management
After Mutation Surveyor is installed, user management can be configured for it. User 
management requires that a user be authenticated before logging in and using the 
applications. You can configure user management independently for each computer 
(localhost) on which Mutation Surveyor is installed. In this configuration, the SoftGenetics 
Server service must be installed on each computer on which Mutation Surveyor is installed. 
Because the same user management configuration is part of the installation process for 
Geneticist Assistant and NextGENe, the steps that you must follow to install the 
SoftGenetics Server service depend on whether Geneticist Assistant and/or NextGENe has 
already been installed on the localhost. Alternatively, a single server can host the 
SoftGenetics Server service and you can configure each Mutation Surveyor host to connect 
to this single server to verify user credentials. When you configure user management, you 
must always configure the Administrator user account first. Only the Administrator user has 
all the necessary privileges for managing other users. All other users are standard users. 
After you configure user management, you must turn on user management. You can also 
always turn off user management at any time without deleting any of the user configuration 
information.

To configure user management

1. If Geneticist Assistant or NextGENe is already installed on the computer on which you 
are configuring user management for Mutation Surveyor, go to “To turn on user 
management” on page 38; otherwise, do the following:

• Log on to the host computer as a Windows user that is a local Administrator.

• To avoid issues with User Account Control settings, right-click on the Mutation 
Surveyor desktop shortcut and on the context menu that opens, select Run as 
administrator.

2. On the Mutation Surveyor main menu, click Help > User Management > Install Local 
Service.

The License page for the SoftGenetics Server Setup wizard opens. The page details the 
license agreement for installing the SoftGenetics Server service. 

If you changed the directory for storing the MySQL information that Mutation 
Surveyor uses from the default directory (C:\ProgramData\MySQL\MySQL Server 
5.1\Data), then before configuring user management, you must contact 
tech_support@softgenetics.com.

The following procedures details the configuration of user management 
independently for each computer (localhost) on which Mutation Surveyor is 
installed. To configure user management with a single server hosting the 
SoftGenetics Server service, contact tech_support@softgenetics.com.
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Figure 1-13:  SoftGenetics Server Setup wizard, License Agreement page

3. Click I Agree to accept the license agreement.

The Settings page for the SoftGenetics Server Setup wizard opens. By default, the page 
is prepped for configuring the Administrator user.

Figure 1-14:  SoftGenetics Server Setup wizard, Settings page

4. Do the following:

• Leave the user name set to Administrator, or modify it as needed.

• In the Password field, enter the password for the Administrator user.

Be patient. It might take a few minutes for the SoftGenetics Server Setup wizard to 
open. 

The only invalid character for the password is a space.There are no other special 
requirements or restrictions for the Administrator password. It can adhere to your 
organization’s standards and any other requirements as needed. If you forget or 
lose this password, it is not recoverable. 
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• In the Verify field, enter the Administrator password exactly as you entered it in the 
Password field.

• In the Email field, enter the email address for the Administrator user.

5. Click Next.

The Choose Components page for the SoftGenetics Server Setup wizard opens. A single 
component, the Server, is listed on the page. 

Figure 1-15:  SoftGenetics Server Setup wizard, Choose Components page

6. Select Server, and then click Install.

The Installation page for the SoftGenetics Server Setup wizard opens. The page details 
the components that are being installed and the status of the installation. See Figure 1-16 
on page 37.

The current version of User Management does not support email notifications; 
however, an email address is still required.

After you select the server, the space requirements for installing the SoftGenetics 
Server service are displayed on the page. Make sure that you have sufficient space 
on the computer to install this service.
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Figure 1-16:  SoftGenetics Server Setup wizard, Installation page

Note the following about the installation:

• If MySQL has not already been installed on the localhost, then after installation of 
MySQL is complete, click Close at the prompt; otherwise, the installation begins 
with the installation of the other server components (Python, Django, and Apache).

• During the installation of the other server components, you might receive Security 
Alerts. The installation is set up to handle these alerts and with the exception of a 
Windows Security Alert for Apache (see below), no special action is required.

• After Apache is installed, a Windows Security Alert opens indicating that the 
Windows Firewall has blocked some features of the installation. Click Unblock to 
allow the Apache HTTP Server to operate correctly on the localhost.

Figure 1-17:  Windows Security Alert for Apache
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After installation is complete, Completed is displayed at the top of the Installation page.

Figure 1-18:  SoftGenetics Server Setup wizard, Installation page for completed installation

7. Click Close.

The SoftGenetics Server Setup wizard closes. Mutation Surveyor remains open.

8. Continue to “To turn on user management” below.

To turn on user management

1. On the Mutation Surveyor main menu, click Help > User Management > Manage 
Settings.

The User Management Settings dialog box opens. The General tab is the open tab.

Figure 1-19:  User Management Settings dialog box, General tab

2. Leave Service host set to localhost.
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3. Select Turn on user management.

Remember last user becomes available.

4. Leave Remember last user, or optionally, clear it.

5. Click OK.

The Administrator Verification dialog box opens. The dialog box indicates that 
Administrator verification is required to apply the changes.

Figure 1-20:  Administrator Verification dialog box

6. In the Username field, leave the Administrator username as-is, or optionally, modify the 
name as needed.

7. In the Password field, enter the password for the Administrator user.

8. Click OK.

A message opens, indicating that to apply the changes that Mutation Surveyor must be 
closed and reopened and asking you if you want to close Mutation Surveyor now.

9. Click Yes.

The message closes.

     

If Remember last user is selected, then when a user logs into Mutation Surveyor, 
the Username field on the Login dialog box is automatically populated with the 
user name for the user who last logged into Mutation Surveyor.
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10. Start Mutation Surveyor.

The Login dialog box opens.

Figure 1-21:  Mutation Surveyor Login dialog box

11. Enter the Administrator username and password, and then click OK.

The Login dialog box closes and Mutation Surveyor opens. Now, every time a user 
opens Mutation Surveyor, they are prompted to enter a username and password before 
they can use the application.

To turn off user management

After configuring and turning on user management for your Mutation Surveyor instance, as 
the Administrator user, you always have the option of turning off user management. This 
does not delete any user configuration information. It simply means that users are not 
required to be authenticated before they log in to and use Mutation Surveyor. You can always 
turn user management back on.

1. Start Mutation Surveyor.

The Login dialog box opens.

Figure 1-22:  Mutation Surveyor Login dialog box

If you are the Administrator user, you should now continue to setting up the 
needed groups and users for your Mutation Surveyor instance. See “Managing 
Groups in Mutation Surveyor” on page 42 and “Managing Users in Mutation 
Surveyor” on page 47.
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2. Enter the Administrator username and password, and then click OK.

Mutation Surveyor opens.

3. On the Mutation Surveyor main menu, click Help > User Management > Manage 
Settings.

The User Management dialog box opens. The General tab is the open tab. Turn on user 
management is selected.

Figure 1-23:  User Management Settings dialog box, General tab

4. Clear Turn on user management. 

5. Click OK.

A message opens, indicating that to apply the changes that Mutation Surveyor must be 
closed and reopened and asking you if you want to close Mutation Surveyor now.

6. Click Yes.

The message and Mutation Surveyor close. Now, any user can start Mutation Surveyor 
without any authentication. The user configuration information, however, is not deleted, 
so you can always turn user management back on if needed.
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Managing Groups in Mutation Surveyor
Users are the people who log into Mutation Surveyor, whether they are adding and 
reviewing content, or just using the application in a read-only capacity. A group is a 
collection of users that have the same permissions in Mutation Surveyor. As the 
Administrator user for Mutation Surveyor, you are responsible for managing all the groups 
for your Mutation Surveyor instance and managing the users for these groups to ensure that 
your users have the appropriate permissions available to them in Mutation Surveyor. You can 
assign users to one of the four default groups that are installed with every instance of 
Mutation Surveyor, or you can create your own groups with the needed permissions, and 
then assign users to one of these groups. 

Managing groups for Mutation Surveyor consists of adding new groups, editing existing 
groups, and deleting groups.

To manage groups in Mutation Surveyor

1. On the Mutation Surveyor main menu, click Help > User Management > Manage 
Settings.

The User Management Settings dialog box opens. The General tab is the open tab. See 
Figure 1-23 on page 41.

2. Click the Groups tab to open it. 

The tab lists the four default groups that are installed with every instance of Mutation 
Surveyor as well as any groups that have been configured for your Mutation Surveyor 
instance. If applicable, it also lists any groups that have been configured for your 
Geneticist Assistant and/or NextGENe instances. See Figure 1-24 on page 43.

Mutation Surveyor Default User Group

Reporter Technician Analyst Supervisor

Assigned Permissions

View Project Y Y Y Y

Export Results Y Y Y Y

Create and Run Project N Y Y Y

Re-run Project N N Y Y

Edit Variants N N Y Y

Manage Analysis Settings N N N Y

Manage Report Settings N N N Y

Manage Knowledge Base N N N Y
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Figure 1-24:  User Management Settings dialog box, Groups tab

3. Optionally, to view a list of all users that are currently assigned to a group, select the 
group.

The users that are assigned to the selected group are displayed alphabetically by 
username in the User list pane.

4. Continue to one of the following:

• “To add a new group” on page 44.

• “To edit a group” on page 44.

• “To delete a group” on page 45.
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To add a new group

1. Click Add Group.

The Add Group dialog box opens.

Figure 1-25:  Add Group dialog box

2. In the Group name field, enter the name for the new group.

3. On the Permissions list, select the permissions for the new group.

4. Click OK.

A message opens, indicating that the new group was successfully created.

5. Click OK.

The message closes. The Groups tab remains open with the newly added group 
displayed on the tab.

6. Click OK.

The User Management Settings dialog box closes.

To edit a group

Editing a group from the Groups tab consists of modifying the permissions for the group. If 
you want to edit a group by adding or deleting users, then you must do so from the Users tab. 
(See “Managing Users in Mutation Surveyor” on page 47.) Also, you cannot edit a group 
name. If you need to rename a group, then you must delete the current group, and create a 
new group with the new name, and then reassign all the users who were associated with the 
deleted group to this new group.

Although you can edit the permissions that are assigned to the Mutation Surveyor 
default groups, SoftGenetics strongly recommends that you not do so. Instead, you 
should create a new group with the appropriate permissions and then assign users 
to the new group.
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1. Select the group for which you are modifying the permissions, and then click Edit 
Group.

The Edit Group dialog box opens. The group name is displayed in the Group name field, 
and you cannot edit it. The permissions that are currently assigned to the group are also 
displayed.

Figure 1-26:  Edit Group dialog box

2. Modify the permissions for the group as needed.

3. Click OK.

A message opens, indicating that the group was successfully edited.

4. Click OK.

The message closes. The Groups tab remain opens.

5. Click OK.

The User Management Settings dialog box closes.

To delete a group

1. Select the group that you are deleting, and then click Delete Group.

A message opens, indicating that you are deleting the selected group, and prompting you 
to click OK to confirm the deletion.

     

Although you can delete any of the Mutation Surveyor default groups, 
SoftGenetics strongly recommends that you not do so. Instead, you should delete 
only those custom groups that you have added for your Mutation Surveyor 
installation.
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2. Click OK.

The message closes, and a second message opens, indicating that you have successfully 
deleted the selected group. 

3. Click OK.

The second message closes. The entry for the group is removed from the Groups tab.The 
Groups tab remains open.

4. Click OK.

The User Management Settings dialog box closes.
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Managing Users in Mutation Surveyor
Users are the people who log into Mutation Surveyor, whether they are adding and 
reviewing content, or just using the application in a read-only capacity. If you are the 
Administrator user for Mutation Surveyor, then you are responsible for managing all the 
other users for your Mutation Surveyor instance. Managing users for Mutation Surveyor 
consists of adding new users, editing existing users, and deleting users. You can also view 
the activity for your Mutation Surveyor users (logging in to or logging out of Mutation 
Surveyor) in a log file.

To manage users in Mutation Surveyor

1. On the Mutation Surveyor main menu, click Help > User Management > Manage 
Settings.

The User Management Settings dialog box opens. The General tab is the open tab. See 
Figure 1-23 on page 41.

2. Optionally, to view the activity for your Mutation Surveyor users (logging in to or 
logging out of Mutation Surveyor) in a log file, click View Log.

The User Management Log file opens onscreen. The file lists all the activity for your 
Mutation Surveyor users, and if applicable, for your Geneticist Assistant and/or 
NextGENe users as well. You can click Save to File to save the log file with a name and 
a location of your choosing.

Figure 1-27:  User Management Log file
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3. Click the Users tab to open it. 

The tab lists all the user accounts that have been configured for your Mutation Surveyor 
instance, and if applicable, any user accounts that have been configured for your 
Geneticist Assistant and/or NextGENe instances. 

Figure 1-28:  User Management Settings dialog box, Users tab

4. Continue to one of the following:

• “To add a user” on page 49.

• “To edit a user” on page 50.

• “To delete a user” on page 51.
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To add a user

1. Click Add User.

The Add User dialog box opens.

Figure 1-29:  Add User dialog box

2. Enter the information for the new user:

• In the Username field, enter the appropriate user name.

• In the Password field, enter the password for the user.

• In the Verify field, enter the user password exactly as you entered it in the Password 
field.

• Optionally, in the Email field, enter the email address for the user.

3. Assign the user to a selected group.

4. Optionally, if the user is to be responsible for User Management in Mutation Surveyor 
(managing groups and users), then select System administrator.

The only invalid character is a space. There are no other special requirements or 
restrictions for the user password. It can adhere to your organization’s standards 
and any other requirements as needed. If you forget or lose this password, it is not 
recoverable. 

The current version of User Management does not support email notifications; 
however, you can still enter an email address.

By assigning a user to a group assigns the user’s permissions for Mutation 
Surveyor. If the appropriate group is not available, then you must add the group. 
See “Managing Groups in Mutation Surveyor” on page 42.
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5. Click OK.

A message opens, indicating that the new user was created successfully.

6. Click OK.

The message closes. The entry for the new user is displayed on the Users tab. The Users 
tab remains open.

7. Click OK.

The User Management Settings dialog box closes.

To edit a user

You can edit the password, the email address, and the groups for a user. For any user other 
than the default Administrator user, you can edit the System administrator status. You cannot 
edit the username for any user. To edit the username, you must delete the user, and then 
create a new user with a different username. See “To delete a user” on page 51.

1. Select the user that you are editing, and then click Edit User.

The Edit User dialog box opens. 

Figure 1-30:  Edit User dialog box

2. Edit the information for the user as needed:

• To edit the password, select New password, and then do the following:

• In the Password field, enter the password for the user.

• In the Verify field, enter the user password exactly as you entered it in the 
Password field.

The only invalid character is a space. There are no other special requirements or 
restrictions for the user password. It can adhere to your organization’s standards 
and any other requirements as needed. If you forget or lose this password, it is not 
recoverable. 
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• Enter an email address for the user, or edit the existing address as needed.

• Select a different group for the user.

• Select or clear the System administrator status for the user.

3. Click OK.

A message opens, indicating that the new user was updated successfully.

4. Click OK.

The message closes. The entry for the user is updated accordingly on the Users tab.

5. Click OK.

The User Management Settings dialog box closes.

To delete a user 

You cannot delete the default Administrator user. To edit the name for a user, you must delete 
the user, and then create a new user with a different user name. See “To add a user” on page 
49.

1. Select the user that you are deleting, and then click Delete User.

A message opens, indicating that you are deleting the user and asking you to click OK to 
continue.

2. Click OK.

The message closes, and a second message opens indicating that the selected user was 
successfully deleted.

3. Click OK.

The second message closes. The entry for the user is removed from the Users tab. The 
Users tab remains open.

4. Click OK.

The User Management Settings dialog box closes.
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Project Setup

To set up a project in Mutation Surveyor, you must understand about the different file types, 
how to modify the default Mutation Surveyor project settings, and then using this 
information to set up a project that meets your working needs. You can set up single or 
multiple projects in Mutation Surveyor. This chapter guides you through the necessary steps 
for setting up a single project in Mutation Surveyor.

This chapter covers the following topics:

• “Project File Types” on page 54.

• “Modifying the Default Mutation Surveyor Project Settings” on page 56.

• “Setting up a Single Mutation Surveyor Project” on page 74.

     

For information about working with multiple Mutation Surveyor projects, 
including processing and displaying results, see Chapter 11, “Multiple Projects,” 
on page 341.
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Project File Types
A project in Mutation Surveyor can have up to three different types of files—sample files, 
reference files, and GenBank files. Each file serves a different purpose in the project, each 
file has a different source, and each file type has its own unique requirements.

Sample file

The sample file is always a required file for a Mutation Surveyor project. The Sample file is 
the file that contains an unknown base sequence that you want to determine. A sample file 
must be in one of three formats—SCF, AB1/ABI, or Gz. A sample file can be a single 
one-directional file or it can be two separate files, with one file containing the forward read 
and the other file containing the overlapping reverse read. 

Reference file

The Reference file contains a known base sequence to which your sample files are 
compared. The Reference file is always a required file in a Mutation Surveyor project; 
however, the file source can vary. You can manually load a reference file, or you can have 
Mutation Surveyor create a synthetic reference file. The loaded file must be in one of three 
formats—SCF, AB1/ABI, or Gz. If you do not load a reference file and your files do not 
meet the requirements for an Automatic GenBank download (see “Automatic GenBank 
download” on page 55) then you must have a GenBank file loaded so that Mutation Surveyor 
can automatically create a synthetic reference file for each contig based on the loaded 
GenBank file. 

GenBank file

A GenBank file is a text-based file that shows the amino acid translation that corresponds to 
the base coding sequence (CDS). A GenBank file is always an optional file for a Mutation 
Surveyor project. The required file format is either GBK, GB, or SEQ. If you load a 
GenBank file as a reference file, then Mutation Surveyor automatically creates a synthetic 
reference file for each contig based on the loaded GenBank file. 

If your sample files are human DNA and the traces fall within the coding region of 
the gene, then you have the option of loading only sample files. See “Automatic 
GenBank download” on page 55.

You can load a GenBank file even you have loaded reference files for a project. 
This can be useful if you want to determine systematic errors in your amplicons 
such as PCR artifacts. See “GenBank/Reference Comparison” on page 62.
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Automatic GenBank download

If your sample files are human DNA, then you have the option of loading only sample files 
for a Mutation Surveyor project. When you run the project, by default, Mutation Surveyor 
automatically accesses a GenBank database on SoftGenetics’s bwt server (this database 
contains Build 37 of the human genome) and downloads the correct GenBank reference file 
(gene) to which to match the sample files.

You can change the default location from which to download the GenBank 
reference file. See “Automatically Download GenBank Files” on the “Others tab” 
on page 70.
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Modifying the Default Mutation Surveyor Project 
Settings

When you run a mutation project, you can use the default values for the mutation project 
settings, or you can modify any or all the settings as needed. You use the Mutation Project 
Settings dialog box to modify the settings for a mutation project. You can modify the value 
for two types of project settings—analysis settings and output/display settings. 

• Analysis settings—Analysis settings determine how your data is analyzed and therefore, 
which positions in your sample traces are called as mutations and which are not. Any 
difference that is found between your sample traces and reference traces must meet all the 
project analysis settings to be called as a mutation. You must modify the analysis settings 
before running a project. The Input tab, the Contig tab, and the Database tab contain only 
analysis settings. Other analysis settings are found on the following tabs:

• Output/display parameters—Output/display parameters do not affect the analysis of your 
data. They simply determine how your data is displayed to you in the different frames of 
the Graphical Analysis Display (GAD) for a project. For example, is an identified 
mutation displayed in red or blue in the Mutation table of the GAD? You can modify the 
output/display settings (found on the Mutation tab, the Output tab, the Display tab, the 2 
Directions tab, the Others tab, and the Database tab) before or after running a project. 

     

Tab Project Analysis Settings

Mutation • Mutation Detection

• Peak Fronting

• Base Labeling

• Data Processing

Others • Check Gene Direction

• Methylation

For detailed information about the Graphical Analysis Display for a project, see 
Chapter 3, “Graphical Analysis Display,” on page 79.
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To modify the default Mutation Surveyor project settings

1. On the Mutation Surveyor main menu, click Process > Settings. 

The Mutation Project Settings dialog box opens. The Contig tab is the active tab.

2. Do one of the following:

• Click Load Settings to browse to and select a saved Settings file (.ini file) to analyze 
and display the project results according to the settings in the file.

• Modify the project values as needed on any of the tabs. See:

• “Input tab” on page 58.

• “Contig tab” on page 59.

• “Mutation tab” on page 63.

• “Output tab” on page 66.

• “Display tab” on page 68.

• “2 Directions tab” on page 69.

• “Others tab” on page 70.

• “Database tab” on page 73.

3. Optionally, before you process the files, click Save Settings to save the settings that you 
have specified to a Settings.ini file. 

4. Click OK.

• Unless you modify the values again, all new projects are carried out according to the 
options that you have loaded/specified.

• If you load an existing project, the options revert to those set for the project. If you 
run a new project after loading an existing project, the new project is carried out 
according to the existing project settings.

5. Continue to “Setting up a Single Mutation Surveyor Project” on page 74.

To reset all values on all tabs to their default values in a single step, click Default.

You can always load this file at a later date and process other data files according 
to the saved settings in the file.
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Input tab

Figure 2-1:  Mutation Project Settings dialog box, Input tab

Option Description

Trace File (both Raw 
and Processed)

These options are applicable only if you loaded AB1/ABI sample files.

• Load Raw Data—Loads only the raw trace (no baseline substraction, 
no smoothing, no mobility shift correction, or no base calling) in the 
AB1/ABI sample files for analysis.

Note: If the project contains only a few traces and some of the traces 
have heterozygous substitutions close to the start of the traces, 
then the mobility shift correction that Mutation Surveyor carries 
out might cause a single heterozygous peak to be corrected into 
two homozygous peaks, which results in a false positive of a 
single base insertion.

• Load Processed Data—The default value. Loads only the processed 
data in the AB1/ABI sample files for analysis.

Phred Score 
(Processed Data)

• Display Processed Trace Phred Scores—Load the Phred scores that 
are contained within the traces for each base.

• Display Mobility-corrected Phred Scores—Load the Phred scores 
that Mutation Surveyor has calculated for each base.
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Figure 2-2:  Mutation Project Settings dialog box, Contig tab

Option Description

Contig

Fragment Size The number of sequential bases that are used for base matching. The 
default value is 12. The allowed range is 10 -16 bases. Mutation 
Surveyor evaluates a string of 12 bases in the sample trace and 
compares this string to the reference trace. If the string matches the 
reference trace, Mutation Surveyor moves to the next series of 12 bases 
and makes another comparison. Mutation Surveyor continues with 
these matching steps until it is able to determine whether the sample 
trace belongs to an existing contig or whether the sample trace belongs 
in its own contig.

Matching Base Number The minimum number of bases that must match between two sample 
traces for the traces to be placed in the same contig. The default value 
is 60.The allowed range is 20 -100 bases.

Matching Base 
Percentage

The minimum percentage of bases that must match between two 
sample traces for the traces to be placed in the same contig. The default 
value is 30%.The allowed range is 20 - 90%. 
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Force Into One Contig Place sample traces that meet all the matching base criteria and that 
differ in the starting base positions by <= 300 bps into one contig.

Note: Selected by default. If the quality of the sequences differs and 
sequences might be placed into either of two contigs, the 
samples might be placed into a different contig than expected. if 
samples that should be grouped into the same contig are not 
being grouped correctly using the Force Into One Contig option, 
then select Exclude 1st Base Difference > [ ] and accept the 
default value of 200 bps.

Note: If you are using a Grouping File to correctly pair your sample 
files, make sure that this option is not selected. See “Pairing” on 
page 61.

Exclude 1st Base 
Difference > [ ]

Place sample traces that meet all the matching base criteria but that 
differ in the starting base positions by more than “n” number of bases 
into two contigs. The default value is 200 bps.

Note:  Force into One Contig and Exclude First Base Difference sort contigs using only base 
calling (peak quality is not evaluated) and therefore, are carried out before quality trimming. 
(See “Quality Trim” on page 62.) If neither Force into one Contig nor Exclude 1st Base 
Difference > [ ] is selected, then:

• Place sample traces with > 500 bps that meet all the matching base criteria and that differ in the 
starting base positions by <= 250 bps into one contig.

• Place sample traces with > 300 bps and < 500 bps that meet all the matching base criteria and 
that differ in the starting base positions by < read length/2 bps into one contig.

• Place sample traces with < 300 bps that meet all the matching base criteria and that differ in the 
starting base positions by < 150 bps into one contig.

Base Patch If you are attempting to make mutation calls in the first 50 bases of 
sample traces, but the calls are being missed, then select Base Patch to 
correct the poor mobility shift at the starting of traces. With this option 
selected, Mutation Surveyor evaluates the spacing between each peak, 
and based on the results of this evaluation, Mutation Surveyor might 
make a different base call than what is included in the original trace. 

Note: If you are analyzing AB1/ABI files and these issues are still not 
corrected with Base Patch selected, select Load Raw Data on 
the Options tab. See “Trace File (both Raw and Processed)” on 
page 58.

Calculate Lane Quality 
Within the Region of 
Interest

Calculate the lane quality for the Region of Interest in the GenBank file, 
not the entire trace. If the ROI extends beyond the comparison region, 
then the ROI quality score is adjusted by the percent overlap of the 
aligned region and the ROI. For example, if the ROI length is 63 bp and 
the length of the overlap between the aligned region and the ROI is 8, 
then the percent overlap is 8/63 = 0.127. The currently calculated quality 
score, which in this example is 88, is then adjusted by this percentage to 
give the new quality score or (0.127)*(88) = 11.

Note: To define a Region of Interest (ROI) in a GenBank file, see 
“GBK File Editor Tool” on page 234.

Option Description
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Use Amplicon to 
Construct Contig

Two options:

• If all the filenames in a project contain an amplicon-specific 
designator, then select Select from Character X to Y and enter the 
starting and ending character positions of this designator. For 
example, Figure 2-3 shows a series of sample file names with the 
amplicon-specific designators of 10B and 11A located in positions 14 
through 16 of the filename.

Figure 2-3:  Amplicon-specific designators in sample file name

Note: If ROIs in the GenBank file are labeled with their Amplicon IDs, 
then selecting this option ensures that the appropriate ROI is 
evaluated for each amplicon.

• If your sample file names do not follow any file-naming standards, 
and you used a Grouping File to load the sample files, then select 
Use Sample Grouping file to help organize the contigs correctly. See 
“2D Filename Match Editor tool” on page 271.

Note: If you do use a Grouping File, then when you are adding sample 
files to for your Mutation Surveyor project, make sure that Load 
Grouping File is selected on the Open Files dialog box. When 
you click Add in the Sample files pane, select the Grouping File. 
All the sample files that are defined in the Grouping File are 
added for the Mutation Surveyor project.

Pairing

Exact Filename F/R 
Match

Select this option to pair your forward and reverse sample files if your 
filenames differ only by the directional identifier (f or r). For example:

Exact Filename Match 
Before F/R

Select this option to pair your forward and reverse sample files if your 
filenames are identical before the directional identifier (f or r), but vary 
after the directional identifier. For example:

Note: In some situations, neither of the above automatic file pairing options suits your current 
needs. For example, your files might require a complete naming overhaul before you can 
use either option. Additionally, you might want to set aside blocks of data for analysis at a 
later date. In such a situation, you should create a Grouping File to load your sample files. 
See “2D Filename Match Editor tool” on page 271.

Option Description
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Trimming

Quality Trim Eliminates low quality data at the starting and the end of a sample trace. 
Quality trimming trims the sequence data based on the base quality. By 
default, when the S/N Ratio is greater than 15 for 7 out of 9 sequential 
bases, then mutation detection is carried out in this region. 

Note: Quality Trim is always implemented in Mutation Surveyor which 
is why the option is always selected and always unavailable. If 
you select other trimming options, then all the selected trimming 
methods are compared. The trimming method that results in the 
greatest number of bases being trimmed is the trim method that 
is applied. Quality Trimming is then applied after the selected 
trimming method.

Vector Trim Trims the sample sequence according to a starting vector sequence and 
an ending vector sequence that you define using the SEQ File Editor 
tool. See “SEQ File Editor Tool” on page 257.

5’ Trim [ ] Trim the 5’ end of the sample trace by the indicated number of bases.

3’ Trim [ ] Trim the 3’ end of the sample trace by the indicated number of bases.

Score Trim [ ] Reject regions for mutation detection in which the base quality for 7 out 
of 9 sequential bases falls below the specified value. For example, if the 
Score Trim is set to a value of 10, and the S/N Ratio is 8 for 7 out of 9 
sequential bases, then mutation detection is not carried out in this 
region. The default value is 16. 

Contig Sort By

Determines the sort order of multiple contigs in a project.

• Sample Filename

• Reference Filename

• Contig Num. of Sample Files

GenBank/Reference 
Comparison

If you have both GenBank and reference files loaded, and this option is 
selected, then Mutation Surveyor creates a synthetic sample trace from 
the base sequence of the GenBank file and the reference trace to 
classify the variance between the GenBank file and your reference files. 
You can, in turn, use this variance to determine systematic errors in your 
amplicons such as PCR artifacts.

Option Description
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Mutation tab

Figure 2-4:  Mutation Project Settings dialog box, Mutation tab

Option Description

Mutation

Mutation Score Indicates the level of confidence that a called mutation is a true 
mutation. The score is based on the concept of Phred scores, where 
quality scores are logarithmically linked to error probabilities as shown 
in Figure 2-5.

Figure 2-5:  Phred scores and error probabilities

The values for “Overlapping Factor,” “Dropping Factor,” and “S/N Ratio” 
are used in the calculation of the Mutation Score. The lower the score, 
the greater number of mutation calls, but the confidence in the accuracy 
of the calls is reduced. The default value is 5.00.

Mutation Height The minimum height (in RFU) required for a peak in the mutation trace 
to be called as a mutation peak. The default value is 500 RFU.
Mutation Surveyor User’s Manual 63



Chapter 2
Project Setup
Overlapping Factor The average of the following two values:

• The difference in the area between the reference peak and the 
mutation peak.

• The difference in the area between the sample peak and the mutation 
peak. 

For an ideal mutation peak, the overlapping factor has a value of 1.0. In 
reality, this value is typically less than one. The overlapping factor must 
be greater than or equal to the specified value for the variant to be 
called a mutation. The default value is .20, or 20%.

Figure 2-6:  Calculating the Overlapping Factor

Dropping Factor Measures the drop in peak intensity at the variant position by 
normalizing the peak intensity between the reference peak and the 
sample peak at positions two through five on both sides of the variant. 
The dropping factor for a homozygous mutation is 1, or 100%. The 
dropping factor for a heterozygous mutation is 0.5, or 50%. The 
dropping factor must be greater than or equal to the specified value for 
the variant to be called a mutation. The default value is .10, or 10%.

Figure 2-7:  Calculating the Dropping Factor

Option Description

Difference in 
area between 
reference peak 
and mutation 
peak.
Difference in 
area between 
sample peak 
and mutation 
peak.

Mutation peak.
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S/N Ratio Signal (S) is defined as the mutation peak intensity and noise (N) is 
defined as the median noise intensity for the mutation peak. The Signal 
to Noise Ratio (S/N Ratio) determines how large the signal must be for a 
mutation peak relative to the noise for the mutation to be registered.

Note: The minimum noise at a given base position is 250 RFU.

Note: S/N Ratio is output to some reports as SnRatio.

Mutation Detection

Determines the level of sensitivity that Mutation Surveyor uses to call 
mutations. 

• High sensitivity

• Medium sensitivity

Note: There are many functions that change the parameters between 
these two options. For example, if in 2D data, one trace 
indicates a mutation at a location, but the other trace does not, 
Mutation Surveyor checks for local base quality and decides 
whether to add or delete the mutation. In other situations, 
statistical analyses are carried out for the contigs to check for 
possible missed mutations, reported mutations are checked for 
missed mutations and so on. If you are concerned that your 
data might be showing a high number of false positives, then 
set the sensitivity to medium to reduce the number of false 
positives.

Allow for Hypervariable 
Mutation Detection

Select this option to have Mutation Surveyor automatically extend the 
starting and ending positions for the aligned comparison region if both of 
the following conditions are met:

• At least 4 of 10 consecutive bases outside of the aligned comparison 
region have a Phred-like score >=15.

• At least 8 of 12 consecutive bases outside of the aligned comparison 
region are identical to the reference bases. 

Note: By extending this region, more potential mutations can be 
called, which is especially useful for samples that are known to 
have a high mutation frequency such as viruses and the human 
leukocyte antigen system (HLA).

Delete Indels/het_indels 
Automatically

Select this option to have Mutation Surveyor automatically delete all 
insertion and deletion calls from the project. 

Note: Selecting this option helps to eliminate false positives that are 
common to hypervariable sequences.

Allow Software to 
Delete Mutations

Select this option to have Mutation Surveyor automatically delete 
illogical mutation calls and mutation calls that have high background 
noise (> 250 RFU).

Delete Indels Outside of 
ROI

If selected, then Mutation Surveyor automatically deletes insertions and/
or deletions that fall outside the ROI.

Option Description
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Output tab

Figure 2-8:  Mutation Project Settings dialog box, Output tab

Peak Fronting

Correction Peak Fronting is often seen as a smaller peak that is in front of a major 
peak of the same color, which means that the peaks represent the same 
base in the sequence. This small peak is often the result of PCR 
reactions of a dye-labeled terminator when concentrated reagents are 
used. With Peak Fronting Correction, the minor peak is reduced in size 
relative to the major peak. The default value is 1%. 

Note: Peak Fronting Correction might reduce the mutation intensity of 
some peaks in the mutation trace.

Note: Newer chemistries often have less peak fronting, so lowering 
this value can increase the sensitivity of mutation detection.

Base Labeling - Determines the point on a peak that used for determining peak height.

• Original • Use the base position that was defined by the original base calling 
software. 

• Peak Center • Use the bases at the center of the peak to determine peak height.

Data Processing

Dye blob baseline noise 
removal

If the sequence traces exhibit broad peaks caused by a dye blob, then 
the baseline might introduce artifacts into the trace. Select this option to 
remove the baseline noise that is caused by a dye blob. 

Note: Baseline removal might reduce the mutation intensity of some 
peaks in the mutation trace.

Option Description
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Option Description

Output Table Fields Select the fields that are to be displayed in the Viewing and Reporting 
pane for the different standard mutation reports. 

Note: Base Score - The average value of the Phred scores in the 
comparison region. The Phred score can be derived by either 
the Processed Trace Phred scores or the Mobility-corrected 
Phred scores.

Note: The selections that you make here affect all standard mutation 
reports en masse. You cannot select different fields for different 
reports. See Chapter 5, “Mutation Surveyor Standard Reports,” 
on page 127.

Quality Thresholds Lane Quality >= [ ]—Lane quality is a measure of the S/N Ratio within a 
sample trace prior to alignment to a reference trace. After the sample 
trace is aligned to the reference trace, peak spacing in the sample trace 
is adjusted, which often results in higher lane quality. Lane quality 
ranges from 0 to 100, with 100 being the highest quality. If multiple 
reference files are available, Mutation Surveyor chooses the reference 
file with the highest lane quality. Any lanes that do not meet the quality 
threshold are placed in a folder other than a contig folder.

Note: “Low Quality” is displayed in the Lane Quality column in reports 
for a trace with lane quality that falls below the Quality 
Threshold. 

Output Limits

CDS Only Limits the graphical output to the CDS.

• Before (After) CDS • Available only if CDS Only is selected. Specify the number of bases 
that are to precede/follow the exon.

Region of Interest Only Limits the graphical output to Regions of Interest.

Print Default Header 
Information 

Selected by default. Prints the default Header information on a variety of 
standard mutation reports. 

Add dbSNP Id to 
Comments

Displays the dbSNP identifier in the Comments field for a standard 
mutation report when Comments are selected for output.

Mutation Call 
Nucleotides Relative to 
Gene Direction

Make the mutation call based on the gene orientation. To make a 
mutation call for a gene on the reverse strand, a reverse complement is 
generated. 
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Display tab

Figure 2-9:  Mutation Project Settings dialog box, Display tab

Option Description

Mutation Threshold

 Determines how an identified mutation is displayed—red font (low confidence) or blue font (high 
confidence)—in the different mutation reports. The values in the Reject column indicate the upper 
rejection boundary. The values in the Pass column indicate the lower acceptance boundary. 

• If the value for any of the mutation settings is less than the rejection boundary, then the mutation 
is rejected and is not displayed in the different mutation reports. 

• If the values for all the mutation settings fall within the indicated ranges, the mutation is accepted 
and displayed in red in the different mutation reports. 

• If the values for all the mutation settings exceed their acceptance boundaries, then the mutation 
is accepted and displayed in blue in different mutation reports. 

Note: For 2D data, the mutation scores (F and R) are summed and the sum score is used to 
determine if the mutation call is rejected, passed, or put into check.

Amino Acid • 1 Letter—Display 1 Letter IUPAC amino acid code in the mutation 
reports and views.

• 3 Letter—Display 3 Letter IUPAC amino acid code in the mutation 
reports and views.

• With Indel Changes—Selected by default. Displays the amino acid 
output including indels. Clear this option to display the amino acid 
output without indels.
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2 Directions tab

Figure 2-10:  Mutation Project Settings dialog box, 2 Directions tab

Position • Contig—Show the position within the GenBank file for the queried 
contig in the Nucleotide Sequence frame and Mutation table of the 
GAD, and in the Project Reviewer report.

• Chromosome—Show the chromosome position for the queried contig 
in the Nucleotide Sequence frame and Mutation table of the GAD, 
and in the Project Reviewer report.

Note: The Chromosome option works correctly only if the GenBank 
file contains chromosome information; otherwise, Mutation 
Surveyor defaults to showing the contig information.

Check 2D Small Peaks 
(Mosaic)

• Check—If selected, Mutation Surveyor searches for minor alleles that 
are present within the baseline of bi-directionally aligned peaks and 
indicates their presence with a short green bar.

Note: This option is useful for somatic mutation detection.

• Height Threshold—Available only if Check 2D Small Peaks is 
selected. Specify the RFU value for the smallest peak that is to be 
detected.

Maximum Height in 
Mutation 
Electropherogram

If the height of a peak in the mutation trace exceeds this maximum 
value, then Mutation Surveyor normalizes the peak to this maximum 
height. The default value is 5000 RFU.

Display Phred Score If selected, the Phred-like score for each peak in the mutation trace is 
displayed in the sample trace directly below the base call.

Display Negative SNPs If selected, positions with reported variations that do not contain the 
SNP are indicated in the Graphical Analysis Display (GAD) by showing 
the possible alleles in green at the top of the mutation trace. 

Option Description
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For 2D data, the mutation scores (F and R) are summed and the sum score is used to 
determine if the mutation call is rejected, passed, or put into check. Figure 2-11 below 
illustrates how 2 Directions settings work based on the default values for a mutation project.

Figure 2-11:  Examination of 2D mutation data

For 1D data that is being analyzed with 2D settings, a mutation is called if it meets one of the 
following parameters; otherwise, it is rejected.

• Score > SumScoreReject 

• Score > SumScoreReject*0.8 and Dropping Factor >= 0.3 

• Score > SumScoreReject*0.6 and Dropping Factor >= 0.35 

• Score > SumScoreReject*0.4 and Dropping Factor >= 0.4

Figure 2-12 below illustrates these parameters based on the default value of 20 for the 
SumScoreReject.

Figure 2-12:  Examination of 1D mutation data analyzed with 2D settings

Others tab

Option Description

2 Directions Select this option if 2D is being analyzed. 

1 Direction Select this option 1D data is being analyzed. 

Note: You can select the 2 Directions options for 1D data.
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Figure 2-13:  Mutation Project Settings dialog box, Others tab

Option Description

Database URL

Automatically Download 
GenBank Files

• If your sample files are human DNA, then you have the option of 
loading only sample files for a Mutation Surveyor project. When you 
run the project with this option selected, Mutation Surveyor 
automatically accesses the database that is specified by the URL and 
downloads the correct reference file (gene) to which to match the 
sample files. 

Note: The default URL is for a GenBank database on the 
SoftGenetics bwt (http://bwt.softgenetics.com/query.php) 
server. This database contains Build 37 of the human genome, 
which contains chromosome information. If the sample 
sequences fall within the coding region of the gene, then you 
can select the other available SoftGenetics server, (http://
softgenetics.my.speedingbits.com/cgi-bin/hg.cgi?), which 
contains build 36 of the human genome in its GenBank 
database. (This database does not contain chromosome 
information.) To specify this database as the default database, 
after you select its URL, click Add.

User Local Directory • If the reference file to which you want to match your sample files 
resides in a directory on your local computer, clear the Automatically 
Download GenBank Files option, and then click the Browse button 

 to browse to and select the local directory path. 
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Check Gene Direction

Automatically Adjust 
GenBank Direction

Selected by default. Determines whether the queried gene in the 
GenBank file is complemented based on its location (plus (+) or 
minus (-)) strand.

• Orient GenBank files in Gene Direction

• Orient GenBank files in Chromosome Direction

Inspect GenBank for 
Chromosome Positions

Selected by default. Determines if the GenBank file header contains the 
genome build, the chromosome name, and the chromosome position. If 
this information is present, then chromosome information can be 
displayed in the Nucleotide Sequence frame and the Mutation table in 
the GAD, and the Project Reviewer report; otherwise, only the contig 
information can be displayed.

Note: If you clear this selection, then Mutation Surveyor does not 
notify you when chromosome options will not work correctly; 
however, if chromosome information is contained in the 
GenBank file, then the chromosome options still work correctly.

Query Reference 
Traces

Not selected by default. If a GenBank file is not loaded for the project, 
but reference traces are, then the sample traces are aligned only to the 
reference traces. If selected, Mutation Surveyor downloads the 
appropriate GenBank file for the project, and aligns both the reference 
and sample traces to the GenBank file for annotation.

Methylation

Methylation Select this option if methylated samples are to be analyzed.

• Set By User • Select this option to manually specify which forms of methylation 
Mutation Surveyor should detect.

• Automethylation • Selected by default when Methylation is selected. Mutation Surveyor 
automatically detects methylated sequences.

Note: For information about methylation detection in Mutation Surveyor, see “Methylation 
Detection” on page 329.

Option Description
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Some GenBank files contain only NT-accession numbers and not chromosome information. 
You specify the database on the Database tab that is to be used to translate these contig 
positions into chromosome positions.

Figure 2-14:  Mutation Project Settings dialog box, Database tab

Option Description

Host The address for the Annotation Database server. The default value is set to 
localhost, which assumes that the server is installed on the same computer as 
Mutation Surveyor. If this is correct, then leave the default value as-is.; 
otherwise, modify the value accordingly.

Port Leave this option set to the default value of 3306 only if no other application is 
already using MySQL on the port; otherwise, modify the value accordingly.

User The user name for MySQL. Leave this option set to the default value of 
softgenetics unless your administrator has changed it.

Password The password for MySQL. Leave this option set to the default value unless 
your administrator has changed it.

Show Database To verify the MySQL connection and populate the list of available annotation 
databases, click this option. 

Note: If the MySQL connection cannot be verified, an error message opens 
indicating this, and that the list of annotation databases cannot be 
populated. Verify that you have imported the necessary annotation 
databases (see “The Mutation Surveyor Track Manager Tool” on page 
310) and/or contact for your administrator for assistance. 

Annotation DB Select the appropriate annotation database. 
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Setting up a Single Mutation Surveyor Project
When you set up any Mutation Surveyor project, the following caveats apply:

• For one directional data, you can enter 24, 48 or 2000 sample files depending on the 
version of Mutation Surveyor that you purchased. Only a single reference file is required. 

• For two directional data, you can enter 12, 24, or 1000 pairs of sample files depending on 
the version of Mutation Surveyor that you purchased. Both a forward reference file and a 
reverse reference file are required.

• Sample files and reference files are limited to a read length of 2500 bps. GenBank files 
are limited to a read length of 10 Mbp per file.

• If your amplicons do not overlap and your forward and reverse directional pairs have 
similar start and end locations, then the forward and reverse files with similar names that 
have been grouped in the same contig are automatically paired. 

To set up a Mutation Surveyor project

1. Confirm that your Mutation Surveyor project options are correctly set, or modify them 
as needed. (See “Modifying the Default Mutation Surveyor Project Settings” on page 
56.)

2. On the Mutation Surveyor main menu, click File > Open Files.

The Open Files dialog box opens.

Figure 2-15:  Open Files dialog box

The following procedure details how to set up a single new Mutation Surveyor 
project. For information about setting up and working with multiple Mutation 
Surveyor projects, see Chapter 11, “Multiple Projects,” on page 341.
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3. For each file type that you are adding to the project:

• Click Add in the appropriate pane. (For example, to add a GenBank file, click Add 
in the GenBank Sequence File pane.)

• In the Open <File> dialog box, browse to and select the files that you are adding to 
the project. (CTRL-click to select multiple files.)

• Click Open to add the files to the project, and then click OK. 

4. Optionally, to view the raw data before it is processed, expand the Sample file folder in 
the Browser pane, and then double-click a sample file. You can do any of the following 
to change the view of the data:

• Zoom in - Click and hold the left mouse button and draw a box from the upper left 
hand corner of the pane towards the lower right hand corner. A box is formed around 
the area that being reduced for viewing.

• Zoom out - Click and hold the left mouse button and draw a box from the lower right 
hand corner of the pane towards the upper left hand corner. (The magnification for 
zooming out is always 100%.)

• Move left/right - Click and hold the right mouse button, and then drag the display to 
the left or right.

Figure 2-16:  Viewing raw data for a sample file
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5. On the Mutation Surveyor main menu, click Process > Run.

Mutation Surveyor aligns the nucleotide sequences of the sample traces to the reference 
traces and groups the sample traces into contigs based on their degree of overlap. (See 
“Contig directory for a Mutation Surveyor project” below.) The reference traces and 
sample traces are then compared at a trace by trace level to identify substitutions, 
insertions, and deletions. All the variants are aligned in the Mutation report, which is 
automatically displayed in the Viewing and Reporting pane after the project is run. 

Figure 2-17:  Mutation Report in Viewing and Reporting pane

6. On the main menu, click File > Save Mutation Project.

The project is assigned a default name and has the type of Mutation Project Files 
(*.Sgp). You cannot change the file type, but you can change the project name and select 
any location in which to save the project. 

Contig directory for a Mutation Surveyor project

Mutation Surveyor aligns the nucleotide sequences of the sample traces to the reference 
traces and groups the sample traces into contigs based on their degree of overlap. Because 
contigs are organized relative to the reference file, forward and reverse sequence pairs are 
grouped into two separate contig folders that are displayed in the Browser pane. The folders 
are labeled as ContignF and ContignR, where F stands for forward sequence, R stands for 
reverse sequence, and “n” stands for the contig file name, for example, Contig2F and 
Contig2R. The number in the parenthesis after the contig name indicates the number of 
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samples for the contig. 

• A green File icon with a red checkmark  indicates the active reference file for the 
contig. 

• If the reference file was derived from a GenBank file, a black checkmark  indicates this 
GenBank file.

• A green File icon  indicates the sample file that is currently selected. The corresponding 
data is displayed in the Viewing and Reporting pane of the GAD. 

Figure 2-18:  Contig directory in the Browser pane

You can right-click on the currently selected trace to open a context menu with the following 
options:

Option Description

Copy Filename to 
Clipboard

Copies the complete file name for the selected trace to the clipboard. You 
can then paste the file name into a third-party application such as Word or 
Excel as needed.

Add/Edit Comment Opens the Add/Edit Comments dialog box in which you can add/edit the 
comments for the selected trace. The comments are displayed above the 
sample trace in the GAD.

Figure 2-19:  Add/Edit Trace Comments dialog box

Note: Trace comments can also be enabled in the Custom report. See 
“Display tab” on page 174.

Delete Lane The Lane Quality for a deleted lane is set to “Low Quality” in the GAD. All 
the mutations for the deleted lane are removed from the Mutation table.

Note: The Delete Lane option is available for a contig on both the 
Mutation table context menu and the Sample Trace name context 
menu. See “GAD analysis options” on page 95.
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Undo Lane Deletion The Lane Quality is reset to its original value in the GAD. All the mutations 
for the deleted lane are again displayed in the Mutation table.

Note: The Undo Lane Deletion option is available for a contig on both 
the Mutation table context menu and the Sample Trace name 
context menu. See “GAD analysis options” on page 95.

Option Description
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The Graphical Analysis Display visually presents mutation project data. A variety of options 
are available for working with the display, including options for analyzing and manipulating 
mutation project data so that you identify the true mutations in a mutation project. 

This chapter covers the following topics:

• “Graphical Analysis Display Layout” on page 81.

• “Graphical Analysis Display Navigation and Analysis Options” on page 94.

• “Exporting the GAD” on page 98.
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Graphical Analysis Display Layout 
The Graphical Analysis Display (GAD) visually presents mutation project data in the 
Viewing and Reporting pane. A variety of options are available for working with the display, 
including options for analyzing and manipulating project data to identify the true mutations 
in a project. To open the display for a mutation project, do one of the following:

• Double-click a sample file in the Mutation report.

• Double-click a sample file in the Browser pane.

• Double-click a specific mutation in the Mutation report.

Figure 3-1:  Graphical Analysis Display in the Viewing and Reporting pane

The Graphical Analysis Display for any mutation project has up to five major components. 
Four of the five components—the Nucleotide Sequence frame, the Amino Acid frame, the 
Sample Traces frame, and the Mutation table—are always displayed for a Mutation Surveyor 
project. The fifth component, the Tracks frame, is displayed only if information has been 
imported from an annotation database for the project, and/or false positives and/or artifacts 
have been manually added to the project. From top to bottom, these components are:

1 - Nucleotide Sequence frame

2 - Amino Acid frame

3 - Sample Traces frame

4 - Mutation table

5 - Track frame
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• The Nucleotide Sequence frame. See “Nucleotide Sequence frame” below.

• The Amino Acid frame. See “Amino Acid frame” on page 83.

• The Tracks frame. See “Tracks frame” on page 83.

• The Sample Traces frame. See “Sample Traces frame” on page 84.

• The Mutation table. See “Mutation table” on page 87.

The settings that you specify on the output/display tabs of the Mutation Project Settings 
dialog box determine some of the information that is displayed in the GAD. If you modify a 
setting on an output/display tab and then click OK, the GAD is dynamically updated to 
reflect this change. (See “Modifying the Default Mutation Surveyor Project Settings” on 
page 56.) In addition, the Mutation Surveyor toolbar is dynamically updated with buttons 
that are specific for navigating and working with the GAD. (See “GAD Toolbar” on page 
88.)

Nucleotide Sequence frame

The Nucleotide Sequence frame displays the GenBank file, the reference traces, and the 
sample traces as called bases. 

Figure 3-2:  Nucleotide sequence frame

From top to bottom in the frame, the rows display the following information:

• Position Information—The option that is selected on the Display tab of the Mutation 
Project Settings dialog box determines the information that is displayed in the first row. 
The positions within the GenBank file for the queried contig are displayed if Contig is 
selected. Chromosome number:chromosome positions are displayed if Chromosome is 
selected. The location of the queried gene (plus (+) or minus strand (-)) and the option that 
is selected for Automatically Adjust GenBank Direction on the Others tab determines the 
order (ascending or descending) in which this position information is displayed.

• The nucleotide sequence for the GenBank file. Within an exon, the GenBank nucleotides 
are displayed in uppercase. Outside the exon, the GenBank nucleotides are displayed in 
lowercase. If the gene is on the minus (-) strand and Orient GenBank Files in Gene 

The Tracks frame is displayed only if information has been imported from an 
annotation database for the project, and/or false positives and/or artifacts have 
been manually added to the project.

The following sections describe the GAD components for a 2D mutation project in 
which a GenBank file was used to create a synthetic reference file. There are slight 
differences for 1D projects, or for projects that did not use a GenBank file.
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Direction is selected for Automatically Adjust GenBank Direction, then the nucleotide 
sequence is also displayed upside down.

• The nucleotide sequence for the forward reference trace.

• The nucleotide sequence for the forward sample trace.

• The nucleotide sequence for the reverse sample trace.

• The nucleotide sequence for the reverse reference trace.

An asterisk indicate inconsistencies in base calls between traces. A black asterisk (*) 
indicates an inconsistency between a reference trace and a sample trace. A red asterisk (*) 
indicates an inconsistency between a reference trace and the GenBank-derived trace. 

Amino Acid frame

The Amino Acid frame displays the codon number and the IUPAC abbreviation for the 
corresponding amino acid sequence for the called bases that fall within a coding region in the 
GenBank sequence (the first line in the frame) and in the sample file (the second line in the 
frame.) Any differences between the amino acid translations as the result of mutations in the 
sample file are therefore visible in this frame. The frame also shows the coding DNA 
reference sequence. Just like the Nucleotide Sequence frame, the location of the queried gene 
(plus (+) or minus strand (-)) and the option that is selected for Automatically Adjust 
GenBank Direction on the Others tab determines the order (ascending or descending) in 
which the codon numbers and c.dna numbers are displayed. 

Figure 3-3:  Amino Acid frame

Tracks frame

The Tracks frame is displayed only if information has been imported from an annotation 
database for the project, and/or false positives and/or artifacts have been manually added to 
the project. A reported single base variant at a specific chromosome position is indicated by 
a green tick mark. A reported variant that spans multiple bases at a specific chromosome 
position is indicated by a green horizontal line. You can place your cursor over a green tick 
mark or horizontal line to open a popup that displays detailed information for the reported 
variant. 

Figure 3-4:  Tracks frame with mutation information displayed for a reported variant
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Sample Traces frame

The Sample Traces frame displays the traces for a selected sample grouped by direction. 
From top to bottom, the forward reference trace, the forward sample trace, and the forward 
mutation trace are grouped together, and from top to bottom, the reverse sample trace, the 
reverse reference trace, and the reverse mutation trace are grouped together. The forward 
direction group is marked by a light blue vertical bar to the left of the group and the reverse 
direction group is marked by a light tan vertical bar to the left of the group. The trace name, 
the sequence direction, and the lane quality are displayed above each trace. If any comments 
have been added for a trace, they are also displayed above the trace. The location of the 
queried gene (plus (+) or minus strand (-)) and the option that is selected for Automatically 
Adjust GenBank Direction on the Others tab determines if the Reference trace is reverse 
complemented or not. The X-axis indicates the frame number and the Y-axis indicates peak 
intensity. The nucleotide numbering is from the 5’ end to the 3’ end prime end on the 
forward trace and from the 3’ end to the 5’end on the reverse trace. A legend identifies the 
different parts of the traces. In addition, the different types of peaks in the traces are 
identified with unique peak information. (See “Mutation trace legend” below and “Mutation 
trace peak identification” on page 86.)

Figure 3-5:  Reference traces. sample traces and mutation traces

Mutation trace legend

A peak in the mutation trace is called as a mutation peak when its height (in RFU) is greater 
than or equal to the value specified for the Mutation Height in the Mutation Project settings. 
(See “Mutation tab” on page 63.) A mutation peak appears in frame with the reference trace. 
The peak color indicates the called base for the mutation. (To see the color that is assigned to 
a specific base or group of bases in the mutation trace, click the Show Lines button  on 
the GAD toolbar.)

Horizontal location bars run across the top of the mutation trace. The bar color indicates the 
location of the sequence that is being displayed in the trace.

• Yellow—Exon coding region

• Pink—Region of Interest (ROI)
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• Light tan—GenBank sequence match

• Light blue—Primer region

• Green—Somatic (Mosaic) mutation

• Red—Homozygous deletion or duplication. See “Mutation trace peak identification” 
below.

• Red with green arrows—Homozygous insertion. See “Mutation trace peak identification” 
below. 

• Brown—Heterozygous insertion or deletion. See “Mutation trace peak identification” 
below.

Figure 3-6:  Example of different colored Location bars in a mutation trace

Brown tick marks indicate reported variations in the GenBank file while tick marks of other 
colors indicate reported SNPs. Thick blue vertical bars define a comparison region, which is 
a region where the sample traces align to the reference traces, and all the mutation project 
analysis settings have been met, and therefore, mutations, with the exception of 
heterozygous indels, can be called in this region. (See “Mutation trace peak identification” 
below.)

Figure 3-7:  Comparison region in mutation trace

     

Somatic mutations are marked in the mutation trace only if you have selected the 
Check 2D Small Peaks (Mosaic) option for the mutation project settings. See 
“Display tab” on page 68.

If Display Negative SNPs is selected for the mutation project, you can zoom in on 
the tick marks in the mutation trace to see the involved bases. See “Display tab” 
on page 68.

Region of Interest Exon coding regionGenBank sequence match

Comparison region

Reported SNP

Reported variation in GenBank file
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Mutation trace peak identification

If all the criteria are met for a substitution mutation event, the values for mutation score, 
peak height, overlapping factor, and dropping factor are displayed on the peak.

Figure 3-8:  Substitution mutation event 

The mobility line is the horizontal line that runs through the center of the mutation trace. This 
line indicates the mobility of the sample trace relative to the reference trace—that is, by how 
much was the sample trace shifted so that the center of the peaks in the sample trace align to 
the center of the peaks in the reference trace? Typically, this line is green; however, the line 
changes color if an indel event is detected in the sample trace. If a homozygous deletion, 
duplication, or insertion event is detected in the sample trace, then the line is red. A positive 
peak in the mobility line spans a homozygous deletion event. A negative peak in the mobility 
line spans a homozygous duplication or insertion event.

Figure 3-9:  Homozygous deletion event

Figure 3-10:  Homozygous duplication event

Figure 3-11:  Homozygous insertion event

     

Positive peak in mobility line

Negative peak in mobility line

Negative peak in mobility line
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If a heterozygous insertion or deletion event is detected in the sample trace, then the line is 
brown and a blue vertical line indicates that mutation detection is not possible past the point 
of the event.

Figure 3-12:  Heterozygous mutation event

Mutation table

The Mutation table is the last component in the GAD. The Mutation table displays all the 
mutation data for the currently opened trace. See “Modifying the Default Mutation Surveyor 
Project Settings” on page 56.

Figure 3-13:  Mutation table

The color-coding for a substitution mutation event indicates a variety of information about 
the mutation.

• Text color—Blue text indicates that the mutation is called with high confidence. Red text
indicates that the mutation is called with low confidence. (See “Mutation Threshold” on
page 68.) Black text indicates that the mutation has been manually confirmed. (See
“Confirm” on page 135.)

• Purple background with green text—A reported variation that was not found in the
mutation project.

• Pink background—A novel variant that results in a change to the amino acid sequence.

• Purple background—A reported variant that might or might not result in a change to the
amino acid sequence.

• Blue background—A novel variant on the forward strand that does not result in a change
to the amino acid sequence.

• Tan background—A novel variant on the reverse strand that does not result in a change
to the amino acid sequence.

• No background color—A novel variant that is found in both directions that does not result

For a detailed explanation about the code in the Mutation field, see “Mutation 
Report” on page 129.
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in a change to the amino acid sequence. 

To view a mutation event in the mutation trace in the GAD, double-click the mutation in the 
table. If the mutation is a heterozygous indel, the Het_Indel tool also opens. See “To add or 
edit a heterozygous indel (The Het_Indel tool)” on page 359.

GAD Toolbar 

Button Description

Open Files—Opens the Open Files dialog box which you use to load GenBank files, 
references files and sample files for a project.

Save Project—Saves all the project files to a single file mutation project file with an .sgp 
extension. You can open an entire project in a single step by opening this SGP file. 

Raw Data to Processed Data—Enabled when AB1/ABI files without base call 
information are uploaded and Load Raw Data is selected for the Mutation Project 
settings. Converts the raw files so that base call information is displayed. 

Run—Runs the currently loaded project in Mutation Surveyor.

Restart—Opens the Options dialog box which you use to modify the current project 
settings. You can then run the project again using these new settings.

Show/Hide Browser—Shows/hides the Browser pane in the Mutation Surveyor main 
window. Also available on the Display menu (Display > Browser).

Show/Hide Nucleotides—Shows/hides the Nucleotide Sequence frame in the GAD. 
Also available on the Display menu (Display > Nucleotides).

• Show/Hide Amino Acids—Shows/hides the Amino Acid frame in the GAD. Also 
available on the Display menu (Display > Amino Acids).

• Show/Hide Tracks—Shows/hides the Tracks frame in the GAD. Also available on 
the Display menu (Display > Tracks).

Show/Hide Mutation table—Shows/hides the Mutation table in the GAD. Also available 
on the Display menu (Display > Mutation table).

Show Lines—Provides options for:

• Show All—Shows all nucleotides in the sample traces and mutation traces.

• Hide All—Hides all nucleotides in the sample traces and mutation traces.

• Showing/hiding selected nucleotides in the sample traces and mutation traces.

• Show/Hide Grid—Hides the background grid in all sample traces and mutation 
traces. 

Note: If you select Hide Grid, you can still select Show All.
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Zoom In—Zooms in on the center of the GAD.

Zoom Out—Zooms out from the center of the GAD.

Note: The GAD “remembers” all the Show/Hide settings that you last specified. Even if you close, 
and then reopen Mutation Surveyor, the Show/Hide settings remain the same for any 
project that you open.

Select Reference File—Opens the Select Reference file dialog box in which you can 
select a different reference file to which to align samples traces in a contig.

Custom Report—Opens the Custom Report Settings dialog box which you use to 
specify the settings for a custom report. See “Custom Report” on page 166.

Graphic Display—Opens the Graphic Display Report settings dialog box in which you 
specify the settings for generating a Graphic Display report. See “Graphic Display 
Report” on page 112.

GAD report—Prints the currently opened GAD in a report format. See “GAD Report” on 
page 118.

Clinical Report—Generates a Clinical report. See “Clinical Report” on page 120.

Display Mutations with 1D/2D Settings—Toggles the GAD between the 1D and 2D 
views.

Note: With 1D setting selected, more low confidence mutation calls might be included 
in reports.

Detect Heterozygous Indels—Opens the Heterozygous Indel Detection window. See 
“To add or edit a heterozygous indel (The Het_Indel tool)” on page 359.

Nucleotide Text Display Report—Generates a Nucleotide Text Display report. See 
“Nucleotide Text Display Report” on page 122.

Save Base-Modified Samples—Opens the Browser for Folder dialog box in which you 
can specify the directory in which to save modified traces. See “Edit Base” on page 97.

Re-process Modified Files—Displayed only after you edit a base call in a sample file or 
reference file. Reprocesses the mutation project based on the modified files. See “Edit 
Base” on page 97.

Export GAD—Exports selected GAD regions to a Word document, to JPG files, or 
directly to a printer. See “Exporting the GAD” on page 98.

Button Description
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Search GenBank sequence

You use the Search function to search for a specific sequence or position in the GenBank file 
for the displayed project.

1. On the GAD toolbar, click the Search the GenBank Sequence icon . 

The Search dialog box opens.

Figure 3-14:  Search dialog box

2. In the Find field, enter the appropriate search string.

3. Under Options, indicate whether to search by sequence (the default value), or by 
position.

4. Optionally, if you select Search by Sequence, then to search by a reverse complement 
sequence, click Reverse Complement.

5. Click Previous or Next to search through the GenBank sequence in the Nucleotide 
Sequence frame. 

Matching sequences or positions are highlighted in yellow.

     

Quantify—Opens the Mutation Quantification function. See “Mutation Quantifier 
Function” on page 331.

Search the GenBank Sequence—Opens the Search dialog box. You use the options 
on this dialog box to search for a specific sequence in the loaded GenBank file for a 
project. See “Search GenBank sequence” below.

Variation Tracks Settings icon - Opens the Variation Tracks Settings dialog box. The 
Variation Tracks Settings dialog box displays the available tracks settings for the 
Mutation table based on the variation databases that were imported for the project. See 
“Variation Tracks Settings dialog box” on page 91.

Note: After being imported into Mutation Surveyor, a variation database is referred to 
as a track.

Button Description
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Variation Tracks Settings dialog box

The Variation Tracks Settings dialog box contains the tracks settings for the Mutation table 
based on the variation databases that were imported for the project. (After being imported 
into Mutation Surveyor, a variation database is referred to as a track. See “The Mutation 
Surveyor Track Manager Tool” on page 310.) You can select what information to display for 
the tracks in the Annotation field, and you can filter the data that is displayed in the Mutation 
table based on the tracks, or you can choose not to filter the data based on any of the tracks.

1. On the GAD toolbar, click the Variation Tracks Settings icon . 

The Variation Tracks Settings dialog box opens. The Tracks pane is the left pane of the 
dialog box. The pane displays all the variation databases, or tracks, that were imported 
for the selected project. 

Figure 3-15:  Variation Tracks Settings dialog box, Filter Settings pane

2. If you do not want to filter the data for the project based on any of the tracks, then click 
Load Settings > Clear all track filters, and then click OK; otherwise, go to Step 3.

3. In the Tracks pane, select a track, and then do the following:

a. Indicate the types of variants that are to be included in the Mutation report. 

• All - By default, all variants that meet all the filtering criteria are displayed in 
the Mutation report, whether they are included in the selected track. 

• Reported - Select Reported to display only those variants that meet all the 
filtering criteria and that are included in the selected track.

• Unreported - Select Unreported to display only those variants that meet all the 
filtering criteria, but they are not included in the selected track. 
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b. Specify the filter settings for the track. 

• Click Report Display to open the Report Display Settings dialog box.

The Report Display Settings pane displays all the columns that can be included in 
the Annotation field of the Mutation table. By default, no columns are selected. 

Figure 3-16:  Mutation Tracks Settings dialog box, Report Display Settings pane

4. Select the columns that are to be included in the Annotation field of Mutation table, and 
then optionally, select one or both of the following:

• Display track group—Displays the track group in the Annotation field, for example, 
ClinVar for the ClinVar database.

• Display track name—Displays the track name in the Annotation field. (This is the 
name that you assigned to the track during its import with the Track Manager tool. 
See “The Mutation Surveyor Track Manager Tool” on page 310.)

5. Repeat Step 3 and Step 4 for each track that is to be used to filter the Mutation table.

6. Click OK to close the Report Display Settings dialog box.

7. Do one of the following to save your settings and close the Variation Tracks Settings 
dialog box:

• Click OK. 

Going forward, the Mutation table is generated according to these saved settings 
until you change them.

     

The available settings vary for each track. 
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• Save Settings > Save User Defaults, and then click OK. 

The settings that you have specified for all the tracks are saved as your (the logged in 
user’s) default settings. Going forward, any new project that you run in Mutation 
Surveyor uses these settings by default. If you change the settings for a project, and 
want to generate the Mutation table display based on your default settings, then you 
can click Load Settings > Load User Defaults to restore your default settings.

• Save Settings > Save To File, and then click OK. 

The settings that you have specified for all the tracks are saved to a Settings (.ini) 
file. Going forward, you can click Load Settings > Load From File to load this saved 
Settings file and generate the Mutation table display according to the settings in the 
file. 
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Graphical Analysis Display Navigation and 
Analysis Options

You can easily change the view in the GAD or navigate the GAD viewer using some of the 
toolbar icons (see “GAD Toolbar” on page 88) or your mouse and some keyboard hotkeys. 
Options are also available for analyzing mutation project data so that you identify the true 
mutations in a mutation project. Miscellaneous options are also available for manipulating 
the mutation project data so that you can work with the data in outside programs if needed.

GAD viewing and navigation options

     

Action Description

Zoom in Click and hold the left mouse button and draw a box from the upper left 
hand corner of the pane towards the lower right hand corner. A box is 
formed around the area that being reduced for viewing.

Zoom out Click and hold the left mouse button and draw a box from the lower right 
hand corner of the pane towards the upper left hand corner. 

Note: The magnification for zooming out is always 100%.

Moving an image in the 
GAD

To move any image (frame or trace) in the GAD, right-click and hold the 
mouse button on the image, and then move the mouse. 

Note: The frames and traces are linked in the GAD. If you zoom in on a region in one of the 
frames or traces or zoom out from a region in one of the frames or traces, then this action is 
automatically duplicated in the same region in all the other frames and traces. If you move a 
frame or a trace, then all other frames and traces are moved to the same position as well.

Moving to a mutation 
peak

Press and hold the [Ctrl] key and then press:

• F to move forward to the next mutation peak.

• B to move back to the previous mutation peak.

Note: You move to each mutation peak on a trace by trace basis. For 
example, if Sample Trace #1 has five mutation peaks, Sample 
Trace #2 has no mutation peaks, and Sample Trace #3 has one 
mutation peak, you must press CTRL+F five times to move to 
each mutation peak in the Sample Trace #1. When you press 
CTRL+F the 6th time, you move to the mutation peak in Sample 
Trace #3. 

Moving to a trace Use the Browse function on the right side of the Traces component in 
the GAD to move to the next or previous trace. 
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GAD analysis options

Analysis options are available from the context menu for the Mutation table and from 
various context menus in the GAD. Any edit action (addition, substitution, or deletion) that 
you carry out for a mutation is displayed in the Actions column for the mutation in the 
Mutation table.

Action Description

Mutation table context menu analysis options

Edit Comments You can manually add or edit comments for a mutation call. 

• Right-click the entry for the mutation call on the Mutation table, and on 
the context menu that opens, click Edit Comments. You can add original 
comments in the Comments field, or you can select from a list of up to 
200 customizable Comment templates.

• Right-click the entry for the mutation call on the Mutation table, and on 
the context menu that opens, click Edit. The Edit Substitution dialog box 
or the Edit Indel dialog box opens. Add comments in the Comments 
field in this dialog box.

Note: For detailed information about editing a mutation call, see Chapter 
12, “Reviewing and Editing Mutation Projects,” on page 355.

Edit Right-click the entry for the mutation in the Mutation table, and on the 
context menu that opens, click Edit. The Edit Substitution dialog box or the 
Edit Indel dialog box opens. Edit the mutation call as appropriate. 

Note: For detailed information about editing a mutation call, see Chapter 
12, “Reviewing and Editing Mutation Projects,” on page 355.

Delete Mutation • Right-click the entry for the mutation in the Mutation table, and on the 
context menu that opens, click Delete Mutation.

• Click the entry for the mutation in the Mutation table, and then click 
[Ctrl]-D.

• Press and hold the [Ctrl] key, and then right-click the mutation peak in 
the trace to open a Warning message about deleting the mutation call. 
Click OK in the message to delete the mutation call. 

In the Delete Mutation dialog box that opens, you can simply click OK to 
delete the mutation without adding it to the User Knowledge database, or if 
the GenBank file that was used for the project contains chromosome 
information, then you can add the mutation to the User Knowledge 
database. (See “Creating a User Knowledge Database for Known 
Deletions” on page 371.) The text for the mutation code turns gray in the 
Mutation table. The comment <<Deleted>> is displayed in the Actions field 
in the Mutation table.

Undo Mutation 
Deletion

• Right-click the entry for the deleted mutation in the Mutation table, and 
on the context menu that opens, click Undo Mutation Deletion.

• Press and hold the [Ctrl] key, and then right-click the deleted mutation in 
the trace to open a Warning message about undoing the deletion of the 
mutation call. Click OK in the message to undo the deletion of the 
mutation call
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Delete Lane Make sure that the appropriate trace is open in the GAD, and then 
right-click any entry in the Mutation table and on the context menu that 
opens, click Delete Lane.

Note: The Lane Quality for a deleted lane is set to “Low Quality” in the 
GAD. All the mutations for the deleted lane are removed from the 
Mutation table.

Note: The context menu for a contig in the Browser pane also has a 
Delete Lane option. See “Contig directory for a Mutation Surveyor 
project” on page 76.

Undo Lane Deletion Make sure that the appropriate trace is open in the GAD, and then 
right-click any entry in the Mutation table and on the context menu that 
opens, click Undo Lane Deletion.

Note: The Lane Quality for the lane is reset to its original value. All the 
mutations that were deleted for the lane are again displayed in the 
Mutation table.

Note: The context menu for a contig in the Browser pane also has a 
UnDo Lane Deletion option. See “Contig directory for a Mutation 
Surveyor project” on page 76.

Confirm/Undo 
Confirmation 

Right-click the entry for the mutation in the in the Mutation table, and on 
the context menu that opens, click the appropriate option.

Undo Undo the last edit action that was carried out for the mutation.

View Edit History See “Viewing the Edit History (Audit Trail) for a Mutation” on page 373.

Hyperlink to NCBI’s 
dbSNP

Opens the NCBI’s database entry (via the web) for the variant.

GAD context menu analysis options

Delete Lane Make sure that the appropriate trace is open in the GAD, and then 
right-click the Sample Trace name, and on the context menu that opens, 
click Delete Lane.

Note: The Lane Quality for a deleted lane is set to “Low Quality” in the 
GAD. All the mutations for the deleted lane are removed from the 
Mutation table. 

Note: The context menu for a contig in the Browser pane also has a 
Delete Lane option. See “Contig directory for a Mutation Surveyor 
project” on page 76.

Undo Lane Deletion Make sure that the appropriate trace is open in the GAD, and then 
right-click the Sample Trace name, and on the context menu that opens, 
click Undo Lane Deletion.

Note: The Lane Quality for the lane is reset to its original value. All the 
mutations that were deleted for the lane are again displayed in the 
Mutation table.

Note: The context menu for a contig in the Browser pane also has a 
Undo Lane Deletion option. See “Contig directory for a Mutation 
Surveyor project” on page 76.

Action Description
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Miscellaneous GAD options

Add Substitution Call Right-click in the mutation trace at the position at which you want to add 
the substitution, and on the context menu that opens, click Add 
Substitution. The Add Substitution dialog box opens. Add the substitution 
as appropriate.

Note: For detailed information about modifying a mutation call, see 
Chapter 12, “Reviewing and Editing Mutation Projects,” on page 
355.

Note: If you click a peak for a substitution mutation event, a message 
opens indicating that substitution already exists at the selected 
position and asking you if you want to replace it. Click OK to 
continue with the substitution. 

Add Insertion/
Deletion Call

Press and hold the [Ctrl] key, and then click the mobility line at the position 
of the indel. The Add Indel dialog box opens. Add the Indel call as 
appropriate. 

Note: For detailed information about modifying a mutation call, see 
Chapter 12, “Reviewing and Editing Mutation Projects,” on page 
355.

Edit Base • Right-click a reference or sample trace and click Edit Base. A dialog 
box opens that displays the complete base sequence for the trace. 

• Click the base that you are editing and enter the text for the new base 
(A,C, G, or T.) 

• Click the Close button (“X”) to close the dialog box, and then click “Yes” 
at the prompt to save the base call changes. 

Note: If you do not want to override the original traces, you can save the 
modified traces to a different location. See Save Base-Modified 
Samples on page 89.

• Click the Re-process Modified Files button  to run the project with 

the modified sample and/or reference traces. 

Action Description

Action Description

Copy Image Press and hold the [Shift] key and the [Ctrl] key and then click and hold 
the left mouse button and draw a box around the region of the image 
that you want to copy. The selected region is filled with black. Right-click 
and select Copy to copy the image to your clipboard. Use standard 
keyboard commands or menu commands to paste the copied image 
into an application.

Copy Text Right-click a table cell in the Mutation table and click Copy to copy the 
text in the cell to your clipboard. To copy text in a range of cells, click 
and hold the left mouse button and drag the mouse to select the region 
that you want to copy. Use standard keyboard commands or menu 
commands to paste the copied text into an application.
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Exporting the GAD
You use the Export GAD function to export mutation traces and other information for 
selected mutations to a Word document, to separate JPG files, or directly to a printer. 

Figure 3-17:  Export GAD dialog box

A variety of graphic-based reports that present part or all the GAD in a report 
format are also available in Mutation Surveyor. See Chapter 4, “Mutation 
Surveyor Graphical Reports,” on page 101.

Option Description

Settings

Output the Current 
Mutation Only

Exports the GAD for only those mutations (+-16 bp) that are currently 
displayed in the GAD for the selected sample file.

Output the Mutations in 
the Samples

Exports the GADs for all the mutations in all the sample files for every 
contig.

Output Points of Interest Exports the GAD only for the specified base positions. (The Base 
position must be the genomic position where at least one sample 
contains a mutation call at the point of interest.)

• If Output the Mutations in the Samples is also selected, then images 
are captured for not only all mutation calls, but also for positive and 
negative mutations at all Points of Interest.

• If Output the Mutations in the Samples is not selected, then images 
are captured for only positive and negative mutations at all Points of 
Interest.
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Output Header 
Information

Automatically populated with the default Mutation Surveyor header 

information file. You can click the Browse button  to open the Open 

File dialog box, and browse to and select a custom header to add to the 
report.

Note: A header is a .inf file. For a discussion of Custom headers and 
how to create one, see “Print Header Editor Tool” on page 277.

Save the Word File As Available only if Save the Report as a Word file is the selected action. 
Automatically populated with the default location (c:\data) and filename 
for the Word file to which the mutations traces for the selected mutations 

are being exported. You can click the Browse button  to open the 

Save As dialog box, and specify a different location, name, or both for 
the Word files.

Note: This function works only when Microsoft Word is installed on the 
client computer. If the client’s copy of Word has additional 
add-ons, such as End Note, installed, this function might not 
work properly.

Save separate JPG files 
into

Available only if Saving Report as Separate JPG Files is the selected 
action. Automatically populated with the default location (c:\data) to 
which the mutation traces for the selected mutations are being exported. 

You can click the Browse button  to open the Browse for Folder 

dialog box, and specify a different location for the JPG files.

Action

• Save the Report as a 
Word File

• Exports all the mutation traces to a single Word file.

• Send the Report 
Directly to the Printer

• Exports the files to directly to the system’s default printer

• Save the Report as 
Separate JPG Files

• Export each mutation trace as a separate JGP file

Nomenclature

• Genomic • Displays the mutation call positions based on the genomic position 
referenced in the GenBank file.

• Relative to CDS • Displays the mutation call positions relative to the CDS numbering in 
the GenBank reference file. A mutation that is called in the CDS is 
prefixed with a “c.” A mutation that is called in a non-coding region is 
prefixed with “IVS.” Its position is identified by the closest nucleotide 
in the coding sequence plus or minus the number of bps by which it 
resides away from the closest nucleotide

• Relative to mRNA • Displays the mutation call positions relative to the mRNA numbering 
in the GenBank reference file. A mutation that is called in the mRNA 
region is prefixed with a “c.” A mutation that is called outside of an 
mRNA region is identified by the closest nucleotide in the mRNA 
region plus or minus the number of bps by which it resides away from 
the closest nucleotide.

Option Description
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Nomenclature (cont’d)

• HGVS • Displays the mutation call positions relative to its position in the 
coding sequence. A mutation that is called in a non-coding region is 
identified by the closest nucleotide in the coding sequence plus or 
minus the number of bps by which it resides away from the closest 
nucleotide. Both alleles are shown in separate bracketed statements

Note: For any of the four standard Nomenclature options, if a GenBank file was not loaded as the 
reference file, then the Base Number is enclosed in parenthesis and it indicates the position 
of the base in the reference file. If both a GenBank file and a reference file were loaded for 
the mutation project and the mutation was called at a position that does not align to the 
GenBank file, then the Base Number is enclosed in parenthesis and is displayed as +/- the 
number of base pairs by which the mutation was shifted in comparison to the GenBank file. 

Option Description
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A variety of graphic-based reports that provide detailed information about a mutation project 
are available in Mutation Surveyor. All these reports, which are available from the Display 
option on the Mutation Surveyor main menu, present part or all the GAD in a report format. 
All these reports rely heavily on the use of colored legends to indicate critical information 
about the mutation project data. You can print the information in these reports and you can 
save and store the report information for use at a later date.

This chapter covers the following topics:

• “Project Reviewer Report” on page 103.

• “Graphic Display Report” on page 112.

• “GAD Report” on page 118.

• “Clinical Report” on page 120.

• “Nucleotide Text Display Report” on page 122.

     
Mutation Surveyor User’s Manual 101



Chapter 4
Mutation Surveyor Graphical Reports
     
102 Mutation Surveyor User’s Manual



Chapter 4
Mutation Surveyor Graphical Reports
Project Reviewer Report
You use the Project Reviewer report to view mutation project data for one contig at a time, or 
for all contigs at the same time. The data that you can view includes the reference nucleotide 
sequence, the consensus sequence for all the sample traces, the sequence for each sample 
trace, and all the mutation calls for all the samples. You can use the Project Reviewer 
functions to customize the viewing of this information for your sample files. For example, 
you can use the Sample Grouping function to group all your sample files by an identifier and 
view any overlapping contigs that result. You can also use the Project Reviewer to edit 
mutation calls. 

Figure 4-1:  Project Reviewer report 

Project Reviewer report layout

To view the color coding legends that are used in the report, click Legend at the top of the 
report. The report displays mutation project data according to these legends in four panes.

• Sample pane—The Sample pane is the top left pane. This pane lists all the sample files 
that are contained in the currently selected contig. 

• Base pane—The Base pane is the top center pane. The top row of numbers indicates the 
genomic base position in the reference file. The color of the horizontal location bars that 
run below the genomic position numbers indicates the location of the sequence that is 
being displayed in the trace. Colored tick marks indicate reported variations. The first row 
of nucleotides in the pane is the reference nucleotide sequence. The second row of 

Base pane Trace paneMutation Table paneSample pane
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nucleotides in the pane is the consensus sequence for the sample traces. The remaining 
rows show the sequence for each sample trace. A black dash (-) indicates a match between 
the reference file and the sample file. If a different base is at the same position in the 
sample file and reference file, then the standard IUB/IUPAC code for the base is shown 
in the sample file at the position. Color-coding is used to indicate the mutation type. No 
information is displayed for areas that fall outside the comparison region. A gray square 
indicates a mutation that has been deleted either by Mutation Surveyor or by a user. 

• Trace pane—The Trace pane is the top right pane. This pane displays the sample traces, 
the mutation traces, or both for all the selected samples in the sample and base panes.

• Mutation Table pane—The Mutation Table pane is the lower pane. This pane displays all 
the mutation calls for all the samples in the selected contig. The mutation call codes and 
color-coding that are used in this table are identical to the mutation call codes and color-
coding that are used in the Mutation standard report. See “Mutation Report” on page 129.

The report is interactive:

• To zoom in on a selected region for the sample files, in the Base pane, click and hold the 
left mouse button and draw a box from the upper left hand corner of the region towards 
the lower right hand corner of the region. A box is formed around the area that is being 
reduced for viewing. 

• To zoom in on a selected region for a trace, in the Trace pane, click and hold the left 
mouse button and draw a box from the upper left hand corner of the region towards the 
lower right hand corner of the region. A box is formed around the area that is being 
reduced for viewing. 

• To zoom out from the sample files or trace, click and hold the left mouse button and draw 
a box from the lower right hand corner of the file sequence or trace towards the upper left 
hand corner of the sequence or trace. The magnification for zooming out is always 100%.

• To change the view in the reviewer to a selected mutation, double-click the mutation in 
the Mutation Table pane.

• To change the view to that for a different contig, select the contig on the Contig dropdown 
list. 

By default, the Base pane and Trace pane are linked in the Project Reviewer. If you 
zoom in on a region in one of the panes or zoom out from a region in one of the 
panes, then this zooming action is automatically duplicated in the same region in 
the other pane. You can turn off this automatic linking. See “Project Reviewer 
report toolbar” on page 106.

If you select All, then any overlap among the contigs is displayed in the Base pane 
and in the Trace pane
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Figure 4-2:  Overlapping contigs displayed in the Base pane

• To manipulate and analyze mutation project data, right-click a mutation call in the 
Mutation Table pane and on the context menu that opens, click the appropriate option.

Figure 4-3:  Mutation Table pane context menu

Option Description

Copy Copies the selected text in the cell to your clipboard. To copy text in a range of 
cells, click and hold the left mouse button and drag the mouse to select the 
region that you want to copy. Use standard keyboard commands or menu 
commands to paste the copied text into an application.

Note: You can also copy the Project Reviewer report as an image. Press and 
hold the [Shift] key and the [Ctrl] key, and then click and hold the left 
mouse button and draw a box around the region of the image that you 
want to copy. The selected region is filled with black. Right-click and 
select Copy to copy the image to your clipboard. Use standard 
keyboard commands or menu commands to paste the copied image 
into an application.
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Project Reviewer report toolbar

The Project Reviewer report toolbar contains buttons that are specific for navigating and 
working with the Project Reviewer report. The buttons that are displayed on the toolbar 
depend on whether a single contig is selected or all contigs are selected.

Figure 4-4:  Project Reviewer report toolbar for a selected contig

Figure 4-5:  Project Reviewer report toolbar for all contigs

Edit Opens the Edit Substitution or Edit Indel dialog box in which you can edit the 
selected mutation call. 

Note: For detailed information about modifying a mutation call, see Chapter 
12, “Reviewing and Editing Mutation Projects,” on page 355.

Delete Deletes the selected mutations. 

Note: SHIFT-click to select multiple contiguous mutations.

The text for the mutation code turns gray in both the Project Reviewer report 
and the Mutation Table pane. 

Undo Deletion Reverses the deletion of the selected mutation. 

Note: SHIFT-click to select multiple contiguous mutations.

Delete Lane Note: Deletes all the mutations for a selected sample in a single step. The 
Lane Quality for a deleted lane is set to “Low Quality.”

Note: SHIFT-click to select multiple contiguous samples.

Undo Deletion Reverses the deletion of the selected lane.

Note: SHIFT-click to select multiple contiguous samples.

Confirm Confirms the selected mutations. The text for the mutation code turns black in 
both the Project Reviewer report and the Mutation Table pane. 

Note: SHIFT-click to select multiple contiguous mutations.

Undo 
Confirmation

Removes the “Confirmed” status for the mutation. 

Note: SHIFT-click to select multiple contiguous mutations.

Hyperlink to 
NCBI’s dbSNP

Opens the NCBI’s database entry (via the web) for the variant.

Option Description

Button Description

Show Sample Trace—Selected by default. Shows the sample traces in the Trace 
pane. 

Show Mutation Trace—Selected by default. Shows the mutation traces in the Trace 
pane.
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Link—Selected by default. Links the Base pane and the Trace pane. If you zoom in 
on a region in one of the panes or zoom out from a region in one of the panes, then 
this zooming action is automatically duplicated in the same region in the other pane. 
You can turn off this automatic linking.

Sample Grouping—Opens the Sample Grouping dialog box in which you can 
specify how sample traces are to be grouped in the report.

Figure 4-6:  Sample Grouping dialog box

• From Character [ ] To Character [ ]—Select this option if all the filenames in your 
project contain the same character string/designator in the same positions.

• From File—Select this option if traces that are to be grouped together contain a 
common Sample ID in their filenames. (The Sample IDs do not need to be in the 
same location in the filename.) After you click From File, click Load Sample ID to 
open the Load Sample ID dialog box and specify the different Sample IDs, such 
as Patient #, by which to group the traces. You can also click Open in the Load 
Sample ID dialog box to load an existing Sample ID text file.

Note: By default, the Load Sample ID dialog box contains rows for up to ten 
different Sample IDs. You can right-click and click Insert or Delete as 
needed. 

Move Left/Move Right—Moves the display in the Base pane and Trace pane in the 
indicated direction.

Report Settings—Opens the Project Reviewer Report Settings dialog box, in which 
you can specify what information is to be displayed in the report, what color-coding 
is to be used in the report, and what nomenclature is to be used in the report. See 
“Project Reviewer Report Settings dialog box” on page 108.

Show/Hide Sample—Shows/hides the Sample pane.

Show/Hide Annotation—Shows/hides the gene/CDS annotation in the Base pane 
and the Trace pane.

Show/Hide Base—Shows/hides the Base pane.

Show/Hide Trace—Shows/hides the Trace pane.

Button Description
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Project Reviewer Report Settings dialog box

The Project Reviewer Report Settings dialog box contains three tabs—Mutation, Color, and 
Nomenclature—on which you can specify what information is to be displayed in the report, 
what color-coding is to be used in the report, and what nomenclature is to be used in the 
report, respectively. 

Figure 4-7:  Project Reviewer Report Settings dialog box, Mutation tab

Mutation tab

• Nucleotide Position—Nucleotide positions are displayed in the nomenclature that you 
select on the Nomenclature tab. (See “Nomenclature tab” on page 110.)

• Amino Acid Position—By default, amino acid information is organized with the 
reference amino acid displayed first, the amino acid position displayed next, and the 
mutation amino acid displayed last. If you do not select Amino Acid Position, then a slash 
(/) is displayed between the reference amino acid and the mutation amino acids.

• Confidence(!)—Displays a Confidence mark (!) for mutation calls that exceed certain 
thresholds as defined in the MutationSurveyor.ini file.

Show/Hide Mutation Table—Shows/hides the Mutation Table pane.

Add GenBank File—Available only if All contigs are selected. If you used SEQ files 
as reference files, click the this button to open the Add GenBank file dialog box and 
select a GenBank to add to the project. The Project Reviewer then aligns the SEQ 
files to the GenBank and as a result, the SEQ files are displayed in genomic order. 

The majority of options on this tab are self-explanatory, and therefore, not all 
these options are discussed in this section. 

Although you can modify these thresholds, SoftGenetics does not recommend that 
you do so on your own. Contact SoftGenetics for assistance.

Button Description
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• Comments—Displays all comments that were added to a mutation call, either 
automatically by Mutation Surveyor or manually by a user.

Color tab

Figure 4-8:  Project Reviewer Report Settings dialog box, Color tab

The Color tab provides a variety of color-coding options to assist you with identifying 
different types of mutation calls and potential analysis problems. Color-coding is applied 
according to the following:

• If a mutation call meets several color-coding criteria, the call is displayed in the report in 
the color of highest priority. 

• If None is selected for a color-coding option, then the color of the next highest priority is 
used. 

• For Mutation Region Text color-coding, the priorities from highest to lowest are as 
follows—Deleted, Confirmed, Added, Edited, High Confidence, Low Confidence, 
Normal Alleles, and Not Available. 

• For Mutation Region Background color coding, priorities from highest to lowest are as 
follows—Mosaic, Reported, A.A. Change, Indel, Synonymous, Heterozygous, 
Homozygous, and Not Available, where Synonymous identifies the coding and 
non-coding substitutions that do not affect the amino acid sequence.
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Nomenclature tab

Figure 4-9:  Project Reviewer Report Settings dialog box, Nomenclature tab

If you select Nucleotide positions on the Mutation tab, then the positions are displayed in the 
nomenclature that you select on the Nomenclature tab. 

Option Description

Genomic Displays the mutation call positions based on the genomic position 
referenced in the GenBank file.

Relative to CDS Displays the mutation call positions relative to the CDS numbering in the 
GenBank reference file. A mutation that is called in the CDS is prefixed 
with a “c.” A mutation that is called in a non-coding region is prefixed 
with “IVS.” Its position is identified by the closest nucleotide in the 
coding sequence plus or minus the number of bps by which it resides 
away from the closest nucleotide.

Relative to mRNA Displays the mutation call positions relative to the mRNA numbering in 
the GenBank reference file. A mutation that is called in the mRNA 
region is prefixed with a “c.” A mutation that is called outside of an 
mRNA region is identified by the closest nucleotide in the mRNA region 
plus or minus the number of bps by which it resides away from the 
closest nucleotide.

HGVS Displays the mutation call positions relative to its position in the coding 
sequence. A mutation that is called in a non-coding region is identified 
by the closest nucleotide in the coding sequence plus or minus the 
number of bps by which it resides away from the closest nucleotide. 
Both alleles are shown in separate bracketed statements. 

Note: If any of the four standard Nomenclature options is selected and a GenBank file was not 
loaded as the reference file, then the Base Number is enclosed in parenthesis and it 
indicates the position of the base in the reference file. If both a GenBank file and a 
reference file were loaded for the mutation project and the mutation was called at a position 
that does not align to the GenBank file, then the Base Number is enclosed in parenthesis 
and is displayed as +/- the number of base pairs by which the mutation was shifted in 
comparison to the GenBank file. 
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Figure 4-10:  Nomenclature Examples
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Graphic Display Report
You use the Graphic Display report to examine sample alignment and mutation calls for a 
single contig. The GAD Display report is available from the Display option on the Mutation 
Surveyor main menu or you can click the Graphic Display icon  on the GAD. After you 
select either option, the Graphic Display Report Settings dialog box opens. You specify the 
options in this dialog box, and then click OK to generate the report. (See Figure 4-12 on page 
113.)

Figure 4-11:  Graphic Display Report Settings dialog box

Option Description

Reject 1D Calls When 
Other Direction has No 
Call

Reject a mutation that is called in only one direction when the position 
falls within the comparison region of the other direction. 

Reject 1D Calls When 
Other Direction is Not 
Available

Reject mutation calls that occur outside the region where the sample 
traces in both directions are aligned within the comparison region.

Reject Synonymous 
Mutations

Coding region substitutions that do not affect amino acid calls are not 
displayed in the report.

Display Mutations with 
the “Stop” Codon or 
Indel Only

Display only nonsense mutations and indels in the report.

Display Confirmed 
Mutations Only

Display only those mutations that you have manually confirmed in the 
report.
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Figure 4-12:  Graphic Display report

Graphic Display report layout

The top row of the Graphic Display report details the color coding legends that are used in 
the report. The report displays mutation project data below these legends in four panes. From 
top to bottom, these panes are as follows:

• GenBank pane—The GenBank pane displays information about the loaded GenBank file. 
Genomic positions are indicated in kilobases (kb). The color of the horizontal location 
bars that run below the genomic position numbers indicates the location of the sequence 
that is being displayed in the trace. Colored tick marks indicate reported variations.

• Reference pane—The Reference pane displays information about the reference trace that 
was used for the selected contig. The trace can be a reference file that you manually added 
to the project, or it can be a synthetic reference file that Mutation Surveyor created from 
the loaded GenBank file. 

• Sample pane—The Sample pane displays all the sample files that are contained within the 
selected contig. 

• Allele Frequency pane—The Allele Frequency pane shows the percentage of samples in 
the contig that have the mutation call at the indicated position. Color-coding is used to 
indicate the mutation type.

• Mutation Score pane—The Mutation Score pane shows the average mutation score for all 
the calls at the indicated position for the contig. 
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The report is interactive:

• To zoom in on a selected region, in any pane, click and hold the left mouse button and 
draw a box from the upper left hand corner of the region towards the lower right hand 
corner of the region. A box is formed around the area that is being reduced for viewing. 

• To zoom out from any region, click and hold the left mouse button and draw a box from 
the lower right hand corner of the region towards the upper left hand corner of the region. 
The magnification for zooming out is always 100%.

• To change the view to that for a different contig, select the contig on the Contig dropdown 
list. 

• By default, the filenames for all the files (GenBank, reference files, and sample files) are 
displayed on the report. To remove the filenames from the report display, clear the Show 
Filenames option.

Graphic Display report toolbar

The Graphic Display report toolbar contains buttons that are specific for navigating and 
working with the Graphic Display report. 

Figure 4-13:  Graphic Display report toolbar

     

All the panes in the Graphic Display are linked. If you zoom in on a region in any 
pane, or zoom out from a region in any pane, then this zooming action is 
automatically duplicated in the same regions in all the other panes.

Button Description

Print Preview—Opens the Graphic Display Print Preview window, which 
displays a preview of what is to be printed for the report.

Note: Before you print the Graphic Display report, make sure to adjust 
the zoom level so that the area of the report that you want to 
print is displayed in the report window.

Report Settings—Opens the Graphic Display Report Settings dialog 
box, in which you can specify what information is to be displayed in the 
report. See Figure 4-11 on page 112. 

Project Display Report—Opens the Project Display Report Settings 
dialog box, in which you specify the information that is to be displayed in 
the Project Display subreport, as well a how the sample files are to be 
grouped in the subreport. See “Project Display subreport” on page 115.

Show Filenames Selected by default. Shows the filenames on the report.
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Project Display subreport

You use the Project Display subreport as another way of graphically viewing mutation 
project data. Options are available for filtering mutation calls that are displayed in the report 
and for grouping sample files based on the character string/designator that is used in your 
sample filenames. This subreport, which has a layout that is almost identical to that of the 
Graphic Display report, is ideal for comparing overlapping sample traces that were analyzed 
in separate contigs. The subreport opens after you click OK in the Project Display Report 
Settings dialog box. 

Figure 4-14:  Project Display Report Settings dialog box

Option Description

Mutation Scores

Reject 1D Calls When 
Other Direction has No 
Call

Reject a mutation that is called in only one direction when the position 
falls within the comparison region of the other direction. 

Reject 1D Calls When 
Other Direction is Not 
Available

Reject mutation calls that occur outside the region where the sample 
traces in both directions are aligned within the comparison region.

Reject Synonymous 
Mutations

Coding region substitutions that do not affect amino acid calls are not 
displayed in the report.

Note: In cases where the entire column was not omitted from the report because of rejection by 
one of these criteria, the rejected mutations have no background color and an “n.a.” is 
displayed in the Mutation cell instead of the mutation code.

Display Mutations with 
the “Stop” Codon or 
Indel Only

Display only nonsense mutations and indels in the report.

Display Confirmed 
Mutations Only

Display only those mutations that you have manually confirmed in the 
report.
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Figure 4-15:  Project Display subreport

     

Homozygous Dropping 
Threshold

Indicates the value for the dropping factor at which a mutation is 
identified as either a homozygous substitution or a heterozygous 
substitution. For example, is a mutation A>C or A>AC? Because 
Mutation Surveyor evaluates the traces rather than the base calls, noise 
below a major peak can sometimes be interpreted as a heterozygous 
substitution. This value assists in your analysis by converting these calls 
to homozygous substitutions. 

You can increase this value to view the exact call that Mutation Surveyor 
made, but an increased value might result in some calls remaining as 
heterozygous substitutions.

Sample Grouping

Specify the filename substring by which Mutation Surveyor groups all 
the mutation project samples files in the subreport. 

• n-Primer (n-D) Text Input—Use the ND Grouping file to group the 
sample files. See “ND Filename Match Editor Tool” on page 274.

• Filename Match (based on one of the following):

• From Character [ ] To Character [ ]—If all the filenames in your 
project contain the same characters/designator in the same 
positions, then select this option and enter the starting and ending 
character positions.

Note: Typical Block—If all the filenames in your project contain the 
same characters/designator but in different positions, then 
select this option and enter the value for the character/
designator block.

Option Description
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Project Display subreport toolbar

The Project Display subreport toolbar contains options and buttons that are specific for 
navigating and working with the subreport.

Figure 4-16:  Project Display subreport toolbar

Option/Button Description

Select GenBank File If your mutation project used multiple GenBank files, then select one of 
these files from this list to view the file and the sample files that align to 
it.

Print Preview—Opens the Preview window, which displays a preview of 
what it to be printed for the report.

Note: Before you click the Print Preview button, make sure to adjust 
the zoom level so that the area of the report that you want to 
print will be displayed in the Preview window.

Project Report—Generates a Project report for the sample files. See 
“Project Report” on page 148.

Modify Mutation Projects—See “Modifying Mutation Surveyor Projects” 
on page 343.

Show Filenames By default, the filenames for all the files (GenBank, reference files, and 
sample files) are displayed on the subreport. To remove the filenames 
from the report display, clear the Show Filenames option.

Exact Filename Match Select this option to pair sample files in the report display when the 
filenames for the forward and reverse sample files are very similar.

Note: This sorting option is used in conjunction with the sorting 
options that you specified on the Project Display Report 
Settings dialog box to further group sample files in the report 
display.
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GAD Report
The GAD report displays the Graphical Analysis Display (GAD) for the sample files that are 
contained in a single contig in a report format. You can specify whether the report is to 
display all the traces for all the sample files in the contig, or whether the report is to display 
only those traces for the sample files that contained mutation calls (the default setting for the 
report). After you click GAD Report on the Display menu, the GAD Report Settings dialog 
box opens. You can leave the default option of Print Samples with Mutations Only selected, 
or you can clear this option to display all the traces for all the sample files for a selected 
contig in the report. After you click OK, the GAD report opens.

Figure 4-17:  GAD Report Settings dialog box

Figure 4-18:  GAD report

The first two traces that are displayed in the report are the forward and reverse reference 
traces used for the selected contig. (The names of the traces are displayed in brown font to 
indicate that they are reference traces.) The remaining traces are the traces for the sample 
files in the selected contig. The traces are either the traces for all the sample files that are 
contained in the selected contig, or they are those traces for display the trace regions for only 
those samples in the selected contig that contain mutation calls. To view the traces for a 
different contig, select the contig on the Contig dropdown list.
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GAD Report toolbar

The GAD report toolbar contains options and buttons that are specific for navigating and 
working with the report.

Figure 4-19:  GAD report toolbar

Option/Button Description

Sample Indicates the sample for which the sample traces are currently in view 
for the report. You can select a different sample from the list, or you can 
use the Scroll feature on the right side of the report window to change 
the view.

Zoom In—Zooms in on a region of the report for viewing.

Note: You can also manually zoom in on a region for viewing. Click 
and hold the left mouse button and draw a box from the upper 
left hand corner of the pane towards the lower right hand corner. 
A box is formed around the area that being reduced for viewing.

Zoom Out—Zooms out from a region of the report for viewing. The 
magnification for zooming out is always 100%.

Note: You can also manually zoom out from a region for viewing. Click 
and hold the left mouse button and draw a box from the lower 
right hand corner of the pane towards the upper left hand 
corner. 

Move Left—Moves the currently displayed report view to the left.

Note: You can also manually move the report view to the left. Right-
click and hold the mouse button on the report view, and then 
move the mouse. 

Move Right—Moves the currently displayed report view to the right.

Note: You can also manually move the report view to the left. Right-
click and hold the mouse button on the report view, and then 
move the mouse.

Print Preview—Opens the Preview window, which displays a preview of 
what it to be printed for the GAD report. You can use the options on the 
Preview window’s toolbar to adjust variables such as the color scale and 
the page layout before you print the report.

Note: Before you click the Print Preview button, make sure to adjust 
the zoom level so that the area of the report that you want to 
print will be displayed in the Preview window.

Print Samples with 
Mutations Only

Select this option to display only those traces for the sample files that 
contained mutation calls.

Show Mutation 
Information

Select this option to display the code for each mutation call on the 
report. The code for each call is displayed directly above the mutation 
peak in the sample trace.
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Clinical Report
The Clinical report is a custom-formatted report that contains options for displaying only 
those sample files with mutation calls or for displaying all positions with reported annotation 
information, including negative SNPs. The report shows one pair of sample files in a contig 
per page, and the report includes the mutation code for each called mutation. To generate a 
Clinical report, do the following:

1. On the Reports menu, click Clinical Report.

The Print Report Settings dialog box opens. 

Figure 4-20:  Print Report Settings dialog box

2. Select one or both options as appropriate for your report:

• Print Samples with mutations only—Show only those samples that contain called 
mutations.

• Print Samples with negative SNPs—Show those samples that contained negative 
mutation calls, where a negative SNP is defined as position in the GenBank file at 
which a variation has been reported, but no variation was detected at the same 
position in the sample trace. Sample traces that have negative SNPs might still 
contain mutation calls.

3. Optionally, click the Browse button  to open the Open File dialog box, and browse to 

and select a custom header to add to the report. 

4. Click OK.

The Clinical Report opens in the Print Preview window. You can use the options on the 
Preview window’s toolbar to adjust variables such as the color scale and the page layout 
before you print the report. See Figure 4-21 on page 121.

A header is a .inf file. For a discussion of Custom headers and how to create one, 
see “Print Header Editor Tool” on page 277.
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Figure 4-21:  Clinical report 
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Nucleotide Text Display Report
The Nucleotide Text Display report is a color-coded report of the text base calls of all the 
sample file sequences for a selected contig. The report has options for displaying every 
nucleotide position for every sample trace in a selected contig or for displaying only those 
nucleotide positions at which a mutation was called. To generate a Nucleotide Text Display 
report, do the following:

1. On the Display menu, click Nucleotide Text Display.

The Nucleotide Text Display Report Settings dialog box opens. 

Figure 4-22:  Nucleotide Text Display Report Settings dialog box

2. Select the options as appropriate for your report:

3. Click OK.

The Nucleotide Text Display report opens. See Figure 4-23 on page 123.

Option Description

Original Base Call Display the bases as called in the original sample trace at locations 
where variations exist between the sample and the reference.

Consensus Base Call Display the base relative to the mutation call at locations where mutation 
calls were identified.

Display Base Call Selected by default. Display every nucleotide position for every sample 
trace in a selected contig. If you clear this option, then only the 
variations relative to the Original Base Call or the Consensus Base Call 
are displayed for the sample trace in the selected contig.
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Figure 4-23:  Nucleotide Text Display report

Nucleotide Text Display report layout

The top row of the Nucleotide Text Display report details the color coding legends that are 
used in the report. The color of the horizontal location bars indicates the location of the 
sequence that is being displayed in the trace. Colored tick marks indicate reported variations. 
The report displays mutation project data below these legends in three panes. From left to 
right these panes are:

• Filenames pane—The first row in the Filenames pane is the name of the reference
nucleotide sequence that was used to align the sample files. The second row in the
Filenames pane is the consensus sequence for the sample traces. The remaining rows in
the pane shows the name for each sample trace contained in the selected contig.

• Direction pane—The Direction pane shows the trace direction for the reference sequence,
for the consensus sequence, and for each sample trace for the selected contig.

• Nucleotide Text pane—The Nucleotide Text pane shows the textual representation of the
reference sequence, the consensus sequence, and for each sample trace contained in the
selected contig.

The report is interactive:

• To view the nucleotide text display for a different contig, select the contig on the Contig
dropdown list.

• To view the mutation electropherograms for sample files at a given mutation position,
double-click the mutation in the report. The Contig Trace Figure window opens. (See
Figure 4-24 on page 124.) You can use the Scroll function on this window to scroll
through all the sample traces at the selected mutation position. Each mutation call is
highlighted with either a blue or purple vertical line, for novel or reported variants
respectively.
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Figure 4-24:  Contig Trace Figure window

• To highlight the information for a sequence in the report, click the sequence in the 
Filenames pane.

• To view the Position (Frame #, Nucleotide #, and Row #) for a base, point the cursor on 
the base in the Nucleotide Text pane. The Position information is updated on the report 
toolbar.

Nucleotide Text Display report toolbar

The Nucleotide Text Display report toolbar contains options and buttons that are specific for 
navigating and working with the report.

Figure 4-25:  Nucleotide Text Display report toolbar

These last two options work best after you have zoomed in on a region in the 
Nucleotide Text pane for viewing. See the Zoom In function on the “Nucleotide 
Text Display report toolbar.”

Option/Button Description

Save Report—Opens the Save Report As dialog box in which you can 
specify a name and location for saving the report as a tab-delimited text 
file.

Print Preview—Opens the Preview window, which displays a preview of 
what it to be printed for the Nucleotide Text Display report. You can use 
the options on the Preview window’s toolbar to adjust variables such as 
the color scale and the page layout before you print the report.

Note: Before you click the Print Preview button, make sure to adjust 
the zoom level so that the area of the report that you want to 
print will be displayed in the Preview window.
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Show/Hide Filenames—Shows/hides the Filenames pane.

Show/Hide Direction—Shows/hides the Direction pane.

Zoom In—Zooms in on a region of the report for viewing.

Note: You can also manually zoom in on a region for viewing. Click 
and hold the left mouse button and draw a box from the upper 
left hand corner of the pane towards the lower right hand corner. 
A box is formed around the area that being reduced for viewing.

Zoom Out—Zooms out from a region of the report for viewing. The 
magnification for zooming out is always 100%.

Note: You can also manually zoom out from a region for viewing. Click 
and hold the left mouse button and draw a box from the lower 
right hand corner of the pane towards the upper left hand 
corner. 

Move Left—Moves the currently displayed report view to the left.

Note: You can also manually move the report view to the left. Right-
click and hold the mouse button on the report view, and then 
move the mouse. 

Move Right—Moves the currently displayed report view to the right.

Note: You can also manually move the report view to the left. Right-
click and hold the mouse button on the report view, and then 
move the mouse.

Report Settings—Opens the Nucleotide Text Display Report Settings 
dialog box in which you can specify the information that is to be 
displayed in the report. See Figure 4-22 on page 122. 

Amino Acid Select this option to display the amino acid sequence for which the 
consensus sequence codes. The code is displayed in the top row of the 
Nucleotide Text pane as the 1 Letter IUPAC code.

Consensus Sample Displays the consensus sequence for each of the sample pairs. An extra 
line marked as “Consensus Sample” is displayed below the sample 
pairs in all three of the report panes. 

Option/Button Description
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Mutation Surveyor Standard 
Reports

A variety of text-based standard reports that provide detailed information about a mutation 
project are available in Mutation Surveyor. All these reports, which are available from the 
Reports option on the Mutation Surveyor main menu, display mutation project data 
according to a predefined format. You can print the report information and you can save and 
store the report output for use at a later date.

This chapter covers the following topics:

• “Mutation Report” on page 129.

• “Two Direction Report” on page 136.

• “Advanced Two Direction Report” on page 142.

• “Project Report” on page 148.

• “HGVS Report” on page 159.
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Mutation Report
Mutation Surveyor aligns the nucleotide sequences of the sample traces to the reference 
traces and groups the sample traces into contigs based on their degree of overlap. The 
reference traces and sample traces are then compared at a trace by trace level to identify 
substitutions, insertions, and deletions. All the variants are aligned in the Mutation report, 
which is automatically displayed in the Viewing and Reporting pane after the project is run. 
In addition, the Mutation Surveyor toolbar is updated with buttons that are specific for 
working with the Mutation report.

Mutation report toolbar

Figure 5-1:  Mutation report toolbar

You can also open the Mutation report from the Mutation Surveyor main menu 
(Reports> Mutation Report), or you can double-click the Mutation Report entry in 
the Browser pane. 

Button Description

Open Files—Opens the Open Files dialog box which you use to load 
GenBank files, references files and sample files for a project.

Save Project—Saves all the project files to a single file mutation project 
file with an .sgp extension. You can open an entire project in a single 
step by opening this SGP file. 

Raw Data to Processed Data—Enabled when AB1/ABI files without 
base call information are uploaded and Load Raw Data is selected for 
the Mutation Project settings. Converts the raw files so that base call 
information is displayed. 

Run—Runs the currently loaded project in Mutation Surveyor.

Restart —Opens the Options dialog box which you use to modify the 
current project settings. You can then run the project again using these 
new settings.

Show/Hide Browser—Shows/hides the Browser pane in the Mutation 
Surveyor main window.

Save Report—Opens the Save Report As dialog box in which you can 
specify the location for saving the Mutation report as a .txt file.

Custom Report—Opens the Custom Report Settings dialog box which 
you use to specify the settings for a custom report. See Chapter 6, 
“Mutation Surveyor Custom Report,” on page 165.
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Mutation report fields

Figure 5-2 shows the default Mutation report in the Viewing and Reporting pane.

Figure 5-2:  Mutation report

The table below summarizes the default fields that are displayed in the Mutation report.

Graphic Display—Opens the Graphic Display Report settings dialog box 
in which you specify the settings for generating a Graphic Display 
report. See “Graphic Display Report” on page 112.

Display Mutations with 1D/2D Settings—Toggles the Mutation report 
between the 1D and 2D views.

Show Nucleotide Text—Generates a Nucleotide Text Display report. 
See “Nucleotide Text Display Report” on page 122..

Quantify—Opens the Mutation Quantification function. See “Mutation 
Quantifier Function” on page 331..

Variation Tracks Settings icon - Opens the Variation Tracks Settings 
dialog box. The Variation Tracks Settings dialog box displays the 
available tracks settings for the Mutation report based on the variation 
databases that were imported for the project. See “Variation Tracks 
Settings dialog box” on page 91.

Note: After being imported into Mutation Surveyor, a variation 
database is referred to as a track.

Button Description

Field Description

Sample File A list of all the sample traces in the mutation project, including any unmatched 
traces.

Reference File The reference trace to which the sample trace was matched.

Direction The contig number and the direction of the trace (Forward (F) or Reverse (R)).

Gene The gene name as noted in the GenBank reference file.
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To change the fields that are displayed in the Mutation report, select or clear the appropriate 
options for the Output Table Fields on the Output tab on the Mutation Project Options dialog 
box. (See “Output tab” on page 66.) 

Mutation report codes

The mutation code is the unique code that identifies each mutation in the sample trace. The 
code format indicates whether the mutation is a substitution event or whether it is an 
insertion/duplication or deletion event. 

Substitution mutation code

The mutation code for a substitution event has four components—the base number, the 
mutation, the amino acid sequence that is affected by the mutation, and the mutation score. 

Figure 5-3:  Example of a substitution mutation code

• Base Number—If a GenBank file was loaded as the reference file, the Base Number is the 
genomic position in the GenBank file. If a GenBank file was not loaded as the reference 
file, then the Base Number is enclosed in parenthesis and it indicates the position of the 
base in the reference file. If both a GenBank file and a reference file were loaded for the 
mutation project and the mutation was called at a position that does not align to the 
GenBank file, then the Base Number is enclosed in parenthesis and is displayed as +/- the 
number of base pairs by which the mutation was shifted in comparison to the GenBank 
file. 

Exon The exon as noted in the GenBank reference file. 

RF The reading frame of the exon.

Start/End The starting and ending bases for the comparison region. 

Size The number of bps in the comparison region.

Quality Lane quality for the trace. See “Quality Thresholds” on page 67.

Mut # The number of mutations found in the sample trace.

Mutation Displays the mutation code for the called mutation. See “Mutation report codes.”

Note: If Comments is selected on the Output tab on the Mutation Project 
Options dialog box, then Comments are displayed in this field after the 
mutation code.

Field Description

Amino Acid Sequence

Mutation

Base Number

Mutation Score
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Figure 5-4:  Mutation called at a position that does not align to GenBank file

• Mutation—The mutation is written as reference base > variant base, where the reference
base represents the base called at the position in the reference trace and the variant base
represents the base called at the position in the sample trace. The mutation can be
homozygous, such as A > C, or the mutation can be heterozygous, such as A > AC.

• Amino Acid—If the mutation falls within the coding region of the GenBank file, the
amino acid portion of the mutation code shows the codon number, the normal amino acid
that is affected by the mutation, and the resulting amino acid.

• Mutation Score—The mutation score is the 1D score for the mutation. See “Mutation
Score” on page 63.

Figure 5-5:  Example of a mutation code for a homozygous mutation

Figure 5-6:  Example of a mutation code for a heterozygous mutation

Color codes

The color of a substitution mutation code indicates a variety of information about the 
mutation.

• Text color—Blue text indicates that the mutation is called with high confidence. Red text
indicates that the mutation is called with low confidence. (See “Mutation Threshold” on
page 68.) Black text indicates that the mutation has been manually confirmed. (See
“Confirm” on page 135.)

• Purple background with green text—A reported variation that was not found in the
mutation project.

• Pink background—The mutation is a novel variant that results in a change to the amino
acid sequence.

• Purple background—The mutation is a reported variant that might or might not result in 

The mutation code indicates that the mutation is on the 293rd base. The base “C” has been substituted 
for the base “G.” The mutation score is 34.

The mutation code indicates that the mutation is on 462nd base of the GenBank file. The bases “A” and 
“G” have been substituted for the base “G.” The codon number is 75. The normal amino acid is “M” and 
the amino acid that is produced as the result of this mutation is a mixture of the normal amino acid and 
the mutant amino acid “I.” The mutation score is 67.
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a change to the amino acid sequence.

• No background color—The mutation is a novel variant that is found on either the forward
or reverse trace and that does not result in a change in the amino acid sequence.

Insertion, duplication, and deletion mutation codes

Mutation Surveyor monitors the mobility of a sample fragment relative to the reference. 
When the sequences no longer align, Mutation Surveyor continues to attempt alignment until 
it again occurs. If a homozygous insertion or duplication event is detected, Mutation 
Surveyor artificially gaps the reference trace. If a homozygous deletion event is detected, 
Mutation Surveyor artificially gaps the sample trace. If a heterozygous insertion or deletion 
event is detected, Mutation Surveyor automatically deconvolutes the mixed trace into two 
clean traces.

Figure 5-7:  Example of a mutation code for a homozygous insertion event

Figure 5-8:  Example of a mutation code for a homozygous duplication event

Figure 5-9:  Example of a mutation code for a homozygous deletion event

Figure 5-10:  Example of a mutation code for a heterozygous insertion event

Indicates the insertion of three bases—T, A, and C—between bases 23 and 24.

Indicates the insertion of three bases—T, A, and C—between bases 23 and 24, where the preceding bases 
(21 through 23) are also T, A, and C.

Indicates the deletion of four bases—T, G, C, and A—between bases 65 through 68.

Indicates the deletion of three bases—T, A, and G—between bases 98 and 99.
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Figure 5-11:  Example of a mutation code for a heterozygous duplication event

Figure 5-12:  Example of a mutation code for a heterozygous deletion event

Mutation report viewing and analysis options

A context menu is available for the Mutation report. You use the options on this menu to 
change the view of the Mutation report and to manipulate and analyze mutation project data 
so that you identify the true mutations in a mutation project. To open the context menu, right-
click anywhere in the Mutation report.

Figure 5-13:  Mutation report context menu

Indicates the insertion of one base - T - between bases 1316 and 1317, where the preceding base (1316) is 
also T.

Indicates the heterozygous deletion of four bases—T, G, C, and A—between bases 123 through 127. 

Option Description

Shrink Fit the complete Mutation report in the Viewing and Reporting pane.

Expand Expand all columns in the Mutation report to their default widths. 

Note: You might need to Browse the Viewing and Reporting pane to 
view the entire report.
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You can also view the information for a mutation in the Mutation report in the GAD. To open 
the GAD for the trace that contains a mutation, double-click the mutation in the report.

Copy Copies the selected text in the cell to your clipboard. To copy text in a 
range of cells, click and hold the left mouse button and drag the mouse 
to select the region that you want to copy. Use standard keyboard 
commands or menu commands to paste the copied text into an 
application.

Note: You can also copy the Mutation report as an image. Press and 
hold the [Shift] key and the [Ctrl] key and then click and hold the 
left mouse button and draw a box around the region of the 
image that you want to copy. The selected region is filled with 
black. Right-click and select Copy to copy the image to your 
clipboard. Use standard keyboard commands or menu 
commands to paste the copied image into an application.

Sort Click in the column by which you want to sort the report, and then click 
Sort > Descending or Sort > Ascending.

Confirm Confirms the selected mutation. The text for the mutation code turns 
black in both the Mutation report and the Mutation table in the GAD. The 
comment <<Checked>> is displayed in the Actions field for the mutation 
call in the Mutation table in the GAD.

Undo Confirmation Removes the “Confirmed” status for the mutation.

Delete Lane Deletes all the mutations for a selected sample in a single step. The 
Lane Quality for a deleted lane is set to “Low Quality.”

Undo Lane Deletion The Lane Quality for the lane is reset to its original value.

Undo Undo the last edit action that was carried out for the mutation.

View Edit History See “Viewing the Edit History (Audit Trail) for a Mutation” on page 373.

Hyperlink to NCBI’s 
dbSNP

Opens the NCBI’s database entry (via the web) for the variant.

If you click a trace in the GAD with the Mutation report open, the GAD is brought 
to the front. To bring the Mutation report to the front again, press [CTRL]-T.

Option Description
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Two Direction Report
The Two Direction report is automatically generated after you click Reports > 2Dir Report 
on the Mutation Surveyor main menu. The Two Direction report shows mutation information 
organized by paired sample traces. The fields that are displayed by default in the report and 
the color coding of the mutation calls in the report are identical to the default fields and color 
coding in the Mutation report. (See “Mutation report fields” on page 130 and “Color codes” 
on page 132.) Also, just like the Mutation report, you can change the fields that are displayed 
in the report by selecting or clearing the appropriate options on the Output tab on the 
Mutation Project Options dialog box. (See “Output tab” on page 66.) Figure 5-14 shows the 
default Two Direction report. The report opens in a window that is separate from the 
Viewing and Reporting pane.

Figure 5-14:  Two Direction report

Two Direction report layout

The Two Direction report provides the same general information as the Mutation report with 
the following exceptions:

• Forward and reverse samples traces are paired next to each other in the report based on 
the contig in which they were found. Alternating colors of light blue and light tan are used 
to differentiate the sample pairs.

• Mutations are grouped in the report based on their position in the contig. For a position 
that shows a mutation call for some of the sample traces:

• The Mutation # cell is blank for other sample traces that do not show a mutation at 
this position in the aligned region.

• “n.a.” is displayed in the Mutation # cell for other sample traces that show the 
mutation at this position, but the position is outside the aligned region.

• A row below each group of paired sample files shows the sum of all sizes in the contig, 

Paired forward and 
reverse traces.

Mutations are grouped in 
the report based by their 
position in the contig.

Sample traces that do not 
show a mutation at a position 
in the aligned region.

Sample traces that show the 
mutation at a position, but 
the position is outside the 
aligned region.

Allele frequency
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the average lane quality, and the allele frequency (as a percentage).

Two Direction report toolbar

The Two Direction report toolbar contains buttons that are specific for working with the 
report and for changing the information that is displayed in the report.

Figure 5-15:  Two Direction report toolbar

     

Button Description

Copy—Copies the selected text in the cell to your clipboard. To copy 
text in a range of cells, click and hold the left mouse button and drag the 
mouse to select the region that you want to copy. Use standard 
keyboard commands or menu commands to paste the copied text into 
an application.

Save Report—Opens the Save Report As dialog box in which you can 
specify a name and location for saving the report as well as its format 
(.txt, .xls, .xml, or .htm).

Report Settings—Opens the Two Direction Report Settings dialog box 
which contains options for filtering the information that is to be displayed 
in the report. See “Two Direction report settings” on page 138. 

Advanced Two Direction Report—Opens the Advanced Two Direction 
Report Settings dialog box which contains options for filtering the 
information that is to be displayed in the report. It also contains options 
for specifying the formatting of the mutation code in the report. See 
“Advanced Two Direction Report” on page 142.

Project Report—Opens the Advanced Project Report Settings dialog 
box which contains options for filtering the information that is to be 
displayed in the Project report. See “Project Report” on page 148.

Undo Latest Deletions—Restores the deletion that you last carried out 
in the Two Direction report. Allows for multiple undos.

Lock Sample File in 
View

Freezes the Sample Filename column while scrolling.
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Two Direction report mutation codes

The mutation codes that are used in the Two Direction report are identical to the codes that 
are used in the Mutation report with one exception—by default, the substitution mutation 
code also indicates the Dropping Factor and Overlapping Factor for the mutation call.

Figure 5-16:  Substitution mutation code in Two Direction report

To prevent one or both of these values from being displayed in the mutation code, open the 
Two Direction Report Settings dialog box (see “Two Direction report settings” on page 138) 
and clear the appropriate options.

Two Direction report viewing and analysis options

The Two Direction report has multiple options available for changing the view of the report 
and for manipulating and analyzing mutation project data. These options are:

• The Two Direction report settings. See “Two Direction report settings” below.

• The Two Direction report context menu. See “Two Direction report context menu” on 
page 139.

Two Direction report settings

To open the Two Direction Report Settings dialog box, click the Report Settings button  
on the Two Direction report toolbar. 

Figure 5-17:  Two Direction Report Settings dialog box

Overlapping factorDropping factor
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Two Direction report context menu

A context menu is available for the Two Direction report. You use the options on this menu 
to change the view of the Two Direction report and to manipulate and analyze mutation 
project data so that you identify the true mutations in a mutation project. To open the context 
menu, right-click anywhere in the Two Direction report.

Figure 5-18:  Two Direction report context menu

Option Description

Homozygous Dropping 
Threshold

Indicates the value for the dropping factor at which a mutation is 
identified as either a homozygous substitution or a heterozygous 
substitution. For example, is a mutation A>C or A>AC? Because 
Mutation Surveyor evaluates the traces rather than the base calls, noise 
below a major peak can sometimes be interpreted as a heterozygous 
substitution. This value assists in your analysis by converting these calls 
to homozygous substitutions. 

Note: You can increase this value to view the exact call that Mutation 
Surveyor made, but an increased value might result in some 
calls remaining as heterozygous substitutions.

Display the Mutations 
Deleted by the Software

By default, mutations that are deleted automatically by Mutation 
Surveyor are displayed in gray text in the Two Direction report. Clear 
this option to remove these mutation calls from the report display.

Display Mutations 
Deleted by the User

By default, mutations that are deleted by a user are displayed in gray 
text in the Two Direction report. Clear this option to remove these 
mutation calls from the report display.

Display Dropping Factor By default, the substitution mutation code in the Two Direction report 
indicates the Dropping factor for the mutation call. Clear this option to 
remove this value from the mutation code.

Display Overlapping 
Factor

By default, the substitution mutation code in the Two Direction report 
indicates the Overlapping factor for the mutation call. Clear this option to 
remove this value from the mutation code.
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Option Description

Copy Copies the selected text in the cell to your clipboard. To copy text in a range 
of cells, click and hold the left mouse button and drag the mouse to select 
the region that you want to copy. Use standard keyboard commands or 
menu commands to paste the copied text into an application.

Note: You can also copy the Two Direction report as an image. Press and 
hold the [Shift] key and the [Ctrl] key and then click and hold the left 
mouse button and draw a box around the region of the image that 
you want to copy. The selected region is filled with black. Right-click 
and select Copy to copy the image to your clipboard. Use standard 
keyboard commands or menu commands to paste the copied image 
into an application.

Confirm Confirms the selected mutations. 

Note: SHIFT-click to select multiple contiguous mutations or to select all 
mutations in a column.

The text for the mutation code turns black in both the Two Direction report 
and the Mutation table in the GAD. The comment <<Checked>> is displayed 
in the Actions field for the mutation call in the Mutation table in the GAD.

Undo Confirmation Removes the “Confirmed” status for the mutation. 

Note: SHIFT-click to select multiple contiguous mutations or to select all 
mutations in a column.

Sort By Score 
(Descending)

Sort by Score 
(Ascending)

Click the appropriate option to sort the all the data by descending mutation 
score or ascending mutation score.

Delete Mutations Deletes the selected mutations. 

Note: SHIFT-click to select multiple contiguous mutations, to select all 
mutations in a column, or to select multiple rows.

The text for the mutation code turns gray in both the Two Direction report 
and the Mutation table in the GAD. The comment <<Deleted>> is displayed 
in the Actions field for the mutation call in the Mutation table in the GAD.

Note: To undo the last deletion that you carried out, click the Undo Latest 

Deletions button  on the report toolbar.

Delete Lane Deletes all the mutations for a selected sample in a single step. The Lane 
Quality for a deleted lane is set to “Low Quality.”

Undo Deletion The Lane Quality for the lane is reset to its original value.

Undo Undo the last edit action that was carried out for the mutation.

View Edit History See “Viewing the Edit History (Audit Trail) for a Mutation” on page 373.

Hyperlink to NCBI’s 
dbSNP

Opens the NCBI’s database entry (via the web) for the variant.
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You can also view the information for a mutation in the Two Direction report in the GAD. To 
open the GAD for the trace that contains a mutation, double-click the mutation in the report.

If you click a trace in the GAD with the Two Direction report open, the GAD is 
brought to the front. To bring the Two Direction report to the front again, press 
[CTRL]-T.
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Advanced Two Direction Report
Like the Two Direction report, the Advanced Two Direction report shows mutation 
information organized by paired sample traces. Also, the layout of the Advanced Two 
Direction report is identical to the layout of the Two Direction report. (See “Two Direction 
report layout” on page 136.) The Advanced Two Direction report, however, has different 
settings for changing the mutation information that is displayed in the report. 

The fields that are displayed by in the report, the mutation codes, and the color coding of the 
mutation calls in the report are identical to the fields, mutation codes, and color coding in the 
Mutation report (See “Mutation report fields” on page 130, “Mutation report codes” on page 
131, and “Color codes” on page 132.) Just like the Mutation report and the Two Direction 
report, you can change the fields that are displayed in the report by selecting or clearing the 
appropriate options on the Output tab on the Mutation Project Options dialog box. (See 
“Output tab” on page 66.) 

1. To open the Advanced Two Direction report, do one of the following:

• Click the Advanced Two Direction Report button  on the Two Direction report 

toolbar. 

• On the Mutation Surveyor main menu, click Reports > Adv. Two Direction Report.

The Advanced Two Direction Report Settings dialog box opens.

Figure 5-19:  Advanced Two Direction Report Settings dialog box
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2. Accept the default settings for the report, or make any changes as needed. 

     

Option Description

Mutation Scores

Reject 1D Calls When 
Other Direction has No 
Call

Reject a mutation that is called in only one direction when the position 
falls within the comparison region of the other direction. 

Reject 1D Calls When 
Other Direction is Not 
Available

Reject mutation calls that occur outside the region where the sample 
traces in both directions are aligned within the comparison region.

Reject Synonymous 
Mutations

Coding region substitutions that do not affect amino acid calls are not 
displayed in the report.

Note: In cases where the entire column was not omitted from the report because of rejection by 
one of these criteria, the rejected mutations have no background color and an “n.a.” is 
displayed in the Mutation cell instead of the mutation code.

Display Mutations with 
the “Stop” Codon or 
Indel Only

Display only nonsense mutations and indels in the report.

Display Confirmed 
Mutations Only

Display only those mutations that you have manually confirmed in the 
report.

Display Mosaic 
Mutations

Display mosaic mutations in the report.

Homozygous Dropping 
Threshold

This value is the dropping factor at which a mutation is identified as 
either a homozygous substitution or a heterozygous substitution. For 
example, is a mutation A>C or A>AC? Because Mutation Surveyor 
evaluates the traces rather than the base calls, noise below a major 
peak can sometimes be interpreted as a heterozygous substitution. This 
value assists in your analysis by converting these calls to homozygous 
substitutions. 

Note: You can increase this value to view the exact call that Mutation 
Surveyor made, but an increased value might result in some 
calls remaining as heterozygous substitutions.

Mutation Output Format

Display Mutation As Select one option to set the format of the mutation code in the report.

• 123T>CT (Default value)

• 123CT

Display Negative 
Mutation as 123T

Display the position and the normal allele for a negative mutation in the 
report.

Number Bases Relative 
to cDNA

• If this option is cleared, the numbering is the genomic position within 
the GenBank file. 

• If this option is selected:

• Select CDS to number the bases relative to the CDS numbering in 
the GenBank reference file.

• Select mRNA to number the bases relative the mRNA numbering 
in the GenBank reference file.
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3. Click OK.

The Advanced Two Direction report is generated and displayed in a window that is 
separate from the Viewing and Reporting pane. 

Figure 5-20:  Advanced Two Direction report

Advanced Two Direction report toolbar

The Advanced Two Direction report toolbar contains buttons that are specific for working 
with the report and for changing the information that is displayed in the report.

Figure 5-21:  Advanced Two Direction report toolbar

Button Description

Copy—Copies the selected the text in the cell to your clipboard. To copy 
text in a range of cells, click and hold the left mouse button and drag the 
mouse to select the region that you want to copy. Use standard 
keyboard commands or menu commands to paste the copied text into 
an application.

Save Report—Opens the Save Report As dialog box in which you can 
specify a name and location for saving the report as well as its format 
(.txt, .xls, .xml, or .htm).

Report Settings—Opens the Advanced Two Direction Report Settings 
dialog box. See Step 2 of “Advanced Two Direction Report” on page 
142.
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Homolog Consensus Sequence Text—Generates an onscreen text file 
of the consensus base calls for the forward samples in a contig, for the 
reverse samples in a contig, and for the forward and reverse samples 
together.

Figure 5-22:  Homolog Consensus Sequence Text window

• Save button —Opens the Save As dialog box in which you can 

specify a name and location for saving the sequence text as a .txt file.

• Display Sequence in One Line button —Displays the consensus 

sequences in fasta format.

Lock Sample File in 
View

Freezes the Sample Filename column while scrolling.

Button Description
Mutation Surveyor User’s Manual 145



Chapter 5
Mutation Surveyor Standard Reports
Advanced Two Direction report viewing and analysis options

A context menu is available for the Advanced Two Direction report. You use the options on 
this menu to change the view of the Advanced Two Direction report and to manipulate and 
analyze mutation project data so that you identify the true mutations in a mutation project. To 
open the context menu, right-click anywhere in the Advanced Two Direction report.

Figure 5-23:  Advanced Two Direction report context menu

Option Description

Copy Copies the selected text in the cell to your clipboard. To copy text in a 
range of cells, click and hold the left mouse button and drag the mouse 
to select the region that you want to copy. Use standard keyboard 
commands or menu commands to paste the copied text into an 
application.

Note: You can also copy the Advanced Two Direction report as an 
image. Press and hold the [Shift] key and the [Ctrl] key and then 
click and hold the left mouse button and draw a box around the 
region of the image that you want to copy. The selected region 
is filled with black. Right-click and select Copy to copy the 
image to your clipboard. Use standard keyboard commands or 
menu commands to paste the copied image into an application.

Confirm Confirms the selected mutations. 

Note: SHIFT-click to select multiple contiguous mutations or to select 
all mutations in a column.

The text for the mutation code turns black in both the Advanced Two 
Direction report and the Mutation table in the GAD. The comment 
<<Checked>> is displayed in the Actions field for the mutation call in the 
Mutation table in the GAD.

Undo Confirmation Removes the “Confirmed” status for the mutation. 

Note: SHIFT-click to select multiple contiguous mutations or to select 
all mutations in a column.
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You can also view the information for a mutation in the Advanced Two Direction report in 
the GAD. To open the GAD for the trace that contains a mutation, double-click the mutation 
in the report.

Sort By Score 
(Descending)

Sort by Score 
(Ascending)

Click the appropriate option to sort the all the data by descending 
mutation score or ascending mutation score.

Delete Mutations Deletes the selected mutations. 

Note: SHIFT-click to select multiple contiguous mutations, to select all 
mutations in a column, or to select multiple rows.

The text for the mutation code turns gray in both the Advanced Two 
Direction report and the Mutation table in the GAD. The comment 
<<Deleted>> is displayed in the Actions field for the mutation call in the 
Mutation table in the GAD.

Note: To undo the last deletion that you carried out, click the Undo 

Latest Deletions button  on the report toolbar.

Delete Lane Deletes all the mutations for a selected sample in a single step. The 
Lane Quality for a deleted lane is set to “Low Quality.”

Undo Deletion The Lane Quality for the lane is reset to its original value.

Undo Undo the last edit action that was carried out for the mutation.

View Edit History See “Viewing the Edit History (Audit Trail) for a Mutation” on page 373.

Hyperlink to NCBI’s 
dbSNP

Opens the NCBI’s database entry (via the web) for the variant.

If you click a trace in the GAD with the Advanced Two Direction report open, the 
GAD is brought to the front. To bring the Advanced Two Direction report to the 
front again, press [CTRL]-T.

Option Description
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Project Report
Like the directional reports, the Project report shows mutation information organized by 
paired sample traces. Also, although the layout of the Project report is very similar to the 
layout of the directional reports, the report has different settings for working with the report 
and for changing the information that is displayed in the report. The fields that are displayed 
in the report, the mutation codes, and the color coding of the mutation calls in the report are 
identical to the fields, mutation codes, and color coding in the Mutation report (See 
“Mutation report fields” on page 130, “Mutation report codes” on page 131, and “Color 
codes” on page 132.) Just like the other standard mutation reports, you can change the fields 
that are displayed in the report by selecting or clearing the appropriate options on the Output 
tab on the Mutation Project Options dialog box. (See “Output tab” on page 66.) 

1. To open the Project report, on the Mutation Surveyor main menu, click Reports > Project 
report.

The Project Report Settings dialog box opens. 

Figure 5-24:  Project Report Settings dialog box

2. Accept the default settings for the report, or make any changes as needed. 

Option Description

Mutation Scores

Reject 1D Calls When 
Other Direction has No 
Call

Reject a mutation that is called in only one direction when the position 
falls within the comparison region of the other direction. 

Reject 1D Calls When 
Other Direction is Not 
Available

Reject mutation calls that occur outside the region where the sample 
traces in both directions are aligned within the comparison region.
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Reject Synonymous 
Mutations

Coding region substitutions that do not affect amino acid calls are not 
displayed in the report.

Note: In cases where the entire column was not omitted from the report because of rejection by 
one of these criteria, the rejected mutations have no background color and an “n.a.” is 
displayed in the Mutation cell instead of the mutation code.

Display Mutations with 
the “Stop” Codon or 
Indel Only

Display only nonsense mutations and indels in the report.

Display Confirmed 
Mutations Only

Display only those mutations that you have manually confirmed in the 
report.

Display Mosaic 
Mutations

Display mosaic mutations in the report.

Homozygous Dropping 
Threshold

This value is the dropping factor at which a mutation is identified as 
either a homozygous substitution or a heterozygous substitution. For 
example, is a mutation A>C or A>AC? Because Mutation Surveyor 
evaluates the traces rather than the base calls, noise below a major 
peak can sometimes be interpreted as a heterozygous substitution. This 
value assists in your analysis by converting these calls to homozygous 
substitutions. You can increase this value to view the exact call that 
Mutation Surveyor made, but an increased value might result in some 
calls remaining as heterozygous substitutions.

Sample Grouping

Specify the filename substring by which Mutation Surveyor groups all 
the mutation project samples files in the report. (These groupings are 
also used in the Project Sample Assembly subreport and in the 
Comparison functions. See “Project report toolbar” on page 150.)

• n-Primer (n-D) Text Input—Use the ND Grouping file to group the 
sample files. See “ND Filename Match Editor Tool” on page 274.

• Filename Match (based on one of the following):

• From Character [ ] To Character [ ]—If all the filenames in your 
project contain the same characters/designator in the same 
positions, then select this option and enter the starting and ending 
character positions.

Note: Typical Block—If all the filenames in your project contain the 
same characters/designator but in different positions, then 
select this option and enter the value for the character/
designator block.

Option Description
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3. Click OK.

The Project report is generated and displayed in a window that is separate from the 
Viewing and Reporting pane. 

Figure 5-25:  Project report

Project report toolbar

The Project report toolbar contains buttons that are specific for working with the report and 
for changing the information that is displayed in the report. It also contains buttons for 
generating subreports in which you can view mutations in a matrix and view the alleles for 
each mutation. 

Figure 5-26:  Project report toolbar

Button Description

Copy—Copies the selected text in the cell to your clipboard. To copy 
text in a range of cells, click and hold the left mouse button and drag the 
mouse to select the region that you want to copy. Use standard 
keyboard commands or menu commands to paste the copied text into 
an application.

Save Report—Opens the Save Report As dialog box in which you can 
specify a name and location for saving the report as well as its format 
(.txt, .xls, .xml, or .htm).
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Report Settings—Opens the Project Report Settings dialog box. See 
Step 2 of “Project Report” on page 148.

Project Sample Assembly—Opens the Project Sample Assembly 
subreport. The Project Sample Assembly subreport creates a 
consensus of all the samples traces as defined by the Sample Grouping 
parameters set in the Project Report Settings dialog box. This subreport 
also lists the alleles for each mutation. See “Project Sample Assembly 
subreport” on page 152.

Consensus Sequence Text—Opens the Consensus Sequence Text 
dialog box. The Consensus Sequence Text function searches sample 
files that have been grouped based on a specific filename for 
consensus sequence strings. See “Consensus Sequence Text function” 
on page 153.

Sequence Text Comparison—Opens the Sequence Text Comparison 
dialog box. The Sequence Text Comparison function compares the 
sequence text for sample files that have been grouped based on a 
specific filename substring to the sequence text in the reference file. 
See “Sequence Text Comparison function” on page 154.

Amino Acid Text Comparison—Opens the Amino Acid Text Comparison 
dialog box. The Amino Acid Text Comparison function compares the 
amino acid sequence for sample files that have been grouped based on 
a specific filename substring to the amino acid sequence in the 
reference file. See “Amino Acid Text Comparison function” on page 156.

Lock Sample File in 
View

Freezes the Sample Filename column while scrolling.

Button Description
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Project Sample Assembly subreport

The Project Sample Assembly subreport displays a separate row for each substring, the total 
number of mutations found in all the files that contain the specified substring, and the code 
for each called mutation. 

Figure 5-27:  Project Sample Assembly subreport

• To view the group consensus results within a matrix, click Display Results on the 
subreport toolbar.

Figure 5-28:  Results matrix view of mutations

• To view a matrix of the alleles for each group consensus for each mutation, click Display 
Alleles on the subreport toolbar.

Figure 5-29:  Allele matrix view of mutations
\
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Consensus Sequence Text function

The Consensus Sequence Text function searches sample files that have been grouped based 
on a specific filename for consensus sequence strings. You can also specify a minimum lane 
quality to exclude low quality samples

Figure 5-30:  Consensus Sequence Text Settings dialog box

Figure 5-31 is an example of the Consensus Sequence Text report. The reference information 
is displayed at the top of the report. The consensus sequence for the base pair region is 
displayed below the reference information and is grouped by filename substring.

Figure 5-31:  Consensus Sequence Text report

Consensus Sequence Text window toolbar

The Consensus Sequence Text window toolbar contains buttons that are specific for working 
with the output and for changing the output display.

Button Description

Save Sequence Text—Opens the Save As dialog box in which you can 
specify a name and location for saving the output as a .txt file.
Mutation Surveyor User’s Manual 153



Chapter 5
Mutation Surveyor Standard Reports
Sequence Text Comparison function

The Sequence Text Comparison function compares the sequence text for sample files that 
have been grouped based on a specific filename substring to the sequence text in the 
reference file. You can also specify a minimum lane quality to exclude low quality samples.

Figure 5-32:  Sequence Text Comparison Settings dialog box

Figure 5-33 on page 155 is an example of the Sequence Text Comparison report. The 
reference sequence is displayed at the top of the report as a single continuous string of 
characters without numbering or spacing. Sample files are grouped by substring and are 
displayed below the reference sequence. In a sample file sequence, a black dot (.) indicates a 
match between the reference file and the sample file. A black dash (-) indicates an artificial 
gap added to a sample file so that all the sample files remain aligned. This gap can be the 
result of a deletion in the gapped sample or of an insertion in another sample. If a different 
base is at the same position in the sample file and reference file, then the standard IUB/
IUPAC code for the base is shown in the sample file at the position.

     

Display Sequence in One Line—Displays the consensus sequences in 
fasta format.

Save As PHD file—Opens the Browse for Folder dialog box in which 
you can specify the location for saving the output as a .phd file. A .phd 
file contains three columns:

• Column 1-Base call

• Column 2-Quality score for the called base

• Column 3-Raw data frame for called base

You can open a .phd file in Notepad.

Button Description
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Figure 5-33:  Sequence Text Comparison report

Sequence Text Comparison window toolbar

The Sequence Text window toolbar contains buttons that are specific for working with the 
output.

     

Button Description

Save Sequence Text—Opens the Save As dialog box in which you can 
specify a name and location for saving the output as a .txt file.

Save As PHD file—Opens the Browse for Folder dialog box in which 
you can specify the location for saving the output as a .phd file. A .phd 
file contains three columns:

• Column 1-Base call

• Column 2-Quality score for the called base

• Column 3-Raw data frame for called base

You can open a PHD file in Notepad.
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Amino Acid Text Comparison function

The Amino Acid Text Comparison function compares the amino acid sequence for sample 
files that have been grouped based on a specific filename substring to the amino acid 
sequence in the reference file. You can also specify a minimum lane quality to exclude low 
quality samples.

Figure 5-34:  Amino Acid Text Comparison Settings dialog box

Figure 5-35 is an example of the Amino Acid Text Comparison report. The amino acid 
sequence for the reference file displayed at the top of the report using standard IUB/IUPAC 
amino acid codes. Sample files are grouped by substring and are displayed below the 
reference sequence. In a sample file sequence, a black dot (.) indicates a match between the 
reference file and the sample file. If a different amino acid is at the same position in the 
sample file and reference file, then the standard IUB/IUPAC code for the amino acid is 
shown in the sample file at the position.

Figure 5-35:  Amino Acid Text Comparison report
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Amino Acid Text Comparison window toolbar

The Amino Acid Text Comparison window toolbar contains a single button that is specific 
for working with the output.

Project report viewing and analysis options

A context menu is available for the Project report. You use the options on this menu to 
change the view of the Project report and to manipulate and analyze mutation project data so 
that you identify the true mutations in a mutation project. To open the context menu, right-
click anywhere in the Project report. 

Figure 5-36:  Project report context menu

Button Description

Save Sequence Text—Opens the Save As dialog box in which you can 
specify a name and location for saving the output as a .txt file.

Option Description

Copy Copies the selected text in the cell to your clipboard. To copy text in a 
range of cells, click and hold the left mouse button and drag the mouse 
to select the region that you want to copy. Use standard keyboard 
commands or menu commands to paste the copied text into an 
application.

Note: You can also copy the Project report as an image. Press and 
hold the [Shift] key and the [Ctrl] key and then click and hold the 
left mouse button and draw a box around the region of the 
image that you want to copy. The selected region is filled with 
black. Right-click and select Copy to copy the image to your 
clipboard. Use standard keyboard commands or menu 
commands to paste the copied image into an application.

Confirm Confirms the selected mutations. 

Note: SHIFT-click to select multiple contiguous mutations or to select 
all mutations in a column.

The text for the mutation code turns black in both the Project report and 
the Mutation table in the GAD. The comment <<Checked>> is displayed 
in the Actions field for the mutation call in the Mutation table in the GAD.
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You can also view the information for a mutation in the Project report in the GAD. To open 
the GAD for the trace that contains a mutation, double-click the mutation in the report.

Undo Confirmation Removes the “Confirmed” status for the mutation. 

Note: SHIFT-click to select multiple contiguous mutations or to select 
all mutations in a column.

Sort By Score 
(Descending)

Sort by Score 
(Ascending)

Click the appropriate option to sort the all the data by descending 
mutation score or ascending mutation score.

If you click a trace in the GAD with the Project report open, the GAD is brought to 
the front. To bring the Project report to the front again, press [CTRL]-T.

Option Description
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HGVS Report
Like the directional reports, the HGVS report shows mutation information organized by 
paired sample traces. Also, the layout of the HGVS report is very similar to the layout of the 
directional reports. (See “Two Direction report layout” on page 136.) The HGVS report, 
however, displays mutation calls according to the guidelines established by the Human 
Genome Variations Society. (The color coding of these calls is still the same as the color 
coding that is used in the other standard Mutation Surveyor reports. See “Color codes” on 
page 132.) In addition to the standard report mutation fields specified for the project (see 
“Output tab” on page 66), the HGVS report shows many quality values for the project, 
including quality values for the entire trace, the comparison region, and the ROIs.

1. To open the HGVS report, on the Mutation Surveyor main menu, click Reports > HGVS 
report.

The HGVS Report Settings dialog box opens. 

Figure 5-37:  HGVS Report Settings dialog box
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2. Accept the default settings for the report, or make any changes as needed. 

Option Description

Mutation Scores

Reject 1D Calls When 
Other Direction has No 
Call

Reject a mutation that is called in only one direction when the position 
falls within the comparison region of the other direction. 

Reject 1D Calls When 
Other Direction is Not 
Available

Reject mutation calls that occur outside the region where the sample 
traces in both directions are aligned within the comparison region.

Reject Synonymous 
Mutations

Coding region substitutions that do not affect amino acid calls are not 
displayed in the report.

Note: In cases where the entire column was not omitted from the report because of rejection by 
one of these criteria, the rejected mutations do not have a background color and an “n.a.” is 
displayed in the Mutation cell instead of the mutation code.

Display Mutations with 
the “Stop” Codon or 
Indel Only

Display only nonsense mutations and indels in the report.

Display Confirmed 
Mutations Only

Display only those mutations that you have manually confirmed in the 
report.

Display Mosaic 
Mutations

Display mosaic mutations in the report.

Homozygous Dropping 
Threshold

Indicates the value for the dropping factor at which a mutation is 
identified as either a homozygous substitution or a heterozygous 
substitution. For example, is a mutation A>C or A>AC? Because 
Mutation Surveyor evaluates the traces rather than the base calls, noise 
below a major peak can sometimes be interpreted as a heterozygous 
substitution. This value assists in your analysis by converting these calls 
to homozygous substitutions. You can increase this value to view the 
exact call that Mutation Surveyor made, but an increased value might 
result in some calls remaining as heterozygous substitutions.

Phred Score Threshold A measure of base quality, all bases that are in the ROI and that have a 
Phred score <= to the specified value are displayed in the Bases Below 
Threshold (ROI) report column. Reducing this value reduces the 
number of bases that are displayed. Conversely, increasing this value 
increased the number of based that are displayed.

Trace Quality

Display the trace quality for one or more or all the following:

• Entire Trace

• Comparison Region

• ROI (CDS)

and set the trace quality relative to one of the following:

• Phred Score

• S/N Ratio

Quality Threshold A filtering option to visually indicate all the quality values that fall below 
this threshold. Quality values that fall below this threshold are 
highlighted in red in the report.
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3. Click OK.

The HGVS report is generated and displayed in a window that is separate from the 
Viewing and Reporting pane. 

Figure 5-38:  HGVS report

     

Low Quality Threshold 
is: [ ]

Any lanes with quality that is less than this threshold are not displayed in 
the report. 

Note: The value shown is the value that you specified for the Quality 
Threshold on the Output tab of the Mutation Project Settings 
dialog box. To change this value, see “Output tab” on page 66.

Display Start and End

Display start and end base numbering as one of the following:

• Genomic

• HGVS nomenclature

Amino Acid

• 1 Letter • Display 1 Letter IUPAC amino acid code in the report.

• 3 Letter • Display 3 Letter IUPAC amino acid code in the report.

Option Description
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HGVS report toolbar

The HGVS report toolbar contains buttons that are specific for working with the report and 
for changing the information that is displayed in the report.

Figure 5-39:  HGVS report toolbar
]

Button Description

Copy—Copies the selected text in the cell to your clipboard. To copy 
text in a range of cells, click and hold the left mouse button and drag the 
mouse to select the region that you want to copy. Use standard 
keyboard commands or menu commands to paste the copied text into 
an application.

Save Report—Opens the Save Report As dialog box in which you can 
specify a name and location for saving the report as well as its format 
(.txt, .xls, .xml, or .htm).

Report Settings—Opens the HGVS Report Settings dialog box. See 
Step 2 of “HGVS Report” on page 159.

Homolog Consensus Sequence Text—Generates an onscreen text file 
of the consensus base calls for the forward samples in a contig, for the 
reverse samples in a contig, and for the forward and reverse samples 
together.

Figure 5-40:  Homolog Consensus Sequence Text window

• Save button —Opens the Save As dialog box in which you can 

specify a name and location for saving the .txt file.

• Display Sequence in One Line button —Displays the consensus 

sequences in fasta format.
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HGVS report viewing and analysis options

A context menu is available for the HGVS report. You use the options on this menu to 
change the view of the HGVS report and to manipulate and analyze mutation project data so 
that you identify the true mutations in a mutation project. To open the context menu, right-
click anywhere in the HGVS report.

Figure 5-42:  HGVS report context menu

Mutation Output for Database—Outputs the HGVS report to a format 
that can be exported to a database. 

Figure 5-41:  Mutation Output for Database

• Save button —Opens the Save As dialog box in which you can 

specify a name and location for saving the mutation output as a .txt 
file.

• Report Settings button —Opens the Mutation Output dialog box. 

You use the options on this dialog box to select the fields that are to 
be included in the Mutation output. By default, when the dialog box 
first opens, all standard mutation report fields are selected.

Lock Sample File in 
View

Freezes the Sample Filename column while scrolling.

Button Description
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You can also view the information for a mutation in the HGVS report in the GAD. To open 
the GAD for the trace that contains a mutation, double-click the mutation in the report.

Option Description

Copy Copies the selected the text in the cell to your clipboard. To copy text in 
a range of cells, click and hold the left mouse button and drag the 
mouse to select the region that you want to copy. Use standard 
keyboard commands or menu commands to paste the copied text into 
an application.

Note: You can also copy the HGVS report as an image. Press and 
hold the [Shift] key and the [Ctrl] key and then click and hold the 
left mouse button and draw a box around the region of the 
image that you want to copy. The selected region is filled with 
black. Right-click and select Copy to copy the image to your 
clipboard. Use standard keyboard commands or menu 
commands to paste the copied image into an application.

Confirm Confirms the selected mutations. 

Note: SHIFT-click to select multiple contiguous mutations or to select 
all mutations in a column.

The text for the mutation code turns black in both the HGVS report and 
the Mutation table in the GAD. The comment <<Checked>> is displayed 
in the Actions field for the mutation call in the Mutation table in the GAD.

Undo Confirmation Removes the “Confirmed” status for the mutation. 

Note: SHIFT-click to select multiple contiguous mutations or to select 
all mutations in a column.

Sort By Score 
(Descending)

Sort by Score 
(Ascending)

Click the appropriate option to sort the all the data by descending 
mutation score or ascending mutation score.

Delete Mutations Deletes the selected mutations. 

Note: SHIFT-click to select multiple contiguous mutations, to select all 
mutations in a column, or to select multiple rows.

The text for the mutation code turns gray in both the HGVS report and 
the Mutation table in the GAD. The comment <<Deleted>> is displayed 
in the Actions field for the mutation call in the Mutation table in the GAD.

Note: To undo the last deletion that you carried out, click the Undo 

Latest Deletions button  on the report toolbar.

Delete Lane Deletes all the mutations for a selected sample in a single step. The 
Lane Quality for a deleted lane is set to “Low Quality.”

Undo Deletion The Lane Quality for the lane is reset to its original value.

Undo Undo the last edit action that was carried out for the mutation.

View Edit History See “Viewing the Edit History (Audit Trail) for a Mutation” on page 373.

If you click a trace in the GAD with the HGVS report open, the GAD is brought to 
the front. To bring the HGVS report to the front again, press [CTRL]-T.
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A text-based custom report is available in Mutation Surveyor. This reports contain options 
for building a tailored report that provides detailed information about your mutation projects 
in a format that best suits your specific working needs. In addition, you can print the report 
information and you can save and store the report output for use at a later date.

This chapter covers the following topics:

• “Custom Report” on page 166.
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Custom Report
The Custom report offers a variety of report formats in which to display your mutation 
project data. A variety of options are also available for tailoring the report to best suit your 
working needs, including sample grouping options, report heading options, options for 
filtering the variations that are displayed in the report, display options for samples and 
mutation calls, color-coding options for mutation calls, and nomenclature options for 
mutation calls. You can create a custom report template from scratch, or you can load an 
existing custom report template, modify the settings as needed, and then save the modified 
template. 

To create a Custom Report template

1. On the Mutation Surveyor main menu, click Reports > Custom Report.

The Custom Report Settings dialog box opens. The Format tab is the active tab.

Figure 6-1:  Custom Report Settings dialog box, Format tab
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2. Do one of the following:

• To set up a new custom report from scratch, select your options and specify the 
appropriate values on the different dialog box tabs.

• To generate the report based on existing settings, click Load to browse to and select 
the MS Report Template.ini file that you want to use. Optionally, before you 
generate the report, modify the settings for the loaded report as needed.

See:

• “Format tab” on page 168.

• “Filters tab” on page 172.

• “Display tab” on page 174.

• “Mutation tab” on page 175.

• “Color tab” on page 178.

• “Nomenclature tab” on page 179.

• “Other tab” on page 181.

3. Do one of the following:

• To generate an onscreen report according to the settings that you have specified, 
click OK.

The report opens in the Custom Report window. 

Figure 6-2:  Custom Report window
 

Click Default at any time to reset all the values on all the tabs to the system default 
values. 
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• To save the settings for loading and generating a report at a later date, click Save.

The Save Mutation Surveyor Report Template dialog box opens. By default, a 
Custom report is saved as MutationSurveryor_CRSettings.ini file in the C:\Program 
Files (x86)\SoftGenetics\Mutation Surveyor\<MS_Version>\Report folder. If you do 
not want to override the default custom report file supplied with Mutation Surveyor, 
change the name of the file, the location of the file, or both.

Format tab

The Format tab contains options for the formatting and layout of the custom report. 

Figure 6-3:  Custom Report Settings dialog box, Format tab
]

Option Description

Table Format

One Trace Per Row Display all mutation information for each trace in its own row.

Generate Forward/
Reverse Consensus

Create a single consensus by merging the forward consensus and 
reverse consensus.

Generate Group 
Consensus

Create a single consensus by merging all the consensus information for 
the sample group.

Mutation Position 
Specific for Column

Aligns mutations by column within each group (By Group) or aligns 
mutations by column across all groups (By Table).

One Mutation per Row Display information for each mutation call in its own row. 

Note: Select if mutation information is to be exported to a database.

Transpose Generates a table that has base positions in rows and sample traces in 
columns.
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Headings

Show Display Region 
Heading

Selected by default. If you clear this option, then column headings are 
not displayed in the report.

Show Mutation Number Labels mutation call columns with Variant number.

Show Position 
Information

Labels mutation call columns by the genomic position referenced in the 
GenBank file.

Note: A particularly useful option if you display mutation calls by a 
nomenclature other than Genomic. 

Show Default Header 
Information

Displays the Mutation Surveyor version number, the date and time that 
the report was generated, the project name (if loading a saved project) 
and the report settings file name. “Default” is displayed as the report 
settings filename when the report is generated using the system default 
settings. The actual report filename is displayed when the report is 
generated using a saved report settings file. “Customized” is displayed 
in all other cases. (The settings were not loaded using a saved report 
settings file and the settings are not the system default settings.) 

Create Header/Custom 
Header File

Click Create Header to open the Create Header dialog box which 
contains a template for creating a custom header that can be displayed 
at the top of a custom report. 

Figure 6-4:  Create Header dialog box

Do one of the following:

• Modify any of the default template information in either column. 

• Click Open to select an existing custom header file to modify.

You can add or delete rows of information as needed.

• To delete a row from the header, right-click the row, and then click 
Delete a Row.

• To insert a row into the header, right-click the row that is to be located 
below the inserted row, and then click Insert a Row.

• To add a row as the last row in the header, right-click any row, and 
then click Add a Row.

Click Save to save the custom header as an .inf file, and then click the 

Browse button  to browse to and load the saved header file for the 

custom report.

Option Description
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Grouping—Traces are initially grouped based on the 1st Order Grouping option. Further sorting is 
then carried out based on the 2nd Order Grouping option, and then on the 3rd Order Grouping 
option. 

• Contig • The default value for 1st Order. Groups are sorted based on the 
Contigs that Mutation Surveyor created for determining mutation 
calls.

• Trace • When Trace is selected, the From Character X to Y option is enabled. 
Traces are sorted into groups based on character matching in the 
specified positions in the trace filenames.

• Grouping File • Traces are sorted into groups based on the grouping method that is 
specified in the Load Grouping text file. See “2D Filename Match 
Editor tool” on page 271.

• Sample ID • When Sample ID is selected, both the Load Sample ID button and 
the From Character X to Y option are enabled. Click Load Sample ID 
to open the Load Sample ID dialog box and specify the different 
Sample IDs, such as Patient #, by which to group the traces. You can 
also click Open to load an existing Sample ID file.

Note: By default, the Load Sample ID dialog box contains rows for up 
to ten different Sample IDs. You can right-click and click Insert 
or Delete as needed.

Figure 6-5:  Load Sample ID dialog box

The traces that are to be grouped together must contain at least one of 
these Sample IDs in their filenames but they do not need to be in the 
same location in the filename. When grouping by Sample ID, the trace 
filenames are first checked based on the Sample IDs defined in the 
Load Sample ID dialog box. The values specified in the From Character 
X to Y fields are ignored if all the trace filenames contain at least one of 
these Sample IDs. Traces that do not contain any of these Sample IDs 
in their filenames are sorted into groups based on the values specified 
in the From Character X to Y fields. Traces that do not contain any of 
these Sample IDs and that do not contain the characters specified in the 
From Character X to Y fields are sorted into their own group. 

• F/R pairing • The default value for the 2nd Order. Places two-directional traces in 
adjacent rows.

Option Description
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• Trace Position • The default value for the 3rd Order. Traces are sorted into groups 
based on where they match to the GenBank reference file. Each 
trace is matched at its starting genomic base number. Groups can be 
sorted so that traces that match to the earliest reference base are 
displayed first.

• Gene • Traces are sorted into groups based on the gene names defined in 
the GenBank reference file.

• Exon • Traces are sorted into groups based on the exons defined in the 
GenBank reference file.

• Trace Quality • Traces are sorted into groups based on the lane quality for the trace. 

• None • Ignore the sorting level. 

Add Blank Rows 
between Groups

Selected by default. Clear this option of you do not want a blank row to 
be displayed between groups of traces in the custom report.

Group Summary

• Do Not Show Group 
Summary Information

• Do not display a row below each group that shows such information 
as the average frequency of the call among the traces.

• Show Allele 
Information

• Show Allele Frequency—Adds a row below each group that displays 
the average frequency of the call among all the traces. Traces for 
which data is not available for the indicated position are not used in 
the frequency calculation.

• Show Advanced Allele Information—Applicable only if you are 
analyzing diploid samples. Displays the frequency of each allele by 
traces and as a grand total.

• Total—Shows the frequency of the two alleles within each sample 
trace.

• Grand Total (2D data)

• If both the forward and reverse traces show a mutation at the 
position, then the alleles in the Forward direction mutation call 
are used in the calculation of the allele frequency.

• If data is not available for the position in one of the traces, then 
the alleles in the mutation call in the other direction are used in 
the calculation of the allele frequency.

• If data is available for the position in both traces, but only one of 
the traces has a mutation call, then Mutation Surveyor ignores 
this pair and the alleles in the sample trace with the mutation 
call are not used in the calculation of the allele frequency.

• Grand Total (1D data)—The alleles in each trace are used in the 
calculation of the allele frequency.

• Show Mutation 
Summary

• Applicable only if you have loaded a GenBank file with reported 
variations. Displays a listing of variants within each group, with 
variants placed in one of two columns—Unreported and Reported. 
The Unreported column displays novel variants that were found in the 
sample files, but were not reported in the GenBank file. The Reported 
column displays the reported variants that were found in the sample 
files.

Option Description
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Filters tab

The Filters tab contains options for specifying which traces are to be displayed in the custom 
report.

Figure 6-6:  Custom Report Settings dialog box, Filters tab

 Some of the options on this tab are self-explanatory, and therefore, not all these 
options are discussed in this section. 

Option Description

Traces

Show Selected Traces Filtering options that limit the traces that are displayed in the report to 
only those that meet the selected criteria.

• Containing No Mutation Calls

• Containing only normal alleles—Traces without mutations that can 
have mosaics, negative SNPs, and/or negative mutations.

• Containing Negative SNPs—A negative SNP is defined as position 
in the GenBank file at which a variation has been reported, but no 
variation was detected at the same position in the sample trace. 
Sample traces that have negative SNPs might still contain 
mutation calls.

• Containing Negative Mutations—A negative mutation is defined as 
a position in a sample trace at which a variation was detected, but 
no variation was detected at the same position for other sample 
traces in the group. Sample traces that have negative mutations 
might still contain mutation calls.

• Unmatched Traces—Clear this option to remove sample traces 
from the Custom report that do not match to the reference trace.
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Nucleotide Quality

• Phred Score

• Intensity

Define nucleotide quality thresholds based on the nucleotide Phred 
Score and the nucleotide Intensity. Used to mitigate the calling of false 
positives when the data quality is poor.

Mutation Calls

Show All Mutations Show all mutations of all types in all regions.

Show Selected 
Mutations

Filtering options that limit the mutations that are displayed in the report 
to only those that meet the selected criteria of type and region. (Show 
only mutations of the selected type in the selected regions.)

• Regions—Limit the mutations that are displayed to only those that 
are called within regions of interest (ROI) that are defined in the 
GenBank reference file.

• Mutation Types

• Selected Types—You must choose at least one type from each 
group.

Note: When choosing at least one type from each group:

• Homozygous Dropping Threshold—Indicates the value for the 
dropping factor at which a mutation is identified as either a 
homozygous substitution or a heterozygous substitution. For 
example, is a mutation A>C or A>AC? Because Mutation Surveyor 
evaluates the traces rather than the base calls, noise below a major 
peak can sometimes be interpreted as a heterozygous substitution. 
This value assists in your analysis by converting these calls to 
homozygous substitutions. You can increase this value to view the 
exact call that Mutation Surveyor made, but an increased value might 
result in some calls remaining as heterozygous substitutions.

• Reject 1D Calls When Other Direction has No Call—Reject a 
mutation that is called in only one direction when the position falls 
within the comparison region of the other direction. 

• Reject 1D Calls When Other Direction is Not Available—Reject 
mutation calls that occur outside the region where the sample traces 
in both directions are aligned within the comparison region.

Option Description
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Display tab

The Display tab contains options for specifying the columns to display in the custom report. 

Figure 6-7:  Custom Report Settings dialog box, Display tab

The majority of the options on this tab are self-explanatory, and therefore, not all 
these options are discussed in this section.

Option Description

Region of Interest • ROI Coverage—Identifies an entire ROI that has not aligned to the 
reference trace.

• ROI Phred String—Display a single ASCII character representation of 
the Phred score for each nucleotide position within an ROI. The 
ASCII character that is displayed for a Phred Score is the Phred 
Score + 32. For example, if the Phred Score = 1, then 1 + 32 = 33, or 
the 33rd character in the ASCII character set, which is an 
exclamation point (!).

Note: For an ASCI character map, see http://www.asciitable.com/.

Quality Information • Trace Quality Information—Options in this section are used to identify 
traces of low quality. The Low Quality Threshold is the value that is 
specified for Lane Quality in the Mutation project settings. (See 
“Quality Trim” on page 62.) The trace is also identified with the 
background color that has been selected for Quality Failure on the 
Colors tab. (See “Color tab” on page 178.)

• Nucleotide Quality Information—Options in this section are used to 
identify nucleotide positions of poor quality. The Quality Threshold is 
based on the value that is specified for Score Trim in the Mutation 
Project settings. (See “Score Trim [ ]” on page 62.)
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Mutation tab

The Mutation tab contains options for displaying information for the various mutation calls 
as well as options for displaying information about positions where mutations where not 
called. 

Figure 6-8:  Custom Report Settings, Mutation tab

The majority of options on this tab are self-explanatory, and therefore, not all 
these options are discussed in this section. 

Option Description

Show Mutation Call Information

Nucleotide Position Nucleotide positions are displayed in the nomenclature that you select 
on the Nomenclature tab. (See “Nomenclature tab” on page 179.)

Amino Acid Position By default, amino acid information is organized with the reference amino 
acid appearing first, the amino acid position appearing next, and the 
mutation amino acid appearing last. If you do not select Amino Acid 
Position, then a slash (/) is displayed between the reference amino acid 
and the mutation amino acids.

Confidence(!) Displays a Confidence mark (!) for mutation calls that exceed certain 
thresholds that are defined in the MutationSurveyor.ini file.

Caution: Although you can modify these thresholds, SoftGenetics does 
not recommend that you do so on your own. Contact 
SoftGenetics for assistance.

Comments Displays all comments that were added to a mutation call, either 
automatically by Mutation Surveyor or manually by a user. 
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Show Non-Mutation Call Information

Show Normal Alleles • Show Negative SNP—Display selected Show Normal Allele 
Information for nucleotides that do not show the variations reported in 
the GenBank or SEQ file. For indels, “no_ins” or “no_del” is 
displayed.

• Show Negative Mutations—Display selected Show Normal Allele 
Information for a position in a sample trace at which a variation was 
not detected, but the variation was detected at the same position for 
other sample traces in the group.

• Show Normal Allele Information—Specify the information that is to be 
displayed for positions that do not have an identified mutation call.

Note: When Normal Allele Information is displayed and One Mutation 
per Row is selected (see “Table Format” on page 168), all 
options selected in the Show Mutation Call Information section 
are exported for both mutation calls and normal alleles.

General Information

Reported Variant 
Annotation

Displays all the variations’ annotations that are included in the GenBank 
file such as the dbSNP identifier.

Genotype With this option selected, Mutation Surveyor assumes that the analysis 
is for a diploid organism and displays the two alleles at the nucleotide 
position. For indels, a homozygous insertion of “A,” for example, is 
displayed as “insA insA,” and a heterozygous insertion of “A,” is 
displayed as “normal ins A.” If there is no insertion, then “Normal 
Normal” is displayed.

NM_Score Assigns a score to each sample nucleotide that indicates the 
contribution of the normal allele at the position compared to the 
contribution of the possible mutant alleles at the same position. The 
score is based on the height ratio of the four different dye colors and the 
shape of the four peaks at each nucleotide position. The range is 0-100. 
A high score indicates a high degree of similarity between the sample 
trace and the reference trace, which, in turn, means that the sample 
trace more than likely contains a normal allele at the position. A low 
score indicates a high degree of difference between the sample trace 
and the reference trace, which, in turn, means that the sample trace 
more than likely contains a homozygous substitution. Scores in the 
middle indicate high levels of noise and error or heterozygous 
substitutions in the sample trace. 

Option Description
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Display Information—Specifies how the mutation call information is to be distributed in table cells 
for display.

• One Field • All the information displayed in a single field.

• Report the Deletion and Insertion as Delins—If an insertion and 
deletion occur at the same position, then they are merged into a 
single call at the position.

• Mutation Call Nucleotides Relative to Gene Direction—Make the 
mutation call based on the gene orientation. To make a mutation 
call for a gene on the reverse strand, a reverse complement is 
generated. 

• Multiple Fields • Multiple Fields (Group Nts, A.A., and Score into One Field or Group 
Nts and A.A. into Relevant Fields)—Specific pieces of information 
grouped into fields.

• All Information in Unique Fields—Each piece of information displayed 
in its own column.

Show Advanced Display • [ ] # of nucleotides Displayed Before/After Mutation—Displays the 
specified normal number of alleles on either side of the variant. The 
position is displayed with a slash (/) between the normal allele and 
the mutation alleles. 

• Display Position—Displays the reference nucleotide and its position, 
the consensus nucleotides for the group at this position, the amino 
acid information (if applicable), and the reported variants’ 
annotations. This information can be displayed in One Field or in 
Multiple Fields.

Option Description
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Color tab

The Color tab provides a variety of color-coding options to assist you with identifying 
different types of mutation calls and potential analysis problems. 

Figure 6-9:  Custom Report Settings dialog box, Color tab

Color-coding is applied according to the following:

• If a mutation call meets several color-coding criteria, the call is displayed in the report in 
the color of highest priority. 

• If None is selected for a color-coding option, then the color of the next highest priority is 
used. 

• For Mutation Region color-coding, Quality Failure has the highest priority. 

• For Mutation Region Text color-coding, the priorities from highest to lowest are as 
follows—Deleted, Confirmed, Added, Edited, High Confidence, Low Confidence, 
Normal Alleles, and Not Available. 

• For Mutation Region Background color coding, priorities from highest to lowest are as 
follows—Discrepancy, Mosaic, Familial, Pathogenic, Likely_Pathogenic, 
Unlikely_Pathogenic, Benign, Drug_Sensitive, Drug_Resistant, dnSNP, VUS, Reported, 
A.A. Change, Indel, Synonymous, Heterozygous, Homozygous, Not Available, and 
Heading(s) where:

• Discrepancy identifies the variants within a consensus of traces that have at least one 
member of the consensus that differs from the others. The Discrepancy indicator is 
available for the Generate Forward/ Reverse Consensus table format and the Generate 
Group Consensus table format. (See “Table Format” on page 168.)
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• Synonymous identifies the coding region substitutions that do not affect the amino 
acid sequence.

If you select Apply Color Coding as text, then when you save the Custom report as a .txt file, 
the color-coding is shown as a comment in the file.

Nomenclature tab

The Nomenclature tab contains options for specifying the nomenclature that is to be used for 
the mutation calls.

Figure 6-10:  Custom Report Settings dialog box, Nomenclature tab

When a consensus is formed, discrepancies are identified only for positions that 
have data available. For example, if Generate Forward/Reverse Consensus is the 
selected table format, and the Forward trace contains a mutation call at position 
#320 but the Reverse trace does not at this position because data is not available, 
then a discrepancy is not detected.

Option Description

Genomic Displays the mutation call positions based on the genomic position 
referenced in the GenBank file.

Relative to CDS Displays the mutation call positions relative to the CDS numbering in the 
GenBank reference file. A mutation that is called in the CDS is prefixed 
with a “c.” A mutation that is called in a non-coding region is prefixed 
with “IVS.” Its position is identified by the closest nucleotide in the 
coding sequence plus or minus the number of bps by which it resides 
away from the closest nucleotide.
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Figure 6-11:  Nomenclature examples

     

Relative to mRNA Displays the mutation call positions relative to the mRNA numbering in 
the GenBank reference file. A mutation that is called in the mRNA 
region is prefixed with a “c.” A mutation that is called outside of an 
mRNA region is identified by the closest nucleotide in the mRNA region 
plus or minus the number of bps by which it resides away from the 
closest nucleotide.

HGVS Displays the mutation call positions relative to its position in the coding 
sequence. A mutation that is called in a non-coding region is identified 
by the closest nucleotide in the coding sequence plus or minus the 
number of bps by which it resides away from the closest nucleotide. 
Both alleles are shown in separate bracketed statements. 

Note: If any one of the four standard Nomenclature options is selected and a GenBank file was 
not loaded as the reference file, then the Base Number is enclosed in parenthesis and it 
indicates the position of the base in the reference file. If both a GenBank file and a 
reference file were loaded for the mutation project and the mutation was called at a position 
that does not align to the GenBank file, then the Base Number is enclosed in parenthesis 
and is displayed as +/- the number of base pairs by which the mutation was shifted in 
comparison to the GenBank file. 

Custom Allows you to tailor the nomenclature for mutation calls to best suit your 
working needs.

Option Description
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Other tab

The Other tab contains options that affect the report display as well as processing options for 
the report.

Figure 6-12:  Custom Report Settings dialog box, Other tab

     

Option Description

Output

Save Processing 
Settings with Report

Saves all the settings that you selected for the report as part of the 
report output.

Save Excel Format as 
Text

Saves the Custom report as an Excel file with all the data columns 
formatted as Text.

Save XML Report with 
Report

Saves the Custom report as an XML file.

Save VCF Report • Save as One Report—Selected by default. Generate a single VCF 
report that includes the information for all the sample groupings. 

• Save Each Group as Individual Reports—Generate a VCF report for 
each sample grouping.

Note: Remember, you specify the sample grouping on the Format tab. 
See “Format tab” on page 168.

Other Settings

Enable “Hide Selected 
Rows/Columns”

Enables on the Hide Columns and Hide Rows function on the Custom 
report context menu. See “Custom Report viewing and analysis options” 
on page 183.
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Custom Report toolbar

The Custom report toolbar contains buttons that are specific for working with the report and 
for changing the information that is displayed in the report.

Figure 6-13:  Custom report toolbar

Button Description

Save—Opens the Save Report As dialog box in which you can specify a 
name for the saved report as well as its format (.txt, or .xls.) The default 
location is C:\Program Files (x86)\SoftGenetics\Mutation Surveyor\<MS 
Version>\Report, but you can select a different location.

Settings—Opens the Custom Report Settings dialog box in which you 
can adjust your report settings. 

Print—Opens the custom report in the Print Custom Report window. The 
window toolbar contains buttons for working with the report and for 
printing the report.

Figure 6-14:  Print Custom Report window

• \Print button —Opens the Print dialog box in which you can 

specify the options for printing the Custom report. By default, only the 
page that is currently displayed in the Print Custom Report window is 
selected for printing. You can leave the default as is, or you can 
select the entire report or a range of pages for printing.

• Display Previous  and Display Next  buttons—Use these 

buttons to Browse forward and backward through the Custom report 
one page at a time.

• Page Setup button —Opens the Page Setup dialog box in which 

you can specify the page properties of the report pages (such as 
page size and orientation) for printing.
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Custom Report viewing and analysis options

A context menu is available for the Custom report. You use the options on this menu to 
change the view of the Custom report and to manipulate and analyze mutation project data so 
that you identify the true mutations in a mutation project. To open the context menu, 
right-click anywhere in the Custom report.

Figure 6-15:  Custom report context menu

Option Description

Copy Copies the selected text in the cell to your clipboard. To copy text in a 
range of cells, click and hold the left mouse button and drag the mouse 
to select the region that you want to copy. Use standard keyboard 
commands or menu commands to paste the copied text into an 
application.

Note: You can also copy the Custom report as an image. Press and 
hold the [Shift] key and the [Ctrl] key and then click and hold the 
left mouse button and draw a box around the region of the 
image that you want to copy. The selected region is filled with 
black. Right-click and select Copy to copy the image to your 
clipboard. Use standard keyboard commands or menu 
commands to paste the copied image into an application.

Confirm Confirms the selected mutations. 

Note: SHIFT-click to select multiple contiguous mutations for 
confirmation or to select all mutations in a column for 
confirmation.

The text for the mutation code turns black in both the Custom report and 
the Mutation table in the GAD. The comment <<Checked>> is displayed 
in the Actions field for the mutation call in the Mutation table in the GAD.
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Other options include the following:

• To open the GAD for the trace that contains a mutation, double-click the mutation in the 
Custom report.

• To select all cells in the Custom report in a single step, press [CTRL]-A.

• To auto-scale the width of a column to its largest entry, double-click the first cell in the 
column. 

Undo Confirmation Removes the “Confirmed” status for a selected mutation or a selected 
column. 

Note: SHIFT-click to select multiple contiguous mutations for 
confirmation or to select all mutations in a column for 
confirmation.

Delete Mutations Deletes the selected mutations. 

Note: SHIFT-click to select multiple contiguous mutations for deletion, 
to select all mutations in a column for deletion, or to select 
multiple rows for deletion.

The text for the mutation code turns gray in both the Custom report and 
the Mutation table in the GAD. The comment <<Deleted>> is displayed 
in the Actions field for the mutation call in the Mutation table in the GAD.

Note: To undo the last deletion that you carried out, click the Undo 

Latest Deletions button  on the report toolbar.

Undo Deletion Removes the “Deleted” status for a selected mutation, a selected 
column, or a selected row.

Delete Lane Deletes all the mutations for a selected sample in a single step. The 
Lane Quality for a deleted lane is set to “Low Quality.”

Undo Deletion The Lane Quality for the lane is reset to its original value.

Hide Selected Rows

Hide Selected Columns

Enabled if “Enable Hide Selected Rows/Columns” is selected on the 
Other tab. (See “Other tab” on page 181.)

Undo Last Hide Rows/
Columns

Enabled if selected rows and/or columns are hidden in the Custom 
report.

Undo Undo the last edit action that was carried out for the mutation.

View Edit History See “Viewing the Edit History (Audit Trail) for a Mutation” on page 373.

Hyperlink to NCBI’s 
dbSNP

Opens the NCBI’s database entry (via the web) for the variant.

If you click a trace in the GAD with the Custom report open, the GAD is brought 
to the front. To bring the Custom report to the front again, press [CTRL]-T.

If you auto-scale the report after selecting all the cells in the report, you can resize 
the entire report easily in a single step.

Option Description
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Reports

Customer reports are another type of custom report in Mutation Surveyor. Each report was 
initially developed as a template to provide custom content that met a specific customer’s 
needs. All these report templates are now available from the Reports > Customer Reports 
option on the Mutation Surveyor main menu 

This chapter covers the following topics:

• “JHU report” on page 187.

• “Tassel report” on page 192.

• “Emory report” on page 195.

• “Bentley report and MSM_Song report” on page 198.

• “PrettyBase report” on page 202.

• “Methylation report” on page 205.

• “Vertex report” on page 209.

• “Vertex2 report” on page 211.

• “Vertex3 report” on page 214.

• “Full Gene report” on page 217.

• “FullBase report” on page 224.
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JHU report
The JHU report displays various quality scores for a defined ROI organized by paired sample 
traces. The layout of the JHU Output report is identical to the layout of the Two Direction 
report. (See “Two Direction report layout” on page 136.) The mutation codes, and the color 
coding of the mutation calls in the report are identical to the mutation codes and color coding 
in the Mutation report (See “Mutation report fields” on page 130, “Mutation report codes” on 
page 131, and “Color codes” on page 132.) The JHU report contains fields that are specific 
to the report as well as all the fields that are displayed in any of the standard mutation 
reports. 

Figure 7-1:  JHU report

     

For detailed information about using the GBK File Editor to define ROIs in a 
GenBank file, see “GBK File Editor Tool” on page 234.
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JHU Report toolbar

The JHU report toolbar contains buttons that are specific for working with the report and for 
changing the information that is displayed in the report.

Figure 7-2:  JHU report toolbar

Button Description

Copy—Copies the selected text in the cell to your clipboard. To copy 
text in a range of cells, click and hold the left mouse button and drag the 
mouse to select the region that you want to copy. Use standard 
keyboard commands or menu commands to paste the copied text into 
an application.

Save Report—Opens the Save Report As dialog box in which you can 
specify a name and location for saving the report as well as its format 
(.txt, .xls, .xml, or .htm).

Undo Latest Deletions—Restores the deletion that you last carried out 
in the JHU report. Allows for multiple undos.

Report Settings—Opens the JHU Report Settings dialog box which 
contains options for filtering the information that is to be displayed in the 
report. See “JHU report settings” on page 189.

Display the Sequence of ROI—Generates an onscreen text file of the 
sequences in the GenBank ROIs.

Figure 7-3:  Sequence in Region of Interest window

• Save button —Opens the Save Sequence Text As dialog box in 

which you can specify a name and location for saving the .txt file.

• Display Sequence in One Line button —Displays the sequences 

in fasta format.

Lock Sample File in 
View

Freezes the Sample Filename column while scrolling.
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JHU report viewing and analysis options

The JHU report has multiple options available for changing the view of the report and for 
manipulating and analyzing mutation project data. These options are:

• The JHU report settings. See “JHU report settings” below.

• The JHU report context menu. See “JHU report context menu” on page 190.

JHU report settings

To open the JHU Report Settings dialog box, click the Report Settings button  on the 
JHU report toolbar. 

Figure 7-4:  JHU Report Settings dialog box

Option Description

Homozygous Dropping 
Threshold

Indicates the value for the dropping factor at which a mutation is 
identified as either a homozygous substitution or a heterozygous 
substitution. For example, is a mutation A>C or A>AC? Because 
Mutation Surveyor evaluates the traces rather than the base calls, noise 
below a major peak can sometimes be interpreted as a heterozygous 
substitution. This value assists in your analysis by converting these calls 
to homozygous substitutions. 

Note: You can increase this value to view the exact call that Mutation 
Surveyor made, but an increased value might result in some 
calls remaining as heterozygous substitutions.

Phred Score Threshold Call a mutation only if the Phred score for the variant base or bases is 
greater than the indicated threshold.

ROI Boundaries Affects the values that are output to the Start (ROI) and End (ROI) 
column for traces that do not have complete coverage of the Region of 
Interest. For example, an ROI is set for positions 50 to 150 (Expected 
value). The sample trace's comparison region is positions 100 to 200. 
Only positions 100 to 150 of the ROI are within the comparison region 
(Actual value) whereas positions 50-99 are not covered.

Output Confidence 
Mark for JHU

Displays a Confidence mark (!) for mutation calls that exceed certain 
thresholds that are defined in the MutationSurveyor.ini file.

Note: Although you can modify these thresholds, SoftGenetics does 
not recommend that you do so on your own. Contact 
SoftGenetics for assistance.
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JHU report context menu

A context menu is available for the JHU report. You use the options on this menu to change 
the view of the JHU report and to manipulate and analyze mutation project data so that you 
identify the true mutations in a mutation project. To open the context menu, right-click 
anywhere in the JHU report.

Figure 7-5:  JHU report context menu

Option Description

Copy Copies the selected text in the cell to your clipboard. To copy text in a 
range of cells, click and hold the left mouse button and drag the mouse 
to select the region that you want to copy. Use standard keyboard 
commands or menu commands to paste the copied text into an 
application.

Note: You can also copy the JHU report as an image. Press and hold 
the [Shift] key and the [Ctrl] key and then click and hold the left 
mouse button and draw a box around the region of the image 
that you want to copy. The selected region is filled with black. 
Right-click and select Copy to copy the image to your clipboard. 
Use standard keyboard commands or menu commands to 
paste the copied image into an application.

Confirm Confirms the selected mutations. 

Note: SHIFT-click to select multiple contiguous mutations to select all 
mutations in a column.

The text for the mutation code turns black in both the JHU report and the 
Mutation table in the GAD. The comment <<Checked>> is displayed in 
the Actions field for the mutation call in the Mutation table in the GAD.

Undo Confirmation Removes the “Confirmed” status for the mutation. 

Note: SHIFT-click to select multiple contiguous mutations or to select 
all mutations in a column.

Sort By Score 
(Descending)

Sort by Score 
(Ascending)

Click the appropriate option to sort all the data by descending mutation 
score or ascending mutation score.
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You can also view the information for a mutation in the JHU report in the GAD. To open the 
GAD for the trace that contains a mutation, double-click the mutation in the report.

Delete Mutations Deletes the selected mutations. 

Note: SHIFT-click to select multiple contiguous mutations, to select all 
mutations in a column, or to select multiple rows.

The text for the mutation code turns gray in both the JHU report and the 
Mutation table in the GAD. The comment <<Deleted>> is displayed in 
the Actions field for the mutation call in the Mutation table in the GAD.

Note: To undo the last deletion that you carried out, click the Undo 

Latest Deletions button  on the report toolbar.

Undo Undo the last edit action that was carried out for the mutation.

View Edit History See “Viewing the Edit History (Audit Trail) for a Mutation” on page 373.

If you click a trace in the GAD with the JHU report open, the GAD is brought to 
the front. To bring the JHU report to the front again, press [CTRL]-T.

Option Description
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Tassel report
The Tassel report is ideal for identifying mutations in your sample traces if your traces are 
grouped by Sample ID (see “Sample ID” on page 170) or if all the filenames in your project 
contain the same characters/designator but in different positions. After you click Tassel 
Report on the Customer Reports menu, the Tassel Report Settings dialog box opens.

Figure 7-6:  Tassel Report Settings dialog box

1. Do one of the following:

• If all the filenames in your project contain the same character string/designator in the 
same positions, then select From Character [ ] To Character [ ] and enter the starting 
and ending character positions of the characters/designator. 

• If all the filenames in your project contain the same character string /designator but 
in different positions, then select Typical Block and enter the character string/
designator.

2. Click OK.

The Tassel report is generated. 

Figure 7-7:  Tassel report
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The layout of the Tassel report is somewhat similar to the layout of the Two Direction Output 
report. (See “Two Direction report layout” on page 136.) The similarities between the Tassel 
report and any of the other standard reports, however, ends there. In the Tassel report:

• Cells showing a novel variant that results in a change to the amino acid sequence are 
displayed in pink. 

• Cells showing a reported variant that results in a change to the amino acid sequence are 
displayed in lime green. 

• A lowercase letter indicates a 1D mutation, while an uppercase letter indicates a 2D 
mutation. 

• If a mutation is a substitution, then the standard IUPAC code for the variant base or bases 
is displayed for the mutation. 

• If a mutation is a deletion, then a zero (0) is displayed for the mutation.

You can also view the information for a mutation in the Tassel report in the GAD. To open 
the GAD for the trace that contains a mutation, double-click the mutation in the report.

Tassel report toolbar

The Tassel report toolbar contains just two buttons for working with the report.

Figure 7-8:  Tassel report toolbar

If you click a trace in the GAD with the Tassel report open, the GAD is brought to 
the front. To bring the Tassel report to the front again, press [CTRL]-T.

Button Description

Copy—Copies the selected text in the cell to your clipboard. To copy 
text in a range of cells, click and hold the left mouse button and drag the 
mouse to select the region that you want to copy. Use standard 
keyboard commands or menu commands to paste the copied text into 
an application.

Note: You can also copy the Tassel report as an image. Press and 
hold the [Shift] key and the [Ctrl] key and then click and hold the 
left mouse button and draw a box around the region of the 
image that you want to copy. The selected region is filled with 
black. Right-click and select Copy to copy the image to your 
clipboard. Use standard keyboard commands or menu 
commands to paste the copied image into an application.

Save Report—Opens the Save Report As dialog box in which you can 
specify a name and location for saving the report as well as its format 
(.txt, .xls, .xml, or .htm).
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Tassel report viewing and analysis options

Although the Tassel report does not have a context menu, you can still copy the report as an 
image. You can also view the information for a mutation in the report in the GAD. 

• To copy the report as an image, press and hold the [Shift] key and the [Ctrl] key and then 
click and hold the left mouse button and draw a box around the region of the image that 
you want to copy. The selected region is filled with black. Right-click and select Copy to 
copy the image to your clipboard. Use standard keyboard commands or menu commands 
to paste the copied image into an application.

• To open the GAD for the trace that contains a mutation, double-click the mutation in the 
report.

If you click a trace in the GAD with the Tassel report open, the GAD is brought to 
the front. To bring the report to the front again, press [CTRL]-T.
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Emory report
The layout of the Emory report is very similar to the layout of the Two Direction report. (See 
“Two Direction report layout” on page 136.) The mutation codes and the color coding of the 
mutation calls in the report are identical to the mutation codes and color coding in the 
Mutation report (See “Mutation report codes” on page 131 and “Color codes” on page 132.) 
The Emory report, however, displays only the quality score and the number of mutations for 
each sample. 

Figure 7-9:  Emory report

Emory report toolbar

The Emory report toolbar contains just two buttons for working with the report and an option 
to control the display while scrolling the report.

Figure 7-10:  Emory report toolbar

Button Description

Copy—Copies the selected text in the cell to your clipboard. To copy 
text in a range of cells, click and hold the left mouse button and drag the 
mouse to select the region that you want to copy. Use standard 
keyboard commands or menu commands to paste the copied text into 
an application.

Save Report—Opens the Save Report As dialog box in which you can 
specify a name and location for saving the report as well as its format 
(.txt, .xls, .xml, or .htm).

Lock Sample File in 
View

Freezes the Sample Filename column while scrolling.
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Emory report viewing and analysis options

A context menu is available for the Emory report. You use the options on this menu to 
change the view of the Emory report and to manipulate and analyze mutation project data so 
that you identify the true mutations in a mutation project. To open the context menu, right-
click anywhere in the Emory report.

Figure 7-11:  Emory report context menu

Option Description

Copy Copies the selected text in the cell to your clipboard. To copy text in a 
range of cells, click and hold the left mouse button and drag the mouse 
to select the region that you want to copy. Use standard keyboard 
commands or menu commands to paste the copied text into an 
application.

Note: You can also copy the Emory report as an image. Press and 
hold the [Shift] key and the [Ctrl] key and then click and hold the 
left mouse button and draw a box around the region of the 
image that you want to copy. The selected region is filled with 
black. Right-click and select Copy to copy the image to your 
clipboard. Use standard keyboard commands or menu 
commands to paste the copied image into an application.

Confirm Confirms the selected mutations. 

Note: SHIFT-click to select multiple contiguous mutations or to select 
all mutations in a column.

The text for the mutation code turns black in both the Emory report and 
the Mutation table in the GAD. The comment <<Checked>> is displayed 
in the Actions field for the mutation call in the Mutation table in the GAD.

Undo Confirmation Removes the “Confirmed” status for the mutation. 

Note: SHIFT-click to select multiple contiguous mutations or to select 
all mutations in a column.
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You can also view the information for a mutation in the Emory report in the GAD. To open 
the GAD for the trace that contains a mutation, double-click the mutation in the report.

Sort By Score 
(Descending)

Sort by Score 
(Ascending)

Click the appropriate option to sort all the data by descending mutation 
score or ascending mutation score.

Delete Mutations Deletes the selected mutations. 

Note: SHIFT-click to select multiple contiguous mutations, to select all 
mutations in a column, or to select multiple rows.

The text for the mutation code turns gray in both the Emory report and 
the Mutation table in the GAD. The comment <<Deleted>> is displayed 
in the Actions field for the mutation call in the Mutation table in the GAD.

Note: To undo the last deletion that you carried out, click the Undo 

Latest Deletions button  on the report toolbar.

Delete Lane Deletes all the mutations for a selected sample in a single step. The 
Lane Quality for a deleted lane is set to “Low Quality.”

Undo Deletion The Lane Quality for the lane is reset to its original value.

Undo Undo the last edit action that was carried out for the mutation.

View Edit History See “Viewing the Edit History (Audit Trail) for a Mutation” on page 373.

Hyperlink to NCBI’s 
dbSNP

Opens the NCBI’s database entry (via the web) for the variant.

If you click a trace in the GAD with the Emory report open, the GAD is brought to 
the front. To bring the Emory report to the front again, press [CTRL]-T.

Option Description
Mutation Surveyor User’s Manual 197



Chapter 7
Mutation Surveyor Customer Reports
Bentley report and MSM_Song report
The Bentley and MSM_Song reports are useful when carrying out analyses of diploid 
samples. Both reports show the genomic position of the mutation, the genotype, and the 
frequency of each allele by traces and as a grand total.

The layout of the reports is very similar to the layout of the Two Direction Output report. 
(See “Two Direction report layout” on page 136.) Both of the reports contain the same fields 
that are displayed in any of the standard mutation reports. There are few minor difference 
between the Bentley report and the MSM_Song report:

• By default, the MSM_Song report displays the entire sequence of the GenBank file in the 
top row of the report. The Bentley does not.

• In both reports, the mutation call is split between two columns, with the first column 
displaying a summary for a specific position and the second column displaying the 
genotype for each sample file. The format, however, for these two columns differs 
slightly between the reports.

Figure 7-12:  Bentley report 

Figure 7-13:  MSM_Song report 

For a detailed explanation of allele frequency by trace and grand total allele 
frequency, see “Show Allele Information” on page 171.
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Bentley/MSM_Song report toolbar

The Bentley toolbar and the MSM_Song toolbar contain the same buttons that are specific 
for working with the reports and for changing the information that is displayed in the reports.

Figure 7-14:  Bentley/MSM_Song report toolbar

Bentley/MSM_Song reports viewing and analysis options

The Bentley and MSM_Song reports have several options available for changing the view of 
the reports and for manipulating and analyzing mutation project data. These options are:

• The Bentley/MSM_Song report settings. See “Bentley/MSM_Song report settings” on 
page 200. 

• The Bentley/MSM_Song report context menu. See “Bentley/MSM_Song reports context 
menu” on page 200.

Button Description

Copy—Copies the selected text in the cell to your clipboard. To copy 
text in a range of cells, click and hold the left mouse button and drag the 
mouse to select the region that you want to copy. Use standard 
keyboard commands or menu commands to paste the copied text into 
an application.

Note: You can also right-click and select Copy to copy the selected 
text to your clipboard.

Note: You can also copy both output reports as an image. Press and 
hold the [Shift] key and the [Ctrl] key and then click and hold the 
left mouse button and draw a box around the region of the 
image that you want to copy. The selected region is filled with 
black. Right-click and select Copy to copy the image to your 
clipboard. Use standard keyboard commands or menu 
commands to paste the copied image into an application.

Save Report—Opens the Save Report As dialog box in which you can 
specify a name and location for saving the report as well as its format 
(.txt, .xls, .xml, or .htm).

Report Settings—Opens the Report Settings dialog box which contains 
options for filtering the information that is to be displayed in the report. 
See “Bentley/MSM_Song report settings” on page 200.
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Bentley/MSM_Song report settings

Figure 7-15:  Bentley/MSM_Song Report Settings dialog box

Bentley/MSM_Song reports context menu

Although the Bentley and MSM_Song reports do not have a full context menu, you can still 
copy text from each report, or copy each report as an image. You can also view the 
information for a mutation in the reports in the GAD. 

• Select the text that you want to copy or to copy text in a range of cells, click and hold the 
left mouse button and drag the mouse to select the region that you want to copy. 
Right-click and select Copy to copy the selected text to your clipboard. Use standard 
keyboard commands or menu commands to paste the copied image into an application.

• To copy the report as an image, press and hold the [Shift] key and the [Ctrl] key and then 

Option Description

Display Parameters

• Lane Number—Selected by default. Clear this option if you do not 
want the Lane Number to be displayed in the report.

• Well Position—Selected by default. Clear this option if you do not 
want the Well Position to be displayed in the report.

• Mut#—Selected by default. Clear this option if you do not want the 
mutation number to be displayed in the report.

• Sequence of GenBank File

• Not selected by default for the Bentley Output report—Select this 
option if you want the entire sequence of the GenBank file to be 
displayed in the top row of the report.

• Selected by default for the MSM_Song Output report—Clear this 
option if you do not want the entire sequence of the GenBank file 
to be displayed in the top row of the report.

Mutation Filter

Display Mutations with 
the “Stop” Codon or 
Indel Only

Display only nonsense mutations and indels in the report.
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click and hold the left mouse button and draw a box around the region of the image that 
you want to copy. The selected region is filled with black. Right-click and select Copy to 
copy the image to your clipboard. Use standard keyboard commands or menu commands 
to paste the copied image into an application.

• To open the GAD for the trace that contains a mutation, double-click the mutation in the 
report.

If you click a trace in the GAD with the Bentley or MSM_Song report open, the 
GAD is brought to the front. To bring the report to the front again, press 
[CTRL]-T.
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PrettyBase report
The PrettyBase format was developed by the SeattleSNPs project for easily representing 
SNP information for groups of subjects over a given span of reference sequence. The report 
displays the following information (in order from left to right)—SNP Position, Sample 
Name, Normal Allele, Allele 1, Allele 2, IUPAC code for the mutation call, Mutation Call, 
Comments, Phred Score, and NM_Score. 

Figure 7-16:  PrettyBase report

PrettyBase report toolbar

The PrettyBase report toolbar contains buttons that are specific for working with the report 
and for changing the information that is displayed in the report.

Figure 7-17:  PrettyBase report toolbar

Button Description

Copy—Copies the selected text in the cell to your clipboard. To copy 
text in a range of cells, click and hold the left mouse button and drag the 
mouse to select the region that you want to copy. Use standard 
keyboard commands or menu commands to paste the copied text into 
an application.

Save Report—Opens the Save Report As dialog box in which you can 
specify a name and location for saving the report as well as its format 
(.txt, .xls, .xml, or .htm).

Report Settings—Opens the PrettyBase Report Settings dialog box 
which contains options for filtering the information that is to be displayed 
in the report. See “PrettyBase report settings” on page 203.
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PrettyBase report viewing and analysis options

The PrettyBase report has multiple options available for changing the view of the report and 
for manipulating and analyzing mutation project data. These options are:

• The PrettyBase report settings. See “PrettyBase report settings” below.

• The PrettyBase report context menu. See “PrettyBase report context menu” on page 204.

PrettyBase report settings

To open the PrettyBase Report Settings dialog box, click the Report Settings button  on 
the PrettyBase report toolbar. 

Figure 7-18:  PrettyBase Report Settings dialog box

Option Description

Display

Mutations Only • Mutations Only—Selected by default. Show only all called mutations

• Mutations and Negative Mutations—Select this option to show all 
called mutations and negative mutations.

• All Positions (in ROI)—Select this option to show all nucleotide 
positions within defined ROIs.

Mutation Filter

Display Mutations with 
the “Stop” Codon or 
Indel Only

Display only nonsense mutations and indels in the report.
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PrettyBase report context menu

Although the PrettyBase report does not have a full context menu, you can still copy text 
from the report, or copy the report as an image. You can also view the information for a 
mutation in the report in the GAD. 

• Select the text that you want to copy or to copy text in a range of cells, click and hold the 
left mouse button and drag the mouse to select the region that you want to copy. 
Right-click and select Copy to copy the selected text to your clipboard. Use standard 
keyboard commands or menu commands to paste the copied image into an application.

• To copy the report as an image, press and hold the [Shift] key and the [Ctrl] key and then 
click and hold the left mouse button and draw a box around the region of the image that 
you want to copy. The selected region is filled with black. Right-click and select Copy to 
copy the image to your clipboard. Use standard keyboard commands or menu commands 
to paste the copied image into an application.

• To open the GAD for the trace that contains a mutation, double-click the mutation in the 
report.

• Display Homozygous Mutations—Selected by default. Clear this 
option if you do not want to show homozygous mutations in the 
report.

• Display Heterozygous Mutations—Selected by default. Clear this 
option if you do not want to show heterozygous mutations in the 
report.

• Display Hom/Het InDel—Selected by default. Clear this option if you 
do not want to show homozygous and heterozygous indels in the 
report.

Output

• Phred Score

• NM_Score 

• Normal Allele

• Mutation Call

All four of these columns are displayed by default in the PrettyBase 
Output report. Clear any or all options that you do want to be displayed 
in the report.

Note: For information about the NM_Score, see “NM_Score” on page 
176.

If you click a trace in the GAD with the PrettyBase report open, the GAD is 
brought to the front. To bring the report to the front again, press [CTRL]-T.

Option Description
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Methylation report
How Mutation Surveyor calls mutations for methylated DNA assumes 100% conversion of 
the unmethylated cytosines to uracil during bisulfite treatment. The evaluation of the 
methylation level in CpG islands as well as the level of incomplete conversion of 
unmethylated cytosines, however, is critical for ensuring that your methylation project has 
the necessary high quality data that is required for accurate mutation calls. The Methylation 
report displays information for methylation detection projects. The report distinguishes 
between cytosines that are contained in CpG islands and cystosines that are contained in 
other sequences. The report also displays a Conversion ratio, which is the ratio of the number 
of samples that were successfully converted at a given position to the total number of 
samples with the position. A Conversion Ratio of 100% indicates that the conversion was 
successful for all samples at the given position.

Figure 7-19:  Methylation report

     

Code Description

Cystosines contained in 
CpG islands

• M—Methylated

• U—Non-methylated

Cystosines contained in 
other sequences

• S—Successful conversion of cytosine (C) to thymine (T)

• I—Incomplete conversion
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Methylation report toolbar

The Methylation report toolbar contains buttons that are specific for working with the report 
and for changing the information that is displayed in the report.

Figure 7-20:  Methylation report toolbar

Button Description

Save Report—Opens the Save Report As dialog box in which you can 
specify a name and location for saving the report as a tab-delimited .txt 
file.

Copy—Copies the selected text in the cell to your clipboard. To copy 
text in a range of cells, click and hold the left mouse button and drag the 
mouse to select the region that you want to copy. Use standard 
keyboard commands or menu commands to paste the copied text into 
an application.

Report Settings—Opens the Methylation Report Settings dialog box 
which contains options for filtering the information that is to be displayed 
in the report.

Figure 7-21:  Methylation Report Settings dialog box

• Homozgyous Dropping Threshold—Indicates the value for the 
dropping factor at which a mutation is identified as either a 
homozygous substitution or a heterozygous substitution. For 
example, is a mutation A>C or A>AC? Because Mutation Surveyor 
evaluates the traces rather than the base calls, noise below a major 
peak can sometimes be interpreted as a heterozygous substitution. 
This value assists in your analysis by converting these calls to 
homozygous substitutions. 

Note: You can increase this value to view the exact call that Mutation 
Surveyor made, but an increased value might result in some 
calls remaining as heterozygous substitutions.

• Mutation Dropping Threshold—The dropping threshold must be 
greater than or equal to the specified value for the variant to be called 
a mutation. See “Dropping Factor” on page 64.

Graphic Display—Opens the Graphic Display of Methylations report. 
See “Graphic Display of Methylations report” on page 207.
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Graphic Display of Methylations report

The Graphic Display of Methylations report graphically shows the pattern of methylated and 
non-methylated cystosines along the DNA fragments used for analysis. By default, when the 
report first opens, only cytosines that are part of a CpG island are indicated in the report. Red 
tick marks indicate methylated sites. Dark blue tick marks indicate non-methylated sites. The 
Methylation Ratio graph represents the percentage of samples that are methylated at the 
indicated position in a CpG island. The Conversion Ratio graph represents the percentage of 
samples that were converted at the indicated position outside of a CpG island.

Figure 7-22:  Graphic Display of Methylations report

The report is interactive:

• To view the cytosines that are contained in other sequences, click Display S/I. Light blue 
tick marks indicate successful conversion of cytosine (C) to uracil (U). Gray tick marks 
indicate incomplete conversion.

• To zoom in on a selected region, click and hold the left mouse button and draw a box from 
the upper left hand corner of the region towards the lower right hand corner of the region. 
A box is formed around the area that is being reduced for viewing. 

• To zoom out from any region, click and hold the left mouse button and draw a box from 
the lower right hand corner of the region towards the upper left hand corner of the region. 
The magnification for zooming out is always 100%.

• If your mutation project used multiple GenBank files, then select one of these files from 
the Select GenBank file to view the display for the file and the sample files that align to it.

• By default, the filenames for all the files (GenBank, reference files, and sample files) are 
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displayed on the report. To remove the filenames from the report display, clear the Show 
Filenames option.

Methylation report context menu

Although the Methylation report does not have a full context menu, you can still copy text 
from the report, or copy the report as an image. You can also view the information for a 
mutation in the report in the GAD. 

• Select the text that you want to copy or to copy text in a range of cells, click and hold the 
left mouse button and drag the mouse to select the region that you want to copy. 
Right-click and select Copy to copy the selected text to your clipboard. Use standard 
keyboard commands or menu commands to paste the copied image into an application.

• To copy the report as an image, press and hold the [Shift] key and the [Ctrl] key and then 
click and hold the left mouse button and draw a box around the region of the image that 
you want to copy. The selected region is filled with black. Right-click and select Copy to 
copy the image to your clipboard. Use standard keyboard commands or menu commands 
to paste the copied image into an application.

• To open the GAD for the trace that contains a mutation, double-click the mutation in the 
report.

If you click a trace in the GAD with the Methylation report open, the GAD is 
brought to the front. To bring the report to the front again, press [CTRL]-T.
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Vertex report
The Vertex report displays mutations in all the sample sequences for a selected contig. By 
default, the mutations are shown as the 1 Letter IUPAC representation of the normal amino 
acid that is affected by the mutation and the resulting amino acid. Also by default, the entire 
sequence of the GenBank file is displayed at the top of the report.

Figure 7-23:  Vertex report

The report is interactive:

• To view the amino acid sequences for the sample traces in a different contig, select the 
contig from the Select Contig list.

• To display the 3 Letter IUPAC representation for the amino acids, select Three Letter. 

• To toggle between the amino acids and the called bases for the mutation, clear/select 
Show Amino Acid. (Like the amino acid codes, the called bases are represented by their 
IUPAC codes.)

• To zoom in on a selected region of the GenBank file, click and hold the left mouse button 
and draw a box from the upper left hand corner of the region towards the lower right hand 
corner of the region. A box is formed around the area that is being reduced for viewing.

• To zoom out from the GenBank file, click and hold the left mouse button and draw a box 
from the lower right hand corner of the sequence towards the upper left hand corner of the 
sequence. The magnification for zooming out is always 100%.

• To save the report as an .xls or .txt file, click the Save Report icon  on the report 
toolbar. A Save Report As dialog box opens in which you can specify the name, format 
and location for the saved report. (The .txt format is available only when saving the 
nucleotide sequence for the report. The .xls format is available only when saving the 
amino acid sequence for the report.)

• To copy the report as an image, press and hold the [Shift] key and the [Ctrl] key and then 
click and hold the left mouse button and draw a box around the region of the image that 
you want to copy. The selected region is filled with black. Right-click and select Copy to 
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copy the image to your clipboard. Use standard keyboard commands or menu commands 
to paste the copied image into an application.
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Vertex2 report
You use the Vertex2 report to assemble variations from multiple sequences or samples within 
one or multiple projects. The Vertex2 report is especially useful for analyzing hypervariable 
sequences. After you click Vertex2 Report on the Customer Reports menu, the Vertex Report 
Settings dialog box opens. You can leave the default values as is, or you can modify any of 
the values as needed, and then click OK to generate the report.

Figure 7-24:  Vertex Report Settings dialog box

Option Description

Sample Grouping—Determines how traces are to be grouped in the report.

• From Character [ ] To Character [ ]—Select this option if all the 
filenames in your project contain the same character string/
designator in the same positions.

• From File—Select this option if traces that are to be grouped together 
contain a common Sample ID in their filenames. (The Sample IDs do 
not need to be in the same location in the filename.) After you click 
From File, click Load Sample ID to open the Load Sample ID dialog 
box and specify the different Sample IDs, such as Patient #, by which 
to group the traces. You can also click Open in the Load Sample ID 
dialog box to load an existing Sample ID text file.

Note: By default, the Load Sample ID dialog box contains rows for up 
to ten different Sample IDs. You can right-click and click Insert 
or Delete as needed. 

Figure 7-25:  Load Sample ID dialog box
Mutation Surveyor User’s Manual 211



Chapter 7
Mutation Surveyor Customer Reports
Figure 7-26:  Vertex2 report

Mutation Output Settings

Heterozygous Call From 
[ ] To [ ]

A mutation call with a dropping factor that falls within the specified range 
is classified as a heterozygous mutation call. It is classified as a 
homozygous normal allele if its dropping factor falls below the lower 
threshold and as a homozygous mutation if its dropping factor exceeds 
the upper threshold. 

Output Confirmed 
Mutations Only

Display only manually confirmed mutations in the report.

Output Comments Display automatically added and manually added comments in the 
report.

Sequence Settings

• Show Amino Acid—Show the 1 Letter IUPAC representation of the 
normal amino acid that is affected by the mutation and the resulting 
amino acid. 

• Show Nucleotide—Show the IUPAC codes for the called bases for 
the mutation.

• Three Letters—Available only if Show Amino Acid is selected. Show 
the 3 Letter representation of the normal amino acid that is affected 
by the mutation and the resulting amino acid.

• Output Nucleotide Change—Display only those traces with called 
mutations in the report.

• Output Amino Acid Change Only—Display only those traces with 
called mutations in the report, and for these traces, display the 1 
Letter or 3 Letter IUPAC representation of the normal amino acid that 
is affected by the mutation and the resulting amino acid.

• Output Consensus Sequence—Display the consensus sequence for 
all sample traces in the report.

• Output Sample Sequences—Display the sequence for each 
individual sample trace in the report.

Option Description
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Vertex2 report toolbar

The Vertex2 report toolbar contains just two buttons for working with the report.

Figure 7-27:  Vertex2 report toolbar

Vertex2 report viewing and analysis options

Although the Vertex2 report does not have a context menu, you can copy the report as an 
image. You can also view the information for a mutation in the report in the GAD. 

• To copy the report as an image, press and hold the [Shift] key and the [Ctrl] key and then 
click and hold the left mouse button and draw a box around the region of the image that 
you want to copy. The selected region is filled with black. Right-click and select Copy to 
copy the image to your clipboard. Use standard keyboard commands or menu commands 
to paste the copied image into an application.

• To open the GAD for the trace that contains a mutation, double-click the mutation in the 
report.

Button Description

Save Report—Opens the Save Report As dialog box in which you can 
specify a name and location for saving the report as well as its format 
(.xls or .txt).

Report Settings—Opens the Vertex2 Report Settings dialog box which 
contains options for grouping and filtering the information that is to be 
displayed in the report. See “Vertex2 report” on page 211.

If you click a trace in the GAD with the Vertex2 report open, the GAD is brought to 
the front. To bring the report to the front again, press [CTRL]-T.
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Vertex3 report
Like the Vertex2 report, you can use the Vertex3 report to assemble variations from multiple 
sequences or samples within one or multiple projects. After you click Vertex3 Report on the 
Customer Reports menu, the Vertex3 Report Settings dialog box opens. You can leave the 
default values as they are, or you can modify any of the values as needed, and then click OK 
to generate the report.

Figure 7-28:  Vertex Report Settings dialog box

Option Description

Sample Grouping—Determines how traces are to be grouped in the report.

• From Character [ ] To Character [ ]—Select this option if all the 
filenames in your project contain the same character string/
designator in the same positions.

• From File—Select this option if traces that are to be grouped together 
contain a common Sample ID in their filenames. (The Sample IDs do 
not need to be in the same location in the filename.) After you click 
From File, click Load Sample ID to open the Load Sample ID dialog 
box and specify the different Sample IDs, such as Patient #, by which 
to group the traces. You can also click Open in the Load Sample ID 
dialog box to load an existing Sample ID text file.

Note: By default, the Load Sample ID dialog box contains rows for up 
to ten different Sample IDs. You can right-click and click Insert 
or Delete as needed. 

Figure 7-29:  Load Sample ID dialog box
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Vertex3 report layout

The Vertex3 report is organized by Clone (Sample) ID and contains three sections for each 
Sample ID.
 

Figure 7-30:  Vertex3 report

Mutation Output Settings

Heterozygous Call From 
[ ] To [ ]

A mutation call with a dropping factor that falls within the specified range 
is classified as a heterozygous mutation call. It is classified as a 
homozygous normal allele if its dropping factor falls below the lower 
threshold and as a homozygous mutation if its dropping factor exceeds 
the upper threshold.

Output Confirmed 
Mutations Only

Display only manually confirmed mutations in the report.

Output Comments Display automatically added and manually added comments in the 
report.

Option Description

Section Description

Nucleotide Sequences Displays the reference nucleotide sequence for the samples and 
the consensus nucleotide sequence for the samples.

Nucleotide Changes Displays a list of each location that contains a variation between 
the reference nucleotide and the sample nucleotide, the 
reference nucleotide at the location, the sample nucleotide at 
the location and a column denoting whether the variant is 
synonymous (S) or non-synonymous (N).

Amino Acid Displays the codon number, the reference amino acid and the 
consensus amino acid for each non-synonymous variation.
Mutation Surveyor User’s Manual 215



Chapter 7
Mutation Surveyor Customer Reports
Vertex3 report toolbar

The Vertex3 Report toolbar contains a single button on the toolbar—the Save Report button 
. Click this button to open a Save Report As dialog box in which you can specify the 

name and location for saving the report as a .txt file.

Vertex3 report viewing and analysis options

Although the Vertex3 report does not have a full context menu, you can still copy text from 
the report, or copy the report as an image. 

• Select the text that you want to copy or to copy text in a range of cells, click and hold the 
left mouse button and drag the mouse to select the region that you want to copy. 
Right-click and select Copy to copy the selected text to your clipboard. Use standard 
keyboard commands or menu commands to paste the copied image into an application.

• To copy the report as an image, press and hold the [Shift] key and the [Ctrl] key and then 
click and hold the left mouse button and draw a box around the region of the image that 
you want to copy. The selected region is filled with black. Right-click and select Copy to 
copy the image to your clipboard. Use standard keyboard commands or menu commands 
to paste the copied image into an application.
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Full Gene report
Of all the Customer reports, the Full Gene report is the most customizable report. It has 
options for: 

• Organizing sample traces into groups based on matching filenames and then further sort 
the sample traces within the groups based on specific character positions in the filenames.

• Custom color-coding to assist you with identifying different types of mutation calls and 
potential analysis problems. 

• Creating and displaying a custom header above each group of sample traces.

After you click Full Gene Report on the Customer Reports menu, the Full Gene Report 
Settings dialog box opens. You can leave the default values as they are, or you can modify 
any of the values as needed, and then click OK to generate the report. See:

• “Full Gene Report Settings dialog box, Format tab.”

• “Full Gene Report Settings, Header tab” on page 219.

• “Full Gene Report Settings, Output tab” on page 219.

Figure 7-31:  Full Gene report
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Full Gene Report Settings dialog box, Format tab

Figure 7-32:  Full Gene Report Settings dialog box, Format tab

     

Option Description 

Sample Grouping

n-Primer (n-D) Text 
input

Select this option if you have defined primers when using a GenBank 
reference file to group sample files in forward and reverse pairs.

Filename match • From Character [ ] To Character [ ]—Select this option if all the 
filenames in your project contain the same character string/
designator in the same positions.

• Typical Block—If all the filenames in your project contain the same 
character string /designators but in different positions, then select this 
option and enter the character string/designator.

Sort By From Character [ ] To Character [ ]—Select this option to further sort 
sample traces within a group based on specific character positions in 
the filenames.

Background Color-Coding

Accept the default colors for the different types of mutations, or modify them as you want.

Number Bases Relative 
to cDNA

• If this option is cleared, the numbering is the genomic position within 
the GenBank file. 

• If this option is selected:

• Select CDS to number the bases relative to the CDS numbering in 
the GenBank reference file.

• Select mRNA to number the bases relative the mRNA numbering 
in the GenBank reference file.
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Full Gene Report Settings, Header tab

The Header tab opens after you click Next on the Format tab.

Figure 7-33:  Full Gene Settings dialog box, Header information

Full Gene Report Settings, Output tab

The Output tab opens after you click Next on the Header tab.

Figure 7-34:  Full Gene Report Settings dialog box, Mutation Score and Output options
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Option Description

Mutation Settings

• Mutation position specific for column—Aligns mutations by column 
within each group.

• Display Mutation Number—Display the number of mutations found in 
the sample trace.

Mutation Scores

Reject 1D Calls When 
Other Direction has No 
Call

Reject a mutation that is called in only one direction when the position 
falls within the comparison region of the other direction. 

Reject 1D Calls When 
Other Direction is Not 
Available

Reject mutation calls that occur outside the region where the sample 
traces in both directions are aligned within the comparison region.

Reject Synonymous 
Mutations

Coding region substitutions that do not affect amino acid calls are not 
displayed in the report.

Note: An “n.a.” is displayed in the Mutation cell for rejected mutations instead of the mutation 
code.

Display Mutations with 
the “Stop” Codon or 
Indel Only

Display only nonsense mutations and indels in the report.

Display Confirmed 
Mutations Only

Display only those mutations that you have manually confirmed in the 
report.

Display Mosaic 
Mutations

Display mosaic mutations in the report.

Mutation Output Format

Display Mutation As Select one option to set the format of the mutation code in the report.

• 123T>CT (Default value)

• 123CT
220 Mutation Surveyor User’s Manual



Chapter 7
Mutation Surveyor Customer Reports
Figure 7-35:  Full Gene report

Full Gene report toolbar

The Full Gene report toolbar contains just two buttons for working with the report.

Figure 7-36:  Full Gene report toolbar

     

Button Description

Save Report—Opens the Save Report As dialog box in which you can 
specify a name and location for saving the report as well as its format 
(.xls, .xls (Excel sample in different sheet) or .txt).

Report Settings—Opens the Full Gene Report Settings dialog box which 
contains options for grouping and filtering the information that is to be 
displayed in the report.

Note: The Sample Grouping options are not available on the Format 
tab when you open the Full Gene Report Settings dialog box 
from the report toolbar. This prevents you from changing the 
report format after you have added custom text. To change the 
report format, close and then re-open the report. See “Full Gene 
Report Settings dialog box, Format tab,” “Full Gene Report 
Settings, Header tab,” and “Full Gene Report Settings, Output 
tab.”
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Full Gene viewing and analysis options

A context menu that contains options for changing the view of the Full Gene report and for 
manipulating and analyzing mutation project data. To open the context menu, right-click 
anywhere in the Full Gene report.

Figure 7-37:  Full Gene report context menu

Option Description

Confirm Confirms the selected mutations. 

Note: SHIFT-click to select multiple contiguous mutations or to select 
all mutations in a column.

The text for the mutation code turns black in both the Full Gene report 
and the Mutation table in the GAD. The comment <<Checked>> is 
displayed in the Actions field for the mutation call in the Mutation table in 
the GAD.

Undo Confirmation Removes the “Confirmed” status for the mutation. 

Note: SHIFT-click to select multiple contiguous mutations or to select 
all mutations in a column.

Delete Mutations Deletes the selected mutations. 

Note: SHIFT-click to select multiple contiguous mutations, to select all 
mutations in a column, or to select multiple rows.

The text for the mutation code turns gray in both the Full Gene report 
and the Mutation table in the GAD. The comment <<Deleted>> is 
displayed in the Actions field for the mutation call in the Mutation table in 
the GAD.

Delete Lane Deletes all the mutations for a selected sample in a single step. The 
Lane Quality for a deleted lane is set to “Low Quality.”

Undo Lane Deletion The Lane Quality for the lane is reset to its original value.
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The Full Gene report is interactive.

• You can double click in the Date, Batch Run/ID or/or Result fields and enter any text as 
needed.

• You can also view information for a mutation in the report in the GAD. To open the GAD 
for the trace that contains a mutation, double-click the mutation in the report.

Copy Copies the selected text in the cell to your clipboard. To copy text in a 
range of cells, click and hold the left mouse button and drag the mouse 
to select the region that you want to copy. Use standard keyboard 
commands or menu commands to paste the copied text into an 
application.

Note: You can also copy the Full Gene report as an image. Press and 
hold the [Shift] key and the [Ctrl] key and then click and hold the 
left mouse button and draw a box around the region of the 
image that you want to copy. The selected region is filled with 
black. Right-click and select Copy to copy the image to your 
clipboard. Use standard keyboard commands or menu 
commands to paste the copied image into an application.

Paste Pastes copied text into an editable field (Date, Batch Run/ID or/or Result 
fields).

If you click a trace in the GAD with the Full Gene report open, the GAD is brought 
to the front. To bring the report to the front again, press [CTRL]-T.

Option Description
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FullBase report
The FullBase report shows the forward and reverse consensus sequences for each base 
within specified ROIs. Amplicon IDs must be defined in GenBank or SEQ reference files 
and these IDs must be present in all the respective sample filenames. The Full Base report 
groups replicated positions into a single cell. After you click FullBase Report on the 
Customer Reports menu, the FullBase Report Settings dialog box opens. You can leave the 
default values as they are, or you can modify any of the values as needed, and then click OK 
to generate the report.

Figure 7-38:  FullBase Report Settings dialog box

     

You use GenBank File Editors to define Amplicon IDs. See Chapter 8, “GenBank 
File Editors,” on page 227 for information about defining Amplicon IDs.

Option Description

Amplicon ID from 
Character [ ] To 
Character [ ] 

Displays the starting and ending positions of the amplicon-specific 
starting designator in your reference filenames. 

Sample ID from 
Character to [ ] To 
Character [ ] 

Enter the starting and ending positions for the range in your sample 
filenames that contain the amplicon-specific designator.

Expected Number of 
Reads per Group

The expected total number of traces (forward and reverse) to pass the 
discrepancy check for a group of sample files.

Note: More traces can be in the consensus without being highlighted 
with a yellow background.

Analyst 1 Optional information to further clarify your analysis setup.

Analyst 2 Optional information to further clarify your analysis setup.

Reviewer Optional information to further clarify your analysis setup.
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FullBase report layout

Mutation calls are displayed in cells where a variation has been identified with the font color 
indicating the call confidence. Forward and reverse samples traces are paired next to each 
other with alternating colors of light tan and light blue differentiating the sample pairs. 
Positions that do not have enough samples for determining mutation calls are highlighted in 
yellow. Discrepancies (identifies the variants within a consensus of traces that have at least 
one member of the consensus that differs from the others) are also highlighted in yellow. The 
Comments field is a free text field for entering additional information about your project. 

Figure 7-39:  Full Base report

FullBase report toolbar

The FullBase Report toolbar contains a single button on the toolbar—the Save Report button 
. Click this button to open a Save As dialog box in which you can specify the name and 

location for saving the report as an .xls or .txt file.
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FullBase viewing and analysis options

Although the FullBase report does not have a full context menu, you can still copy text from 
the report, or copy the report as an image, and you can paste copied text into the editable 
Comments field. You can also view the information for a mutation in the Full Base report in 
the GAD. 

• Select the text that you want to copy or to copy text in a range of cells, click and hold the 
left mouse button and drag the mouse to select the region that you want to copy. 
Right-click and select Copy to copy the selected text to your clipboard. Use standard 
keyboard commands or menu commands to paste the copied image into an application, or 
use the Paste command on the Context menu to paste copied text into the editable 
Comments field.

• To copy the report as an image, press and hold the [Shift] key and the [Ctrl] key and then 
click and hold the left mouse button and draw a box around the region of the image that 
you want to copy. The selected region is filled with black. Right-click and select Copy to 
copy the image to your clipboard. Use standard keyboard commands or menu commands 
to paste the copied image into an application.

• Because the FullBase report shows every position and not just mutations, double-click a 
cell in the report to open the relevant position in the first trace of the consensus.

If you click a trace in the GAD with the FullBase report open, the GAD is brought 
to the front. To bring the FullBase report to the front again, press [CTRL]-T.
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Mutation Surveyor provides many tools for optimizing input data and analyzing results. This 
chapter details the three tools that are specifically designed for editing GenBank files and 
Sequence files—the GBK File Editor, the Advanced GenBank Editor, and the SEQ File 
Editor. You use all these tools to view, add, and edit CDS information in multi-exon 
GenBank files, which are essential functions for creating and using GenBank-derived 
reference traces.

This chapter covers the following topics:

• “Overview of GenBank Files” on page 229.

• “GBK File Editor Tool” on page 234.

• “Advanced GBK File Editor Tool” on page 242.

• “SEQ File Editor Tool” on page 257.

     

Although Mutation Surveyor provides many tools for optimizing input data and 
analyzing results, the GenBank Editor tools are the most commonly used of all the 
tools and that is why they are afforded their own chapter. Other Mutation 
Surveyor tools are discussed in appropriate chapters, including Chapter 9, 
“Mutation Surveyor Tools,” on page 263.
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Overview of GenBank Files
The GenBank sequence database is an open access, annotated collection of all publicly 
available nucleotide sequences and their protein translations. This database is produced at 
the National Center for Biotechnology Information (NCBI) as part of the International 
Nucleotide Sequence Database Collaboration, or INSDC. A GenBank file is a text-based file 
that shows the amino acid translation that corresponds to the base coding sequence (CDS). A 
GenBank file is always an optional file for a Mutation Surveyor project. If you do use a 
GenBank file as a reference file for Mutation Surveyor project, then the file must be in one of 
two formats—.gbk or .gb, which represents the sequence text of multiple CDSs or .seq, 
which represents the sequence text of a single CDS. All three file formats contain the same 
information and have similar conventions.

• A comment line is preceded with the greater than (>) symbol or a forward slash (/) and it 
contains the following information—the gene name, the CDS number, the reading frame 
number of the starting CDS base, the starting base number, the coding sequence (CDS), 
the starting amino acid number, the starting and ending vector sequences, the translation 
protein sequence from the CDS, and the DNA variations. Any text in a comment line is 
not read into the DNA sequence. 

• The coding sequence is in uppercase. All other sequences are in lowercase.

To download a GenBank file

1. Open the NCBI’s website (www.ncbi.nlm.nih.gov).

2. On the Search dropdown menu, select Gene.

3. In the search field, enter the official name or symbol for your gene of interest, and then 
click Search.

A list of all organisms that contain the specified gene is displayed.

Figure 8-1:  Searching for a gene (NCBI)

Mutation Surveyor is designed to work with GenBank files that are obtained solely 
from NCBI. You should not use GenBank files that are obtained from other 
sources. See “To download a GenBank file.”
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Figure 8-2:  Gene search results

4. Scroll to the Genomics region section in the search results and select the correct 
assembly for your project.

Figure 8-3:  Assembly options in the Gene report
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5. Download the selected assembly. Note the following about the different assemblies:

Figure 8-4:  NG Accession selected

Figure 8-5:  NC Accession selected

Assembly Description

NG Accession • The RefSeq.

• Most RefSeq GenBank files contain only a single transcript.

• NG Accession can show dbSNP.

• Nucleotide positions do not relate to chromosome coordinates.

• Click the GenBank link to download your selected NG Accession.

See Figure 8-4 below.

NC Accession • NC accessions often contain several transcripts.

• NC accessions do not have dbSNP.

• Nucleotide positions are chromosome coordinates.

• Click the GenBank link to download your selected NC Accession.

See Figure 8-5 below.

NT Accession • NT Accessions often contain several transcripts

• NT Accessions can show dbSNP.

• Nucleotide positions can be translated to chromosome coordinates.

• Click the dl link to download your selected NT Accession.

See Figure 8-6 on page 232.
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Figure 8-6:  NT Accession selected

6. Optionally, before you download and save the GenBank file, do one or more of the 
following:

• To include additional upstream and/or downstream sequences (for example, to 
include promoter regions), under Change Region Shown, click Selected Region, 
enter the new starting and ending base numbers, and then click Update View.

• To include SNPs for an NG Accession, open the Customize View menu, and under 
Features added by NCBI, select the [ ] SNPs option, and then click Update View.

• To change the view of the GenBank file for a gene that is on the minus strand, open 
the Customize View menu, and under Display Options, deselect Show Reverse 
Complement, and then click Update View. 

Figure 8-7:  Optional actions for a GenBank file

7. To save the GenBank file, open the Send menu, and then do the following.

a. Select Complete Record.

b. For Choose Destination, select File.
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c. For Format, select GenBank.

d. Click Create File.

A File Download dialog box opens with options to Open or Save the selected GenBank 
file.

8. Save the file in a location of your choosing.

You can now use the GenBank Editor and Advanced GBK Editor to view, edit, and 
annotate this GenBank file and you can also use the Advanced GBK Editor to save the 
file as a SEQ file. See “GBK File Editor Tool” on page 234 and “Advanced GBK File 
Editor Tool” on page 242.
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GBK File Editor Tool
You use the GBK File Editor tool to view, edit, or annotate a GenBank file.

To load a GBK file into the GBK File Editor tool

1. On the Mutation Surveyor main menu, click Tools > GBK File Editor to open the GBK 
File Editor window.

2. On the GBK File Editor window main menu, click File> Open, and in the Open File 
dialog box, select the appropriate .gbk file, and then click Open. 

The .gbk file is loaded into the GBK File Editor. The window has four tabs—General 
and Reference, Features 1, Features 2, and Sequence—with each tab displaying different 
information about the GenBank file. When the window first opens, the Sequence tab is 
the active tab. 

Figure 8-8:  GBK File Editor window with loaded .gbk file

     

If the downloaded GenBank file contains multiple genes and/or multiple isoforms, 
the GBK File Editor tool retains only the first isoform of the first gene in the file 
and it does not retain any mRNA information for the isoform. To select from 
multiple isoforms and to retain the mRNA information for the selected isoform, 
you must use the Advanced GBK File Editor tool. See “Advanced GBK File Editor 
Tool” on page 242.
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General and Reference tab/Features 1 tab

Mutation Surveyor pulls information directly from the loaded GenBank file and populates 
the appropriate fields on the General and Reference tab and on the Features 1 tab with this 
information. These tabs show information such as the definition of the gene, the accession 
number of the gene, and the source of the gene (General and Reference tab) and the starting 
and ending base numbers for the gene source and the chromosome number (Features 1 tab).

Figure 8-9:  GBK File Editor window, General and Reference tab

Figure 8-10:  GBK File Editor window, Features1 tab
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Features 2 tab 

The Features 2 tab displays additional gene identification information pulled from the loaded 
GenBank file, for example, the official name for the gene. The tab provides functions for 
editing the CDSs, ROIs, and primers. You can also view the amino acid translations for the 
CDSs on this tab and you can view the a list of the reported variations by position for both 
alleles in the GenBank file.

Figure 8-11:  GBK File Editor, Features 2 tab

CDSs in the GenBank file

The Join field lists the starting and ending base numbers for the first CDS, the second CDS, 
and so on as pulled directly from the loaded GenBank file. Within a CDS, the starting and 
ending base numbers are separated by two decimal points (..). CDSs are separated by 
commas. Two options are available for editing and adding CDS information for the gene:

• Manually edit the information in the Join Field, and then click Refresh. 

• On the CDS dropdown list, select CDS # (new), enter the starting and ending base 
numbers in the From and To fields, respectively, and then click Refresh. The Size field is 
automatically populated with the correct number of bases and the Join field is updated 
with the newly added CDS. 

Even if you modify the information for both the CDSs and the ROIs on this tab, 
your project’s graphical output can be limited based on the options that you have 
selected for Output Limits. See “Output Limits” on page 67.

Remember, CDSs are identified by a yellow location bar in the GAD. See 
“Mutation trace legend” on page 84.
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ROIs in the GenBank file

The Region of Interest fields display the ROIs as pulled directly from the loaded GenBank 
file. Two options are available for adding ROIs to the gene.

• To add ROIs that are based on the CDSs, on the Tool menu, click Auto Create ROI, and 
in the Create ROI for CDSs dialog box, specify the number of base pairs that are to 
included before (left) and after (right) each CDS, and then click OK. Click Refresh to 
view these changes in the Region of Interest fields. 

Figure 8-12:  Create ROI for CDSs dialog box

• To add ROIs that are independent of the CDSs, on the Region of Interest dropdown list, 
select ROI # (new), enter the starting and ending base numbers in the From and To fields, 
respectively, and then click Refresh. The Size field is automatically populated with the 
correct number of bases. 

Primers in the GenBank file

You can use the functions in the Primers fields to identify external and internal primer 
ranges.

• To identify External primer regions, on the Primers dropdown list, select External # 
(new), enter the starting and ending base numbers in the 5’ and 3’ From and To fields, 
respectively, and then click Refresh.

• To identify Internal primer regions, on the Primers dropdown list, select Internal # (new), 
enter the starting and ending base numbers in the 5’ and 3’ From and To fields, 
respectively, and then click Refresh.

Amplicon ID is always an optional value; however, if your samples overlap and 
you are using amplicons to construct contigs, then to ensure proper alignment, the 
Amplicon ID should be the same as the Amplicon ID that is used in your sample 
filenames. (See “Use Amplicon to Construct Contig” on page 61.)

Remember, ROIs are identified by a pink location bar in the GAD. See “Mutation 
trace legend” on page 84.
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Translation for the GenBank file

Mutation Surveyor generates the amino acid translation that is displayed in the Translation 
section based on the nucleotide sequence and the annotations in the CDSs in the loaded 
GenBank file. A red letter indicates the start of a CDS. A blue letter indicates a variation.

Variations in the GenBank file

The Variations section lists the reported variations by position for both alleles in the loaded 
GenBank file. For example, 31407T/C indicates two reported alleles of “T” and “C” at the 
31407 genomic base position. 

Sequence tab

The Sequence tab provides a visual representation of the gene. The tab is divided into three 
sections (upper, middle, and lower) that display different information for the gene. 

Figure 8-13:  GBK File Editor, Sequence tab

Remember, primer regions are identified by a light blue location bar in the GAD. 
See “Mutation trace legend” on page 84.

This color-coding corresponds to the color-coding on the Sequence tab. See 
“Sequence tab” on page 238.

Remember, colored tick marks indicate reported variations. See “Mutation trace 
legend” on page 84. 
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• The upper section displays the Base Count, which is the total base count on a per 
nucleotide basis, with each base having a different color-code. The upper section also 
shows the Sequence Start, which typically has a value of one, but can be negative if 
promoter regions are used. You can modify the value directly in this field, or you can 
modify it using the Adjust option. (See “GBK File Editor tool functions” on page 240.)

• The middle section is an editable textual representation of the full sequence for the gene. 
Black lowercase letters indicate nucleotides in a non-coding region. Red uppercase letters 
indicate nucleotides in a coding region. Blue letters indicate reported variations. (The 
letters are uppercase or lowercase depending on the region in which the variation occurs.) 
After you make a modification to the loaded GenBank file and click Refresh, Mutation 
Surveyor updates the display accordingly.

• The lower section is a color-coded bar chart that indicates different information about the 
gene. CDS regions are shown in green. Reported variations, including indels, are 
indicated by tick marks of different colors. The first row of numbers indicates a CDS, and 
the second row of numbers indicates the starting genomic base position for the CDS. For 
example, if you zoom in on Figure 8-13 on page 238, the 9th CDS has a starting genomic 
base position of 30,592. 

The Sequence tab is interactive:

• To zoom in on a CDS region or an mRNA region in the bar chart for easier viewing, hold 
down the left mouse button and draw a box from the upper left hand corner of the region 
towards the lower right hand corner. A box is formed around the area that being reduced 
for viewing.

• To zoom out, hold down the left mouse button and draw a box from the lower right hand 
corner of the region towards the upper left hand corner. (The magnification for zooming 
out is always 100%.)

     

You must make sure to include the entire CDS region in the box and you cannot 
extend the box’s upper boundary into the middle section.
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GBK File Editor tool functions

The GBK File Editor tool contains several functions for working with the loaded GenBank 
file. In addition to creating ROIs based on the CDSs, (see “ROIs in the GenBank file” on 
page 237), you can:

• Search the loaded GenBank file for a specific sequence. See “To search the loaded 
GenBank file for a specific sequence” below.

• Adjust the number of the first coding base or the sequence start. See “To adjust the 
number of the first coding base or the sequence start” on page 241.

To search the loaded GenBank file for a specific sequence

1. On the GBK File Editor main menu, click Search > Search in Sequence.

The Search in Sequence dialog box opens.

Figure 8-14:  Search in Sequence dialog box

2. Enter the sequence for which to search.

3. Optionally, to reverse complement the sequence before searching, click Complementary. 

If the sequence is found, the sequence text display in the middle section is moved to the 
first occurrence of the sequence and the text is displayed in pink on the tab. 

Figure 8-15:  Located sequence in sequence text display
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To adjust the number of the first coding base or the sequence start

At times, you might want to adjust the number of the first base or the first coding base in a 
GenBank file. For example, if a promoter region is 500 bps, then the sequence start that 
typically is 1 is now 501, but you still want the sequence start to be 1.

1. On the Advanced GBK File Editor main menu, click Tools > Adjust.

The Adjust File dialog box opens.

Figure 8-16:  Adjust File dialog box

2. Set your options as appropriate. 

3. Click OK.

The GBK File Editor display is updated accordingly.
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Advanced GBK File Editor Tool
You use the Advanced GBK Editor tool to view, edit, or annotate a GenBank file. If the 
GenBank file contains multiple protein and mRNA isoforms, the Advanced GBK File Editor 
tool displays all the proteins in the file and it displays the corresponding mRNA information 
for each isoform. You can also use the Advanced GenBank File Editor tool to add, view, or 
edit custom tags and identifiers to the reported variations in the file. 

To load a GenBank file into the Advanced GBK File Editor tool

1. On the Mutation Surveyor main menu, click Tools > Advanced GBK File Editor. 

2. On the GBK File Editor window main menu, click File > Open and in the Open File 
dialog box, select the appropriate file, and then click Open.

The file is loaded into the Advanced GBK File Editor. The Advanced GBK File Editor 
window has a toolbar with buttons that are specific for buttons for working with the 
loaded file and it has two panes—the GenBank Tree File pane and the Tabs pane. When 
the window first opens, the Sequence tab is the active tab in the Tabs pane.

Figure 8-17:  Advanced GBK Editor window

     

You can use the Advanced GBK File Editor tool to load and annotate .gb files, 
SEQ (.seq) files, trace files (.scf, .ab1, and .abi) and text (.txt) files as well as .gbk 
files. 
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Advanced GBK File Editor tool toolbar

Figure 8-18:  Advanced GBK File Editor tool toolbar

     

Button Description

New—Clears the currently loaded GBK file and readies the editor to 
accept a new file.

Open Files—Opens the Open Files dialog box which you use to load 
GenBank files or other files into the editor.

Save All CDSs and all mRNAs—Saves all the CDSs and mRNAs for the 
loaded GenBank file in a single file.

Refresh—Updates the display in the Advanced GBK File Editor window 
after you make a modification to the loaded GenBank file.

Search in Sequence—Opens the Search in Sequence dialog box in 
which you can specify a nucleotide sequence for which to search. See 
“Advanced GBK File Editor tool functions” on page 254.

Adjust —Opens the Adjust File dialog box which you can specify the 
Sequence Start for the selected isoform. See “Advanced GBK File 
Editor tool functions” on page 254.

Search in Database—Opens the Search in Database dialog box which 
provides an option for accessing a SoftGenetics server and 
downloading a GenBank file. See “Advanced GBK File Editor tool 
functions” on page 254.
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Advanced GBK File Editor tool GenBank Tree File pane

The left pane in the Advanced GBK File Editor window is the GenBank Tree File pane. This 
pane displays all the GBK file information (protein and mRNA) in a simple tree format. 
Click the plus (+) and minus (-) symbols to expand and collapse the tree structure, 
respectively. 

Figure 8-19:  Advanced GBK File Editor GenBank Tree File pane

The GenBank Tree File is interactive:

• Click an isoform in the tree structure to select it. The selected protein is marked with a 
green checkmark in the pane. Mutation Surveyor automatically selects the corresponding 
mRNA region for the CDS and marks it with a yellow checkmark. 

• Optionally, after you select an isoform, click File > Save As on the Advanced GBK File 
Editor tool main menu, and then on the dialog box that opens, indicate what information 
is to be saved:

The nucleotide sequence is the same for all isoforms. Only the mRNA and CDS 
locations change when you select a different isoform.

Option Description

Selected Gene Region Saves all the transcripts (CDSs and mRNAs) for the gene to a new 
GenBank file. You can specify the name of this new GenBank file, and 
the location in which to save it. 

Selected Gene Region; 
Selected mRNA Region

Saves only the transcript (CDS and mRNA) that is currently selected to 
a new GenBank file.You can specify the name of this new GenBank 
file, and the location in which to save it.
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• Expand the Variations folder to view a list of all the recorded variations.

Figure 8-20:  Expanded Variations folder

• Double-click a variation in the Variations list to open the Variation Settings dialog box. 
The Variation Settings dialog box provides detailed information about the selected 
variation, including its alleles and its position in the gene. 

Figure 8-21:  Variation Settings dialog box

Seq Files for Selected 
CDS

An individual SEQ file is created for each exon in the currently selected 
CDS. The default name for each SEQ file is 
<GenBank filename>_exon_<n>.seq, where <n> reflects the exon 
number, and the files are saved in the same folder as the loaded 
GenBank file; for example. BRCA1_AmpID_exon_1.seq.

Functions for modifying variations, adding new variations, and adding tags and 
identifiers to variations are available from this dialog box. See “Modifying and 
adding variations” on page 252.

Option Description
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Advanced GBK File Editor tool Tabs pane

The Tabs pane is the right pane in the Advanced GBK File Editor window. The tabs that are 
displayed in this pane depend on the item that is selected in the GenBank Tree File pane. If a 
protein or mRNA is selected in the GenBank Tree File pane, then the tabs that are displayed 
are the Basic Information tab and the Sequence tab. If a variation is selected in the GenBank 
Tree File pane, then the tabs that are displayed are the Allele Frequency tab and the 
Sequence tab. The Sequence tab is always the active tab when the Tabs pane first opens. 

Figure 8-22:  Advanced GBK File Editor window Sequence tab

Sequence tab

The Sequence tab provides a visual representation of the gene. The tab is divided into three 
sections (upper, middle, and lower) that display different information for the gene.

• The upper section displays the Base Count, which is the total base count on a per 
nucleotide basis, with each base having a different color-code. The upper section also 
shows the Sequence Start, which typically has a value of one, but can be negative if 
promoter regions are used. You can modify the value in the Sequence Start field, or you 
can modify it using the Adjust option. (See “Advanced GBK File Editor tool functions” 
on page 254.) You can also modify the values in the Amino Acid Start or the mRNA start 
index fields. To view the amino acid translation for the nucleotides in the CDS, click 
Amino Acids. 

Figure 8-23:  Amino acid translation for a CDS
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• The middle section is a view-only textual representation of the full nucleotide sequence 
for the selected protein or mRNA region. Black lowercase letters indicate nucleotides in 
a non-coding (intron or intragenic) region. Red uppercase letters indicate nucleotides in a 
coding region (CDS). Green uppercase letters indicate nucleotides in an mRNA region. 
Blue letters indicated reported variations. (The letters are uppercase or lowercase 
depending on the region in which the variation occurs.) After you make a modification to 
the loaded GenBank file and click Refresh, Mutation Surveyor updates the display 
accordingly.

• The lower section is a color-coded bar chart that indicates different information about the 
gene. mRNA regions are shown in green and CDS regions are shown in red. Reported 
variations, including indels, are indicated by tick marks of different colors. The first row 
of numbers indicates the starting genomic base position for a CDS and the second row of 
numbers indicates the CDS. For example, in Figure 8-24 below, the 7th CDS has a 
starting genomic base position of 34,399.

Figure 8-24:  CDS and genomic position numbering

The Sequence tab is interactive:

• To move the display in the middle section to the sequence for a CDS, double-click the 
CDS on the bar chart. Similarly, to move the display in the middle section to the sequence 
for an mRNA region, double-click the mRNA region on the bar chart. 

• To zoom in on a CDS region or an mRNA region in the bar chart for easier viewing, hold 
down the left mouse button and draw a box from the upper left hand corner of the region 
towards the lower right hand corner. A box is formed around the area that is being reduced 
for viewing.

• To zoom out, hold down the left mouse button and draw a box from the lower right hand 
corner of the region towards the upper left hand corner. (The magnification for zooming 
out is always 100%.)

     

You must double-click exactly the green region or the red region on the bar chart. 
If you click anywhere else on the bar chart, the display in the middle section does 
not move.

You must make sure to include the entire CDS region or the mRNA region in the 
box and you cannot extend the box’s upper boundary into the middle section.
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• To open a context menu that contains options for working with the sequence text display, 
right-click anywhere in the sequence text display.

Figure 8-25:  Sequence text display context menu

Basic Information tab

Mutation Surveyor pulls information directly from the loaded GenBank file and populates 
the fields on the Basic Information tab with this information. The information that is 
displayed on the tab depends on what option is selected in the GenBank Tree File pane—an 
isoform or an mRNA region. (See Figure 8-29 on page 250.) 

Figure 8-26:  Advanced GBK File Editor, Basic Information tab for selected isoform

Option Description

Copy Copies selected text in the sequence text display to your clipboard. To 
select text for copying, click and hold the left mouse button and drag the 
mouse to select the text that you want to copy. Use standard keyboard 
commands or menu commands to paste the copied text into an application.

Paste Pastes copied text into the sequence text display. 

Find Opens the Search in Sequence dialog box. You use the options on this 
dialog box to search for specific text in the sequence text display. (See 
“Advanced GBK File Editor tool functions” on page 254.)

Field Description

CDS Lists the starting and ending base numbers for the first CDS, the second 
CDS, and so on. Within a CDS, the starting and ending base numbers 
are separated by two decimal points (..). CDSs are separated by 
commas. You can manually edit the information in the CDS field.
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Region of Interest/
Amplicon Id

List of the ROIs defined in the CDS. Within an ROI, the starting and 
ending base numbers are separated by two decimal points (..). ROIs are 
separated by commas. Several options are available for adding and 
editing ROIs.

• You can manually edit the information in the ROI Field.

• You can right-click in either field and select View of Table of Values to 
open the Table of Values dialog box which lists the ROIs and 
Amplicon IDs in table. You can modify the ROI values directly in this 
table, and you can right-click in this dialog box and select Insert Item 
to add new ROIs and Amplicon IDs.

Figure 8-27:  Table of Values dialog box

Note: Amplicon ID is always an optional value; however, if your 
samples overlap and you are using amplicons to construct 
contigs, then to ensure proper alignment, the Amplicon ID 
should be the same as the Amplicon ID that is used in your 
sample filenames. (See “Use Amplicon to Construct Contig” on 
page 61.)

• You can add ROIs that are based on the CDSs. See “Advanced GBK 
File Editor tool functions” on page 254.

Note: Even if you modify the information for both the CDSs and the ROIs on this tab, your 
project’s graphical output can be limited based on the options that you have selected for 
Output Limits. See “Output Limits” on page 67.

External Primer

Internal Primer

Lists the starting and ending base numbers for the external/internal 
primer 5’ end and then for the external/internal primer 3’ end. For each 
end, the starting (From) and ending (To) base numbers are separated 
by two decimal points (..). The primers are separated by commas. 

Note: Use the Primer fields on the GenBank file Editor serves as a 
visual guide when entering information in these fields.

Figure 8-28:  Primer fields on GenBank File Editor tool

Field Description
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Figure 8-29:  Advanced GBK File Editor, Basic Information tab with mRNA region selected 
in GenBank Tree File pane

     

• CodonStart

• product

• protein_id

• note

• translation

• Corresponding_mRNA
_region

• transl_table

Mutation Surveyor pulls the information in these fields directly from the 
loaded GenBank file. Mutation Surveyor deduces the corresponding 
mRNA region for each protein by inspecting the start and end positions 
of each of the exons between the protein and the mRNA. Mutation 
Surveyor deduces the amino acid translation relative to the nucleotides 
in the coding sequence.

Field Description

Region Lists the starting and ending base numbers for the first mRNA region, 
the second mRNA region, and so on. Within an mRNA region, the 
starting and ending base number are separated by two decimal points 
(..). mRNA regions are separated by commas. You can manually edit 
the information in the Region field.

• transcipt_id 

• product

• note

• Corresponding_CDS_
region

Mutation Surveyor pulls the information in these fields directly from the 
loaded GenBank file. Mutation Surveyor deduces the corresponding 
protein for each mRNA region by inspecting the start and end positions 
of each of the exons between the protein and the mRNA.

Field Description
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Allele Frequency tab

If a variation is selected in the GenBank Tree File pane, then the Tabs pane contains an 
Allele Frequency tab instead of a Basic Information tab. This tab lists all the reported 
variations in the GenBank file as well as any of the variations that you or other users have 
added to the file.

Figure 8-30:  Allele Frequency tab

To open a context menu that contains options for annotating the information in the 
Frequency column adding a variation, deleting a variation, and copying a variation, 
right-click anywhere in the Allele Frequency tab.

Figure 8-31:  Allele Frequency tab context menu

The frequency information refers to allele frequency with regards to population 
studies. Mutation Surveyor does not use this information and most SNPs in dbSNP 
do not have this information populated. 

Option Description

Modify Parameter Opens the Variation Setting dialog box in which you can modify the 
selected variation. See “Modifying and adding variations” on page 252.

Add Variation Opens a blank Variation Setting dialog box in which you can add a new 
variation to the loaded GenBank file. See “Modifying and adding variations” 
on page 252.
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Modifying and adding variations

You can use functions that are available for the Allele Settings box to modify the information 
for a selected variation, add a variation to the loaded GenBank file, and add tags and 
identifiers to the variations.

Figure 8-32:  Variation Settings dialog box

• To modify any of the information in the Position field or Gene Name field, double-click 
a displayed value to select it, and then modify the value. 

• To modify the Identifier information for an existing tag, double-click the displayed value 
to select it, and then modify the value. You can also select a different tag for the variation 
on the Tag dropdown list.

• To add multiple tags for a variation, right-click anywhere in the db_xref pane, and on the 
context menu that opens, click Add Line. A new blank line for a tag and identifier is added 
to the pane. 

Delete Deletes the selected variation line from the list of reported variations.

Note: You can also delete a variation by right-clicking the variation in the 
GenBank Tree File pane, and then clicking Delete.

Copy Copies the selected text in the cell to your clipboard. To copy text in a range 
of cells, click and hold the left mouse button and drag the mouse to select 
the region that you want to copy. Use standard keyboard commands or 
menu commands to paste the copied text into an application.

Option Description
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• To modify the information in the Allele Frequency area for a selected variation, 
triple-click the allele that is being modified to select it, and then modify the allele as 
needed.

Figure 8-33:  Modifying a selected variation

• To delete an allele from a variation, right-click in the Allele Frequency area, and on the 
context menu that opens, click Delete Allele. Allele2 is deleted. Repeat this step to delete 
Allele 1. 

• To add a new variation:

i. Enter the Position and Gene Name for the variation.

ii. Right-click in the Allele Frequency area, and on the context menu that opens, click 
Add Allele. Enter a value for Allele1. Repeat this step for Allele 2. 

iii. In the db_xref pane, select a tag from the Tag dropdown list, and then enter a value 
in the Identifier field. You can include both the tag and the identifier, or just one, or 
none. You can also include multiple tags and/or identifiers.

After you have made modifications to an existing variation, or added the values for a new 
variation, click OK to save your edits. 

     

Substitution

Insertion

Deletion
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Advanced GBK File Editor tool functions

The Advanced GBK File Editor tool contains a variety of functions for working with the 
loaded GenBank file. You can: 

• Search the loaded GenBank file for a specific sequence. See “To search the loaded 
GenBank file for a specific sequence” below.

• Access a GenBank database on a SoftGenetics server to download a GenBank file with 
the same sequence. See “To download a GenBank file with the same sequence” on page 
255.

• Adjust the number of the first coding base or the sequence start. See “To adjust the 
number of the first coding base or the sequence start” on page 255.

• Add ROIs that are based on the CDSs. See “To add ROIs that are based on CDSs” on page 
256.

• Reverse complement the currently loaded GenBank file. See “To reverse complement the 
currently loaded GenBank file” on page 256.

To search the loaded GenBank file for a specific sequence

1. On the Advanced GBK File Editor main menu, click Search > Search in Sequence.

The Search in Sequence dialog box opens.

Figure 8-34:  Search in Sequence dialog box

2. Enter the sequence for which to search in this dialog box.

3. Optionally, to reverse complement the sequence before searching, click Complementary. 

If the sequence is found, the sequence text display in the middle section is moved to the 
first occurrence of the sequence and the text is displayed in pink on the tab. 

Figure 8-35:  Located sequence in sequence text display
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To download a GenBank file with the same sequence

1. On the Advanced GBK File Editor main menu, click Search > Search in Database. 

The Search in Database dialog box. opens. This dialog box lists the entire nucleotide 
sequence of the currently loaded GenBank file.

Figure 8-36:  Search in Database dialog box

2. Click Submit to initiate the search.

If a GenBank file is located that has the same genomic sequence as the currently loaded 
GenBank file, then Mutation Surveyor replaces the currently loaded GenBank file with 
the GenBank file from SoftGenetics’s database. If a GenBank file that matches the 
genomic sequence of the currently loaded file cannot be found, then a message opens 
indicating this and the currently loaded GenBank file is cleared from the editor. 

To adjust the number of the first coding base or the sequence start

At times, you might want to adjust the number of the first base or the first coding base in a 
GenBank file. For example, if a promoter region is 500 bps, then the sequence start that 
typically is 1 is now 501, but you still want the sequence start to be 1.

1. On the Advanced GBK File Editor main menu, click Tools > Adjust.

The Adjust File dialog box opens.

Figure 8-37:  Adjust File dialog box

2. Set your options as appropriate. 
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3. Click OK.

The Advanced GBK File Editor display is updated accordingly.

To add ROIs that are based on CDSs

1. On the Advanced GBK File Editor main menu, click Tools > Adjust.

The Create ROI for CDSs dialog box opens.

Figure 8-38:  Create ROI for CDSs dialog box

2. Specify the number of base pairs that are to included before (left) and after (right) each 
CDS.

3. Click OK. 

4. Click the Refresh icon  to view these changes in the Region of Interest field on the 

Basic Information tab. 

To reverse complement the currently loaded GenBank file

1. On the Advanced GBK File Editor main menu, click Tools > Complement.

A message opens, asking you if you want to reverse complement the currently loaded 
GenBank file. 

2. Click Yes. 

The Advanced GBK Editor display is updated accordingly, and a second message opens, 
asking you if you want to save the complement GenBank file. 

3. Click Yes.

By default, the file name is the name of the GenBank file that was complemented and 
appended with the word “complement” (for example, 
BRCA1_NC_RC_complement.gbk) and the file is saved in the same directory as the file 
that was complemented. You can change either or both of these values as needed.
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SEQ File Editor Tool
You use the SEQ File Editor tool to view, add, and edit CDS information in SEQ files. 

To load a SEQ file into the SEQ File Editor tool

1. On the Mutation Surveyor main menu, click Tools > SEQ File Editor to open the SEQ 
File Editor window.

2. On the SEQ File Editor window main menu, click File> Open, and in the Open File 
dialog box, select the appropriate .seq file, and then click Open. 

The .seq file is loaded into the SEQ File Editor. 

Figure 8-39:  SEQ File Editor window with loaded .seq file

     

You can use the SEQ File Editor tool to load and annotate FASTA (.fasta) and 
trace files (.scf, .ab1, and .abi) and text (.txt) files as well as .seq files. 
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SEQ File Editor tool layout

The SEQ File Editor window is divided into two sections—-upper and lower. The upper 
section contains fields that are automatically populated with the information that Mutation 
Surveyor has pulled directly from the loaded SEQ file. You can edit much of this information 
to suit your working needs. The lower section is an editable textual representation of the full 
sequence for the single CDS. Black lowercase letters indicate nucleotides in a non-coding 
region. Red uppercase letters indicate nucleotides in a coding region. Blue letters indicated 
reported variations. (The letters are uppercase or lowercase depending on the region in which 
the variation occurs.) After you make a modification to the loaded SEQ file and click 
Refresh, Mutation Surveyor updates the display accordingly.

Field Description

Gene The gene name.

Exon and Note The Exon number and any other additional information for the exon. 

Note: All Exon fields on all Mutation Surveyor reports are automatically 
populated with the value in this field, so edit this value carefully.

Reading Frame Reading frame number for the first coding base.

Remainder 
Base(s) of 
Previous CDS

The number of bases that are required from the previous CDS that is required 
to complete the first codon of the currently loaded CDS. 

• If the Reading Frame =1, then the no bases are required. The coding 
sequence is complete.

• If the Reading Frame =2, then a single base is required from the previous 
CDS.

• If the Reading Frame =3, then two bases are required from the previous 
CDS.

Remainder 
Base(s) of Next 
CDS

The number of bases that are required from the next CDS that is required to 
complete the last codon of the currently loaded CDS. 

• If the Reading Frame of the next CDS=1, then the no bases are required. 
The coding sequence is complete.

• If the Reading Frame of the next CDS=2, then two bases are required from 
the next CDS.

• If the Reading Frame of the next CDS=3, then one base is required from the 
next CDS.

The Number of 
the First Base

The number assigned to the first nucleotide in the sequence text display. If you 
change this number, then numbering of all the nucleotides in the sequence text 
display is changed accordingly.

Note: If you change the value for The Number of the First Base, the CDS 
numbers and the ROI numbers are not changed. To change these 
numbers, you must use the Adjust function. (See “SEQ File Editor tool 
functions” on page 261.).

mRNA Start Index The genome position of the mRNA start is related to the mRNA numbering 
through the mRNA Start Index. This value is needed to determine the offset in 
numbering between the CDS nomenclature and the mRNA nomenclature 
relative to the number of bases in the untranslated region that is upstream of 
the CDS start.
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mRNA The starting and ending nucleotide numbers for the mRNA region.

Note: If you modify these values, the selected sequence is read as cDNA. 

CDS Index The CDS number as pulled directly from the loaded SEQ file.

Coding Sequence The starting and ending nucleotide numbers for the CDS. The CDS is 
indicated by red letters in the sequence text display. 

Region of Interest The starting and ending nucleotide numbers for the ROI defined in the CDS. 

Caution: You can renumber the positions in the SEQ file (The Number of the First Base, the mRNA 
Start and End values, the Coding Sequence Start and End values, and the Region of 
Interest Start and End values) so that the numbering is relative to the CDS and not to the 
genomic positions (which is the numbering scheme in the GAD); however, if you do 
renumber the positions, then the position at the end of one sequence file might overlap 
the position at the beginning of the next sequence file, which can cause difficulty in your 
data analysis. 

Note: Even if you modify the information for both the CDSs and the ROIs on this tab, your 
project’s graphical output can be limited based on the options that you have selected for 
Output Limits. See “Output Limits” on page 67.

Amino Acid 
Sequence

The starting codon and ending codon numbers for the amino acid string for 
which the currently loaded CDS codes. If the starting and ending coding 
sequence positions are populated and you enter only the starting amino acid 
string number, and then click Refresh, Mutation Surveyor automatically 
calculates the ending number for the string.

Note: To display the amino acid sequence in the standard mutation reports 
and the GAD, Amino Acid must be selected on the Output tab of the 
Project Options dialog box. See “Output tab” on page 66.

• Starting Vector 
Sequence

• Ending Vector 
Sequence

Trims a sample sequence according to a starting vector sequence and an 
ending vector sequence. To carry out a vector trim:

• You must specify both the vector base sequence and the clone DNA base 
sequence in the Sequence field.

• You must specify the starting vector sequence in the Starting Vector 
Sequence field.

• You must specify the ending vector sequence in the Ending Vector 
Sequence field. 

Mutation Surveyor carries out a “loose match” between the vector base 
sequence and the starting and ending vector sequences to determine the 
regions of the SEQ reference file that contain the vector sequence. When a 
sample trace aligns to both the vector sequence and the cDNA sequence of 
the SEQ reference file, Mutation Surveyor adjusts the mutation detection 
region inward to avoid mutation detection in the vector sequence of the sample 
traces.

Note: To carry out a vector trim, Vector Trimming must be selected on the 
Options tab of the Project Options dialog box. See “Contig tab” on 
page 59. Mutation Surveyor trims the data according to the specified 
values and indicates the boundaries with vertical blue bars in the 
GAD.

Note: You can also use the Mask Vector Sequence tool to replace base calls 
in the vector sequence region. See “Mask Vector Sequence Tool” on 
page 301.

Field Description
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Variations If you modify or enter known sequence variations, the variations must adhere 
to a specific layout:

• Substitution:

• <position><variant>/<normal>(<dbSNP_Identifier>)

Example: 30565C/T(dbSNP:8176209)

• Insertion:

• <position_before>..<position_after>-/<nucleotides>(dbSNP_identifier>)

Example: 30609..30610-/C(dbSNP:35466763)

• <position_before>..<position_after>ins<nucleotides>(<dbSNP_Identifier

Example: 30609..30610insC(dbSNP:35466763)

• Deletion:

• <position_1>..<position_N><nucleotides>/-(<db_SNP_Identifier>)

Example: 31549..31552GCAG/-(dbSNP:84678345)

• <position_1>..<position_N>del<nucleotides>/-(<db_SNP_Identifier>)

Example: 31549..31552delGCAG(dbSNP:84678345)

Amino Acid 
Sequence

The amino acid sequence that corresponds to the base sequence beginning 
one base after the Start base indicated for the Amino Acid Start. The string is 
shown using standard IUB/IUPAC amino acid codes. 

Amplicon ID Amplicon ID is always an optional value for the ROI; however, if your samples 
overlap and you are using amplicons to construct contigs, then to ensure 
proper alignment, the Amplicon Id should be the same as the Amplicon ID that 
is used in your sample filenames. (See “Use Amplicon to Construct Contig” on 
page 61.)

Is Last mRNA Select this option if the SEQ file contains the last base of mRNA for the gene. 

Note: Mutation Surveyor does not automatically add a checkmark to the 
“Last mRNA” field for the SEQ file that contains the last base of mRNA 
when you create SEQ files from the Advanced GBK File Editor.

Note: The Relative to mRNA nomenclature outputs IVS*5 for a position that 
is 5 bases after the mRNA, rather than IVS3123+5, indicating that the 
position is outside of the mRNA, and not within an intron.

Field Description
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SEQ File Editor tool functions

The SEQ File Editor tool contains several of functions for working with the loaded SEQ file. 
In addition to being able to modify values directly in the editor, you can:

• Search the loaded SEQ file for a specific sequence. See “To search the loaded GenBank 
file for a specific sequence” below.

• Adjust the number of the first coding base or the sequence start. See “To adjust the 
number of the first coding base or the sequence start” on page 262.

To search the loaded SEQ file for a specific sequence

1. On the SEQ File Editor main menu, click Search > Search in Sequence.

The Search in Sequence dialog box opens.

Figure 8-40:  Search in Sequence dialog box

2. Enter the sequence for which to search in this dialog box.

3. Optionally, to reverse complement the sequence before searching, click Complementary. 

If the sequence is found, the sequence text display in the middle section is moved to the 
first occurrence of the sequence and the text is displayed in pink on the tab. 

Figure 8-41:  Located sequence in sequence text display

     
Mutation Surveyor User’s Manual 261



Chapter 8
GenBank File Editors
To adjust the number of the first coding base or the sequence start

At times, you might want to adjust the number of the first base or the first coding base in a 
SEQ file. For example, if a promoter region is 500 bps, then the sequence start that typically 
is 1 is now 501, but you still want the sequence start to be 1.

1. On the Advanced GBK File Editor main menu, click Tools > Adjust.

The Adjust File dialog box opens.

Figure 8-42:  Adjust File dialog box

2. Set your options as appropriate. 

3. Click OK.

The SEQ File Editor display is updated accordingly.
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Mutation Surveyor provides many tools for optimizing input data and analyzing results, 
including tools for modifying filename information to ensure the correct grouping of sample 
files in a project, tools for converting files from one format to another, and tools for 
assembling sample files and project files for comparison.

This chapter covers the following topics:

• “Sample File Editing Tools” on page 265.

• “File Conversion Tools” on page 279.

• “Assembly Tools” on page 287.

• “Reference Management Tools” on page 308.

• “Other Tools” on page 299.
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Section 1
Sample File Editing Tools

Section Contents

• “Filename Editor Tool” on page 267.

• “2D Filename Match Editor tool” on page 271.

• “ND Filename Match Editor Tool” on page 274.

• “Print Header Editor Tool” on page 277.
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Filename Editor Tool
You use the FileName Editor tool to modify your sample filenames to ensure that your 
sample files will be grouped correctly in a Mutation Surveyor project. You can use the tool to 
modify sample filenames programmatically, or you can manually change filenames using a 
tab-delimited text file.

To programmatically change filenames

1. On the Mutation Surveyor main menu, click Tools > Filename Editor.

The Filename Editor window opens.

Figure 9-1:  Filename Editor window

2. Click the Browse button  next to the From field, and browse to and select the 

directory that contains the sample files for which you are modifying the names.

A list of all the sample files in the selected directory is displayed in the From (left) pane 
of the window. 

3. Click the Browse button  next to the To field, and browse to and select the directory 

that is to contain the renamed sample files.

     

If you select the same directory for the From and To lists, then your original files 
are replaced with the edited files, so select the same directory only if you do not 
want to retain your original files.
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4. Select the option by which to modify your existing sample filenames.

A placeholder in the form of *.* is displayed in the blank field below the From field and 
below the To field. The asterisk (*) in this placeholder is a wildcard character, which is a 
a special character that represents one or more characters in a string of characters. For 
example, in searching, “run*” implies to search for any word that starts with “run” and 
that has any ending, such as running, runt, runs, rundown, and so on.

5. In the From field, enter the part of the filename that is to be replaced or removed 
between the asterisks.

6. In the To field, enter the characters that are to replace the filename or part of the filename 
between the asterisks. If you have selected Overwrite and you simply want to remove a 
selected part of the filename, enter **. 

7. Click Refresh.

The list of edited sample names is displayed in the To (right) pane of the window.

Figure 9-2:  Overwrite example (characters replaced)

Option Description

Overwrite Replaces all or part of the original filename. You can replace part or all the 
filename with different characters, or you can replace all or part of the 
filename with no characters, which essentially removes the specified part of 
the filename. 

Use*_1 Replaces all or part of the original filename and then sequentially numbers 
any identically named files.

Use *_erase part Removes specified characters from the filename. The remaining characters 
make up the new filename.

The list of sample files temporarily disappears from the From list as you enter the 
part of the filename that you want to remove. The list is displayed again after 
Mutation Surveyor recognizes the part of the filename that you have entered.

Whatever value that you enter in the From field is automatically entered in the To 
field as well, so you must make sure to edit the value in the To field correctly.
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Figure 9-3:  Overwrite example (characters removed)

Figure 9-4:  Use*_1 example

Figure 9-5:  Use*_ erase part example

8. Do one of the following:

• If you selected the same directory for the From and To lists, click Rename.

• If you selected different directories for the From and To lists, click Copy.

To manually change filenames

1. Create a tab-delimited text file that has two columns. In the first column, enter the 
current filenames. In the second column, enter the target filenames.

2. Save the text file in the same directory as the sample files.

3. On the Mutation Surveyor main menu, click Tools > Filename Editor.

The Filename Editor window opens.

4. Click Rename Text File.
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5. Click the Browse button  next to the From field, and browse to and select the text 

file.

A list of all the sample files in the selected directory is displayed in the From (left) pane 
of the window. 

6. Click the Browse button  next to the To field, and browse to and select the directory 

that is to contain the renamed sample files.

7. Click Rename.

The list of edited sample names is displayed in the To (right) pane of the window.

If you select the same directory for the From and To lists, then your original files 
are replaced with the edited files, so select the same directory only if you do not 
want to retain your original files.
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2D Filename Match Editor tool
If your sample files are named in such a way that neither Mutation Surveyor’s default project 
options nor Mutation Surveyor’s automatic file pairing options result in your sample files 
being paired correctly, you should use the 2D Filename Match Editor tool to create a 
Grouping File. A Grouping File is a text file that defines how your sample files should be 
paired in your Mutation Surveyor project. You can point to the Grouping File in your 
Mutation Surveyor project, and all the sample files that are defined in the file are added to 
the project. 

To use the 2D Filename Match Editor tool

1. On the Mutation Surveyor main menu, click Tools > 2D Filename Match Editor.

The 2D Filename Match Editor window opens.

Figure 9-6:  2D Filename Match Editor window
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2. Click Add.

The Open Files dialog box opens.

Figure 9-7:  Open Files dialog box

3. In the Sample Files (lower) pane, click Add, and then click Add Files or Add Directory 
to select the samples files that are to be grouped.

4. Click OK.

The samples files are added to the 2D Filename Match Editor window. Mutation 
Surveyor initially tries to correctly group the sample files based on information in the 
sample file names such as *_F and *_R.

Figure 9-8:  2D Filename Editor window with files paired by Mutation Surveyor

If you are adding files, CTRL-click to select multiple non-contiguous files. 
SHIFT-click to select multiple contiguous files. If you are adding a directory, then 
all the files in the directory are added in a single step.
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5. If the automatic pairing is correct, then continue to Step 6; otherwise, continue to Step 7.

6. Click Save to open the Save Result dialog box in which you can specify a name for 
saving the Grouping File.

Figure 9-9:  2D Grouping File example

7. If the automatic pairing is not correct, then do one or more of the following to correctly 
pair your sample files:

• Add a GenBank file to assist Mutation Surveyor surveyor in aligning and pairing the 
sample files. 

• Select a file and use the Forward (F--> R) or Reverse (F <--R) buttons to move the 
sample file to the correct list. After you have moved all the necessary files, click 
Refresh to have Mutation Surveyor try to correctly group the sample files based on 
information in the sample file names such as *_F and *_R.

• Select a file and use the Forward (F--> R) or Reverse (F <--R) buttons to move the 
sample file to the correct list. After you have moved all the necessary files, edit the 
order of the lists. (To edit the order, click a position number to select it, change the 
position number accordingly, and then click Refresh.)

• Use model files to correctly pair sample files.

• Identify two forward sample files and two reverse sample files that are 
appropriate to serve as “model” files. 

• Move the reverse sample files to the Reverse Files list. 

• Right-click each forward sample file and on the context menu that opens, click 
Copy to Model. Repeat this step for the reverse sample files. 

• Click Model Match to correctly pair the remaining sample files.

8. Click Save to open the Save As dialog box in which you can specify a name for saving 
the Grouping File.

By default, the Grouping File is saved as a text file in the same folder as all the 
sample files. You must not change this location, or the Grouping File function will 
not work.

By default, the Grouping File is saved as a text file in the same folder as all the 
sample files. You must not change this location, or the Grouping File function will 
not work.
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ND Filename Match Editor Tool
You use the ND Filename Match Editor tool to create a Grouping that can assist in grouping 
sample files correctly in the Project report and in the SGP Comparison tool. The sample files 
can be .scf files or .abi/ab1 files. 

To use the ND Filename Match Editor

1. On the Mutation Surveyor main menu, click Tools > ND Filename Match Editor.

Figure 9-10:  ND Filename Match Editor window

     

You do not have an option to load the ND Grouping file for the Project report after 
running a Mutation Surveyor project. To use the ND Grouping file for the Project 
report, when setting up your Mutation Surveyor project, you must select Load 
Grouping File on the Open files dialog box, and then click Add in the Sample Files 
pane to select the Grouping file. All the sample files that are listed in the Grouping 
file are added to the project. Although Mutation Surveyor attempts to use the 
information in the Grouping file to group the sample files in the project, the 
Grouping file’s primary purpose is for the grouping of sample files in the Project 
report, the Project Sample Assembly subreport, and the Comparison functions. 
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2. Click Add to open the Open Sample Files dialog box and select the sample files that are 
to be grouped.

The sample files are displayed in the ND Filename Match Editor window. Each row in 
the window represents a group of sample files. By default, the sample files are first 
grouped by comparing the filenames from character one to character five.

Figure 9-11:  ND Filename Match Editor window with grouped sample files

3. Optionally, to modify the sample file grouping, change the character values for Compare 
Filename, and then click Refresh.

4. When you are satisfied with the sample grouping, do one of the following to save the 
Grouping file as a text file:

• If you are saving the Grouping file in the same location as the sample files, click 
Save As to open the Save As dialog box in which you can specify a name and a 
location for saving the Grouping file as a text file. 

By default, the Filename file is populated with _NDMatch.txt. You can the name, 
but you cannot change the file type. The Grouping file lists each row from the 
display as a single line in the text file. 

Figure 9-12:  ND Grouping file saved in same location as the sample files

CTRL-click to select multiple non-contiguous files. SHIFT-click to select multiple 
contiguous files.
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• If you are saving the Grouping file in a different location than all the sample files, 
then click Save Full Path of Sample Files, and then click Save As to open the Save 
As dialog box in which you can specify a name and a location for saving the 
Grouping file as a text file.

By default, the Filename file is populated with _NDMatch.txt. You can change the 
name, but you cannot change the file type. The Grouping file lists each row from the 
display as a single line in the text file with the full path to the file name included.

Figure 9-13:  ND Grouping file saved in a different location than the sample files

5. Click Close.

Even if you close, and then reopen Mutation Surveyor, the ND Filename Match 
Editor tool “remembers” the last settings that specified for it. 
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Print Header Editor Tool
You use the Print Header Editor tool to create a custom header that can be displayed at the 
top of designated output files.

To use the Print Header Editor tool

1. On the Mutation Surveyor main menu, click Tools > Print Header Editor.

The Print Header Editor window opens.

Figure 9-14:  Print Header Editor window

2. Do one of the following:

• Modify any of the default template information in either column. 

• Click Open to select an existing custom header file to modify.

3. Optionally, add or delete rows of information as needed.

• To delete a row from the header, right-click the row, and then click Delete a Row.

• To insert a row into the header, right-click the row that is to be located below the 
inserted row, and then click Insert a Row.

• To add a row as the last row in the header, right-click any row, and then click Add a 
Row.

4. Click Save to save the custom header as an .inf file.

     

When modifying an existing custom header, click Default at any time to reset all 
values in both columns to their original values. 
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Section 2
File Conversion Tools

Section Contents

• Create SCF Tool on page 281

• Convert to SCF tool on page 284

• Extract SGP Tool on page 285
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Create SCF Tool
You use the Create SCF tool to create a synthetic or pseudo trace file from the sequence in a 
SEQ file or in a GBK file. Traces are created in both the forward and reverse direction 
whenever possible and are saved as .scf files. 

Synthetic traces versus pseudo traces

At a minimum, you must load a GenBank file in the Create SCF tool to create SCF files. 
Loading sample traces is optional.

• If you do not load sample traces, then the output is one forward and one reverse trace for 
the first 2500 of the loaded GenBank file, or all the bases if the GenBank file contains less 
than 2500 bases. Each peak is 3000 RFU.

• If you load sample traces, and no match between the sample traces and the GenBank file 
is found, then a trace file is created for the first 2500 bases of the loaded GenBank file, or 
all the bases if the GenBank file contains less than 2500 bases. Each peak is 3000 RFU.

• If you load sample traces and a match between the sample traces and the GenBank file is 
found, then the trace option that is selected—Synthetic or Pseudo—determines the 
characteristics of the trace that is created.

• If Synthetic is selected, then the resulting SCF file has a peak profile similar to that 
of the synthetic reference traces that Mutation Surveyor creates. The height of all four 
peaks at a given location are summed together and the base call and color is that of 
the nucleotide in the GenBank sequence at the given position.

Figure 9-15:  Actual trace compared to a synthetic trace
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• If Pseudo is selected, then the resulting SCF file has a peak profile similar to that of 
the original matched trace with one exception—positions where the base call differs 
between the loaded trace and the GenBank file are given the base call and color of the 
GenBank file. For example, in Figure 9-16, note how the actual 179N was replaced 
with a pseudo 160C.

Figure 9-16:  Actual trace compared to pseudo trace

To use the Create SCF tool

1. On the Mutation Surveyor main menu, click Tools > Create SCF.

The Create SCF File window opens.

Figure 9-17:  Create SCF File window
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2. Leave the default selection of Synthetic as is, or click Pseudo.

3. In the *.SEQ/GBK files (upper) pane, click Add to open the Open Files dialog box, and 
select the .seq or GBK files that are to be used for creating the trace.

4. If you selected Synthetic, then continue to Step 6; otherwise, continue to Step 5.

5. In the *.SCF/AB1/ABI Files (lower) pane, click Add, and then click Add Files or Add 
Directory to select the samples files that are to be used for creating the pseudo trace.

6. Click the Browse button  to open the Save As file dialog box in which you can 
specify a name and location for the saved trace file. 

• Forward and reverse synthetic trace files are saved as *_F_synthesis.scf and as 
*_R_synthesis.scf, respectively.

• Forward and reverse pseudo trace files are saved as *_F_pseudo.scf and as 
*_R_pseudo.scf, respectively.

If you are adding files, CTRL-click to select multiple non-contiguous files. 
SHIFT-click to select multiple contiguous files. If you are adding a directory, then 
all the files in the directory are added in a single step.
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Convert to SCF tool
You use the Convert to SCF tool to convert an .abi/.ab1 file to an .scf file, which is a smaller 
file format. You can also use the Convert to SCF tool to convert a .fasta file to a .scf file; 
however, only the first 1200 bases in the .fasta file are converted.

To use the Convert to SCF tool

1. On the Mutation Surveyor main menu, click Tools > Convert to SCF.

The Convert to SCF File window opens.

Figure 9-18:  Convert to SCF File window

2. The Open Files dialog box opens.

Select the files that are to be converted, and then click Open to add the files to the 
Convert to SCF tool.

3. In the Output Directory field, leave the default location and name for the .scf file as is, or 

click the Browse button  to open the Browse for Folder dialog box in which you can 

select a different location for saving the .scf file.

4. Click Save.
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Extract SGP Tool
You use the Extract SGP Tool to extract GenBank files, sample files, and trace files from an 
SGP file. The sample traces are not extracted as the originally loaded .abi/.ab1 files. Instead, 
they are extracted as .scf files, which is the portion of the originally loaded files that was 
used for analysis in the project. The reference trace is extracted whether it was a loaded trace 
or a generated trace. The project settings and any comments added to the project are not 
extracted.

To use the Extract SGP tool

1. On the Mutation Surveyor main menu, click Tools > Extract SGP.

The Extract SGP window opens.

Figure 9-19:  Extract SGP window

2. In the Input pane, click the Browse button  to open the Open Mutation Project dialog 

box and select the mutation project files that are to be extracted.

3. In the Output pane, leave the default location and name for the extracted files as is, or 

click the Browse button  to open the Browse for Folder dialog box in which you can 

select a different location for saving the extracted files.

4. Click OK.

     

If you close, and then reopen Mutation Surveyor, the Extract SGP tool 
“remembers” the last settings that specified for it. 
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Section 3
Assembly Tools

Section Contents

• SGP Comparison Tool on page 289

• Mutation Assembly Tool on page 294

• Sequence Assembly Tool on page 297
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SGP Comparison Tool
You use the SGP Comparison tool to assembly multiple Mutation Surveyor projects and 
compare and contrast these projects. The SGP files to which other SGP files are being 
compared are the control files, or the standard. The SGP files that are being compared are 
the unknown files, or the sample. The report that is produced by the SGP Comparison tool is 
color-coded to assist in the identification of inconsistent mutations between the standard files 
and the unknown files. You can also use the report to compare multiple tissues, such as 
normal and tumor samples, when the samples are in same project or multiple projects and to 
identify the differences between analysts' reviews. The report is also ideal for auditing 
purposes.

To use the SGP Comparison tool

1. On the Mutation Surveyor main menu, click Tools > SGP Comparison tool.

The SGP Comparison window opens.

Figure 9-20:  SGP Comparison window

     

Before you use the SGP Comparison tool, you might need to correctly group the 
SGP files that are being compared. See “ND Filename Match Editor Tool” on 
page 274.

If a project is already loaded in Mutation Surveyor when you open the SGP 
Comparison tool, then this project is automatically loaded into the tool. 
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2. On the SGP Comparison window toolbar, click the Add SGP Files button .

The Open SGP Files dialog box opens.

Figure 9-21:  Open SGP Files dialog box

3. Click Add to open the Open Files dialog box opens, select the SGP files that are to be 
compared, and then click OK.

The Open Files dialog box closes. The SGP files are added and displayed in the 
Mutation Surveyor main window.

4. On the Mutation Surveyor main menu, click Tools > SGP Comparison to bring the SGP 
Comparison window to the front.

All the sample files in each of the SGP files are grouped together. The separate SGP 
projects are highlighted in different colors.

Figure 9-22:  SGP Comparison window with loaded SGP files
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5. To correctly group the sample files, click the Group Sample Files icon .

The Sample Grouping dialog box opens.

Figure 9-23:  Sample Grouping dialog box

6. Specify the filename substring by which Mutation Surveyor is to group all the samples 
files within a mutation project, and then click OK.

• n-Primer (n-D) Text Input—Use the ND Grouping file to group the sample files. See 
“ND Filename Match Editor Tool” on page 274.

• Filename Match (based on one of the following):

• From Character [ ] To Character [ ]—If all the filenames in your project contain 
the same characters/designator in the same positions, then select this option and 
enter the starting and ending character positions.

• Typical Block—If all the filenames in your project contain the same characters/
designator but in different positions, then select this option and enter the value 
for the character/designator block.

The display in the SGP Comparison window is refreshed to reflect the groupings.

7. Click the Select Standard icon .

The Select Standard dialog box opens.

Figure 9-24:  Select Standard dialog box
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8. Select either an entire mutation project as the standard (the default option), or click 
Select standard from sample files and in the Typical Block field, enter a character string 
that is contained in the names of all the sample files that you want to use as a standard.

9. Click OK to close the Select standard dialog box and return to the SGP Comparison 
window.

10. Click the SGP Comparison icon .

The SGP Comparison report opens. By default, this report shows all the mutations in all 
the SGP projects. The mutations are color-coded for identification. 

Figure 9-25:  SGP Comparison report

The report is interactive:

• To open the Color Code dialog box and view the color legend that is used in the report, 
click Color Code.

• To freeze the Sample File column while scrolling, leave Lock sample File in View 
selected.

• To view only those mutations that are inconsistent between the standard and the unknown 
files, click Display Inconsistent Mutations Only.

• To save the entire report as a text file, click the Save Report icon  to open the Save 
As dialog box in which you can specify a name and location for saving the .txt file.

• To export only the sample files that contain inconsistent mutations as .scf files, click the 
Export Sample Files with Inconsistent Mutations icon  to open the Browse for Folder 
dialog box in which you can specify a location to which to export the files. 

• To copy selected text in a cell to your clipboard, right-click and select Copy. To copy text 
in a range of cells, click and hold the left mouse button and drag the mouse to select the 

Click Color Code link to open the Color Code dialog box which details the color 
coding legend used in the report.
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region that you want to copy. Use standard keyboard commands or menu commands to 
paste the copied text into an application.

• To copy the SGP Comparison report as an image, press and hold the [Shift] key and the 
[Ctrl] key and then click and hold the left mouse button and draw a box around the region 
of the image that you want to copy. The selected region is filled with black. Right-click 
and select Copy to copy the image to your clipboard. Use standard keyboard commands 
or menu commands to paste the copied image into an application.
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Mutation Assembly Tool
The Mutation Assembly Tool is especially useful for cDNA projects. You can use the tool to 
upload mutation project files and identify mutations in the files using cDNA nomenclature. 
Also, you can use the Sample Grouping options to create a consensus of all mutation calls 
within a single row or column for a group of sample traces. This approach is useful for 
merging the results of several patients that were run over multiple projects.

To use the Mutation Assembly tool

1. On the Mutation Surveyor main menu, click Tools > Mutation Assembly.

The Mutation Assembly window opens.

Figure 9-26:  Mutation Assembly window

2. Click Add to open the Open Files dialog box and select the SGP files that are to be 
assembled.
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3. In the Sample Grouping pane, specify the filename substring by which Mutation 
Surveyor is to group all the samples files within the selected mutation projects, and then 
click OK.

• n-Primer (n-D) Text Input—Use the ND Grouping file to group the sample files. See 
“ND Filename Match Editor Tool” on page 274.

• Filename Match (based on one of the following):

• From Character [ ] To Character [ ]—If all the filenames in your project contain 
the same characters/designator in the same positions, then select this option and 
enter the starting and ending character positions.

• Typical Block—If all the filenames in your project contain the same characters/
designator but in different positions, then select this option and enter the value 
for the character/designator block.

4. Click OK.

The Mutation Assembly report opens. This report lists all the identified mutations in the 
loaded mutation project files using cDNA nomenclature.

Figure 9-27:  Mutation Assembly report

     

If you close, and then reopen Mutation Surveyor, the Mutation Assembly tool 
“remembers” the last settings that specified for it. 
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The report is interactive:

• To save the entire report as a text file, click the Save Report icon  to open the Save 
As dialog box in which you can specify a name and location for saving the .txt file.

• To change the information that is displayed in the report, click the Report Settings button 
 to open the Mutation Assembly Report Settings dialog box which contains options 

for filtering the information that is to be displayed in the report.

Figure 9-28:  Mutation Assembly Report Settings dialog box

Option Description

Display • Display Mutations in Rows—Mutations displayed as a matrix of 
samples versus reported mutations.

• Display Mutations in Columns—Mutations displayed as a matrix of 
reported mutations versus samples.

Mutation Parameters • Display Nucleotide Only—Display only the base number and the 
bases involved in the mutation in the mutation code.

• Display Nucleotide and Amino Acid—Display the base number, the 
bases involved in the mutation, and the amino acids (the normal 
amino acid that is affected by the mutation and the resulting amino 
acid) in the mutation code.

• Intelligent Output—The default selection. Shows nomenclature 
“Relative to CDS” when the mutation call is outside of the CDS and 
only the resultant amino acids when the mutation call is within the 
CDS.

Number Base Relative to cDNA—Selected by default. The base number that is used in the mutation 
code is numbered relative to the cDNA region, where the beginning base for the region is Base #1, 
the second base in the region is Base #2, and so on. Clear this option to use the genomic base 
position for the base number in the mutation code.
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Sequence Assembly Tool
You use the Sequence Assembly to carry out de novo assembly of overlapping contigs and 
then save the assembled information as a .seq file. You can then use this .seq file as a 
GenBank file in a Mutation Surveyor project.

To use the Sequence Assembly tool

1. On the Mutation Surveyor main menu, click Tools > Sequence Assembly.

The Sequence Assembly window opens.

Figure 9-29:  Sequence Assembly window

2. Click Add to open the Open Files dialog box and select the files that are to be used for 
the assembly. (The files can be .scf or .abi/.ab1 files.)

3. In the Output Seq File field, leave the default location and name for the .seq file as is, or 

click the Browse button  next to the field to open the Save As dialog box in which 

you can specify a name and location for saving the .seq file.
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4. Click Save.

The SEQ file is saved as one long unbroken string of nucleotides (.fasta format) in a 
single file.

Figure 9-30:  Saved SEQ file

5. Load this file into the SEQ File Editor (see “SEQ File Editor Tool” on page 257) and 
save the file using the editor.

By loading and saving the SEQ file in the SEQ File Editor, the file is saved in a format in 
a GenBank format, so, you can now use the file directly in Mutation Surveyor, or you 
can first annotate the file to identify CDSs, variations, and so on before use.
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Other Tools

Section Contents

• Mask Vector Sequence Tool on page 301

• Output Trace Data Tool on page 303

• BasePatch Tool on page 305

• The HLA Tool on page 307
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Mask Vector Sequence Tool
You use the Mask Vector Sequence tool to physically modify sample files and replace base 
calls in the vector sequence region with N calls. These N calls are displayed as such in the 
GAD. Two files are created with this tool— one file with the masked vector and one file with 
the vector unmasked and the remainder.

To use the Mask Vector Sequence tool

1. Use the SEQ File Editor tool to create a .seq file that depicts the vector sequence. (See 
“SEQ File Editor Tool” on page 257.)

2. On the Mutation Surveyor main menu, click Tools > Mask Vector Sequence.

The Mask Vector Sequence window opens.

Figure 9-31:  Mask Vector Sequence window

3. Click Add in the Vector Sequence File pane to open the Open File dialog box and select 
the vector sequence file that you created in Step 1.

4. Click Add in the Trace Files in the pane to open the Open File dialog box and select the 
trace (sample) files that are to be modified.

You can use the Mask Vector Sequence tool to replace base calls in the vector 
sequence region, or you select the Vector Trim option on the Mutation Surveyor 
Project Settings dialog box (see “Contig tab” on page 59) and trim the sample 
sequence according to a starting vector sequence and an ending vector sequence 
that you define using the SEQ File Editor tool. (See “SEQ File Editor Tool” on 
page 257.) 
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5. In the Output Directory field, leave the default location and name for the .seq file as is, 

or click the Browse button  to open the Browse for Folder dialog box in which you 

can select a different location for saving the sample files.

6. Click OK.

7. Open a new Mutation Surveyor project. Use the .seq file that you created in Step 1 as the 
GenBank file and use the files that you saved in Step 5 as the sample files.
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Output Trace Data Tool
You use the Output Trace Data tool to export information about selected traces such as frame 
number, base position and peak intensities to a tab-delimited text file. You can export 
information either by peak position or by frame. 

To use the Output Trace Data tool

1. Open a Mutation Surveyor project.

2. On the Mutation Surveyor main menu, click Tools > Output Trace Data.

The Output Trace Data window opens. This window lists all the sample traces for the 
Mutation Surveyor project, and by default, all the traces are selected for export.

Figure 9-32:  Output Trace Data window

3. You can leave all sample traces selected, or you can clear the selections for the traces for 
which you do not want to export information. 

4. Select the way by which you want to export the data (Peak Position or Frame-by-Frame) 
and then clear the selections for the information that you do not want to export for each 
peak or each frame.

Click Select All to select all sample traces in a single step. Click Clear All to clear 
current selections in a single step.

By default, all information for a data type is selected for exporting. For 
information about Signal Factor intensity and Signal Factor Dev for Peak 
Position, see “Signal Factor Intensity and Signal Factor Dev” on page 304.
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5. In the Output Directory field, leave the default location and name for the text file as is, or 

click the Browse button  to open the Browse for Folder dialog box in which you can 

select a different location for saving the text file.

6. Click Export.

The selected information is exported to a tab-delimited text file.

Figure 9-33:  Output Trace Data text file

Signal Factor Intensity and Signal Factor Dev

Each base call is derived from a peak of one dye color. Secondary peaks of other dye colors 
might be located under this major peak. For example, if the base call for nucleotide position 
100 is A:

• Signal Factor Intensity = HeightA/(HeightA + HeightT + HeightC +HeightG)

• Signal Factor Deviation = DevA/(DevA + DevT + DevC + DevG), where: 

• Dev(i) = 2.0*Height(i) - Height(iL) - Height(iR) and: 

• Height(iL) is the peak height 4 bases to the left, or before, position 100: 
100 - 4 = nucleotide position 96 for each peak height.

• Height(iR) is the peak height 4 bases to the right, or after, position 100: 
100 + 4 = nucleotide position 104 for each peak height.
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BasePatch Tool
You use the BasePatch Tool to narrow and sharpen broad peaks in previously run sample 
traces to make the peaks more discernible in the traces, and therefore, make it easier to 
identify variants in the traces. You can reprocess any type of sample trace file (AB1/ABI, 
SCF) with the BasePatch tool. 

To use the BatchPatch tool

1. On the Mutation Surveyor main menu, click Tools > BasePatch Tool.

The BasePatch Tool window opens.

Figure 9-34:  BasePatch Tool window

2. Click the Browse button  next to the Input field, and browse to and select the folder 

that contains the sample traces that are to be reprocessed.

By default, the Output directory is set to the same as that for the Input, and the Output 
folder is named Processed.

3. Optionally, click the Browse button  next to the Output field, and browse to and select 

a different directory and/or folder in which to save the reprocessed sample traces.

4. Leave all the Options for the BasePatch tool selected.

You would consider running the BasePatch tool on sample traces for which 
variant identification was inconclusive or difficult because of the shapes 
(broadness) of their peaks.

Option Description

Baseline Subtraction Has a minimal affect on the reprocessing because typically the Input 
sample traces already have had baseline subtraction carried out.
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5. Click OK.

The BasePatch Tool window closes. The sample traces are reprocessed. You can now run 
these sample files in a Mutation Surveyor project to analyze the variants again. See 
“Setting up a Single Mutation Surveyor Project” on page 74.

Peak Sharpening Applies the Mexican Hat Wavelet algorithm to narrow and sharpen the 
peaks in the sample traces. Leave the associated Peak Sharpening values 
(HalfPeak Width and Power) set to their default values.

Note: For information about the algorithm and the Peak Sharpening 
values, contact tech_support@softgenetics.com for assistance.

IUPAC Base Calls After reprocessing, the nucleotides in the sample traces are called again.

Option Description
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The HLA Tool
You use the HLA Tool to analyze Human Leukocyte Antigen (HLA) data. 
The output includes a .dat file that can be loaded into NextGENe for 
additional analysis.

To use the HLA tool

1. On the Mutation Surveyor main menu, click Tools > HLA.

The HLA Tool dialog box opens.

Figure 9-35:  HLA Tool dialog box

2. In the Samples pane, click Add to open the Open Sample File dialog box, 
and browse to and select the data files for analysis.

3. In the GenBank Sequence File pane, click Add to open the Open Seq/Gbk 
files dialog box, and browse to and select the reference GenBank file for 
HLA genes.

4. In the Output field, you can leave the default value for the location of the 
output files as-is (the default value is the directory path for the input 
files), or you can click Set to select a different location.

5. Click OK.

After processing, the Mutation report is automatically displayed in the 
Viewing and Reporting pane of the Mutation Surveyor main window. The 
output includes a .dat file that can be loaded into NextGENe for 
additional analysis.

You can load multiple reference GenBank files for HLA genes.
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Reference Management Tools

Section Contents

• The Mutation Surveyor Track Manager Tool on page 310

• The Import Reference Tool on page 321
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The Mutation Surveyor Track Manager Tool
You can import data from any public or proprietary variant database into Mutation Surveyor. 
The imported data is referred to as a track in Mutation Surveyor. You use the Mutation 
Surveyor Track Manager tool to import data from a database. You can import PolyPhen-2 
scores, SIFT scores, Mutation Taster scores, LRT scores, PhyloP Conservation scores, and 
1000 Genomes frequencies from the dbNSFP database. You can import coding and 
non-coding variant information from the COSMIC database. You can import variant 
information with clinical significance values from the ClinVar database. You can also use the 
Track Manager to import custom databases into Mutation Surveyor and to load track data for 
previously run projects that contain chromosome information.

To use the Mutation Surveyor Track Manager tool to import data

1. On the Mutation Surveyor main menu, click Tools > Track Manager.

The Track Manager window opens. This window lists the following information:

• The directory that you selected for preloaded references.

• The preloaded reference files that you have previously imported.

• Any databases that you have previously imported. The Default Query status 
indicates whether the track, by default, is queried for all projects for the selected 
reference. 

Figure 9-36:  Track Manager window
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2. Do the following:

• Verify that the Reference Directory for preloaded reference files is correct; 
otherwise, click Set to open the Browse to Folder dialog box, and then browse to and 
select the correct directory.

• On the Genome Build list, select the correct preloaded reference file.

3. Optionally, do any or all of the following as needed:

• To edit the Default Query status for a track, right-click the track, and on the context 
menu that opens, click Default Query, and then click Yes or No as appropriate.

• To edit a track, continue to “To edit a track” below.

• To import data from the dbNSFP database for the selected reference, continue to “To 
import data from the dbNSFP database” on page 314.

• To import data from the COSMIC database for the selected reference, continue to 
“To import data from the COSMIC database” on page 315.

• To import data from the ClinVar database for the selected reference, continue to “To 
import data from the ClinVar database or any other dbSNP files” on page 316.

• To import data from other custom variation databases, continue to “To import data 
from other variation databases” on page 317.

• To load track data for previously run projects that contain chromosome information, 
continue to “To load track data for previously run projects” on page 319.

To edit a track

To edit a track, you must load one or more files that specify the records that are to be 
included for reporting purposes and/or files that specify the records that are to be excluded. 
You can also edit the column property settings for the imported track. You must load the files 
from the database that you are editing. For example, if you are editing records from the 
COSMIC database, then you must load COSMIC database files.

1. Right-click on the track that you are editing, and then on the context menu that opens, 
click Edit.

The Edit Track wizard opens. See Figure 9-37 on page 312.
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Figure 9-37:  Edit Track wizard

2. Click Include/Exclude Files.

The Include/Exclude Files page opens.

Figure 9-38:  Include/Exclude Files page
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3. Do one or both of the following:

• For the Include pane, click Load, and then browse to and select the files that define 
the records that are to be included for reporting purposes.

• For the Exclude pane, click Load, and then browse to and select the files that define 
the recorded that are to be excluded for reporting purposes.

4. Click Next.

The Column Properties Settings page opens.

Figure 9-39:  Column Properties Settings page

5. Optionally, select a field (CTRL-click to select multiple fields), and then do one or both 
of the following as needed:

• Select a different identifier on the dropdown list on the right side of the dialog box.

• Select a different field data type (String, Integer, or Data).

Setting Description

Skip Ignore the information in the field.

Display Only View the information in the Mutation report.

Display and Filtering View the information and filter based on the information in the Mutation 
report.

Chr The chromosome number.

ChrPos The chromosome position.

Chr&Pos The chromosome number and position concatenated, for example: 
1:69523.

Mutation Call Mutation call at the indicated position.

WT_SEQ The wild type sequence.

MUT_SEQ The mutant sequence.
Mutation Surveyor User’s Manual 313



Chapter 9
Mutation Surveyor Tools
6. Click Next.

The imported files are processed, and then an Import Completed message opens.

7. Click OK to close the message and return to the Edit Track wizard.

8. Click OK to close the Edit Track wizard and return to the Track Manager window.

9. Click OK to close the Track Manager window.

To import data from the dbNSFP database

1. Click Import dbNSFP.

The Import dbNSFP dialog box opens. 

Figure 9-40:  Import dbNSFP dialog box

2. Click Open dbNSFP website.

A dbNSFP website page that has options for downloading different versions of the 
database opens. 

3. Download the appropriate version of the database for your work.

4. Click Add to browse to and select the downloaded files.

5. In the Name field, enter the name or version number for the downloaded database.

6. Click OK.

The Import dbNSFP dialog box closes. NextGENe can now automatically query the 
dbNSFP database for alignments to the whole human genome reference and to the NC 
and NT accession GenBank files. 

Optionally, click About to open a dialog box that provides a link to an article that 
details the dbNSFP database.

To load dbNSFP information for previously run projects, continue to “To load 
track data for previously run projects” on page 319.
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To import data from the COSMIC database

1. Click Import COSMIC.

The Import COSMIC dialog box opens.

Figure 9-41:  Import COSMIC dialog box

2. To download the COSMIC database for coding or non-coding variants, click Open FTP 
Folder for Download.

The Sanger COSMIC FTP site opens. This site contains all the COSMIC database files 
that are available for downloading.

3. Do one or both of the following:

• To download coding variant data, select the appropriate 
CosmicCodingMuts_vXX_DDMMYYYY_noLimit.vcf.gz file.

• To download non-coding variant data, select the appropriate 
CosmicNonCodingMuts_vXX_DDMMYYYY_noLimit.vcf.gz file.

4. Click Load File and select the files to load.

     

Optionally, you can click Guidelines on Use of COSMIC data to go to a web page 
provided by Sanger with guidelines and information about the public use of 
COSMIC data.

In either case, the exact file name changes with new versions of the database. At 
the prompt to Open or Save the file, click Save to save the file to a location of your 
choice.

Both the coding and non-coding files can be loaded at the same time.
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5. In the Name field, enter the name or version number for the downloaded files.

6. Click OK.

The Import COSMIC dialog box closes. Mutation Surveyor can now automatically 
query the COSMIC database files for alignments to the whole human genome reference 
and to the NC and NT accession GenBank files. 

To import data from the ClinVar database or any other dbSNP files

You can import data from a ClinVar database, or any other dbSNP files that are available 
from NCBI. When you import a ClinVar database, the clinical significance value for each 
variant is also automatically imported.

1. Click Import ClinVar/dbSNP.

The Import Clinvar/dbSNP dialog box opens.

Figure 9-42:  Import ClinVar/dbSNP dialog box

2. Choose the appropriate group—ClinVar or dbSNP for any other dbSNP database.

3. Click Open FTP Folder to Download VCF.

The NCBI FTP site opens. This site contains all the ClinVar or dbSNP database files that 
are available for downloading.

4. Download the appropriate version of the database.

5. Click Add to browse to and select the downloaded files.

6. In the Name field, enter the name or version number for the downloaded database.

If you loaded two files with different version numbers, you can label to indicate 
this, for example, v58-v57.

To load COSMIC tags for previously run projects, continue “To load track data 
for previously run projects” on page 319.
316 Mutation Surveyor User’s Manual



Chapter 9
Mutation Surveyor Tools
7. Click OK.

The Import ClinVar/dbSNP dialog box closes.

To import data from other variation databases

If you download data from variation databases other than dbNSFP, COSMIC, or ClinVar, 
you can also import this data into Mutation Surveyor.

1. Click Import Variation Tracks.

The first page for the Import Variation Tracks wizard opens.

Figure 9-43:  Import Variation Tracks wizard

2. Click Add to browse to and select the downloaded files.

3. In the Name field, enter the name or version number for the downloaded database.

4. Click Next.

The Column Properties Settings page opens. This page lists all the different fields in the 
imported files, the information that is contained in each field, and the field data type 
(String, Integer, or Data.) You can use this information that is displayed on this page to 
verify that Mutation Surveyor is correctly identifying and reading the information in the 
fields. When the page first opens, by default, the information is sorted alphabetically by 
Track Title. You can click the column header for Track Title, Status, or Numeric to 
change the sort order. See Figure 9-44 on page 318.

To load ClinVar or other dbSNP information for previously run projects, continue 
to “To load track data for previously run projects” below.
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Figure 9-44:  Import Variation Tracks wizard, Column Properties Settings page

You can select a field (CTRL-click to select multiple fields), and then you can select a 
different identifier for the field on the dropdown list on the right side of the page, or you 
can select the appropriate field data type (String, Integer, or Data). You can also use the 
dropdown list to choose which fields to use for display, for display and filtering, and 
which fields can be skipped for import.

5. Click Next.

The selected database files are imported into Mutation Surveyor. The Import Variation 
Tracks wizard closes. You return to the first page of the Import Variation Tracks wizard. 
The dialog box displays the imported database files, or tracks.

6. Click OK.

The Import Variation Tracks wizard closes. 

Setting Description

Skip Ignore the information in the field.

Display Only View the information in the Mutation report.

Display and Filtering View the information and filter based on the information in the Mutation 
report.

Chr The chromosome number.

ChrPos The chromosome position.

Chr&Pos The chromosome number and position concatenated, for example: 
1:69523.

Mutation Call Mutation call at the indicated position.

WT_SEQ The wild type sequence.

MUT_SEQ The mutant sequence.

To load variation information for previously run projects, continue to “To load 
track data for previously run projects” on page 319.
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To load track data for previously run projects

1. Open the project in Mutation Surveyor that contains a GenBank reference with 
chromosome coordinates.

2. On the Mutation Surveyor main menu, click Process > Query Reference Tracks.

The Query Reference Tracks dialog box opens. The dialog box lists all the tracks that are 
available for the project reference. By default, all the tracks are selected.

Figure 9-45:  Query Reference Tracks dialog box

3. Verify that the correct directory is displayed for the Reference Root Directory.

The project must contain a GenBank reference that has chromosome coordinates.

The Query Reference Track function was originally designed for NextGENe, and 
was brought over “as-is” into Mutation Surveyor. Even if NextGENe is not 
installed on the same client as Mutation Surveyor, the Reference Root Directory is 
automatically created and set to the default location for the Reference Root 
Directory in NextGENe, and you cannot change it. If NextGENe is installed on the 
same client, then the directory is specified in the Process Options for NextGENe. 
To change the directory, you must edit the Process Options for NextGENe. See the 
NextGENe User Manual for detailed information.
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4. Select the appropriate whole genome build.

5. Leave all the available tracks selected, or clear the selections for the tracks that you do 
not want to query for the project.

6. Optionally, if the track that is to be queried for the project is not available, then click Run 
Track Manager to open the Track Manager tool and import the database. See “The 
Mutation Surveyor Track Manager Tool” on page 310.

7. Click OK.

The Query Reference Tracks dialog box closes. The track information for the project is 
modified accordingly. If new tracks have been added to the project, then the tracks are 
loaded and the information from the tracks can be displayed in the Mutation table in the 
GAD. 

See “Variation Tracks Settings dialog box” on page 91.
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The Import Reference Tool
If you intend to import external annotation databases into Mutation Surveyor or if you want 
to use the Knowledge Database, then you must import the appropriate genome reference. For 
access to a needed reference file, you have two choices:

• You can download preloaded reference files through SoftGenetics’s ftp server, and then 
import the downloaded reference files into Mutation Surveyor. 

• You can import a preloaded reference file into Mutation Surveyor from a DVD that 
SoftGenetics can send to you upon request. 

To download and/or import preloaded reference files

1. Click Import Reference.

The NextGENe Reference Setup Wizard opens. See Figure 9-46 on page 322.

See http://www.softgenetics.com/NextGENe_011.html for a list of preloaded 
reference files that are available upon request on a DVD.

You cannot import and use preloaded reference files if you have not installed 
MySQL. If you did not install MySQL when you installed Mutation Surveyor, then 
you can also use the NextGENe Reference Setup Wizard to do so. 

If the genome you are interested in aligning to is not available on SoftGenetics’s 
ftp site, or on a DVD, you can contact SoftGenetics and request a custom genome.

The Import References tool was originally designed for NextGENe, and was 
brought over “as-is” into Mutation Surveyor. As a result, even if you do not have 
NextGENe installed on the same client as Mutation Surveyor, the tool is still 
labeled with “NextGENe” and not “Mutation Surveyor.”
Mutation Surveyor User’s Manual 321

http://www.softgenetics.com/NextGENe_011.html


Chapter 9
Mutation Surveyor Tools
Figure 9-46:  NextGENe Reference Setup Wizard

2. Click Next.

The Reference Selection page opens. If you have inserted a DVD into the client 
DVD/CD drive, the reference file that is on the DVD is listed in the References on DVD 
pane. Also, when the Reference Setup wizard first opens, regardless if NextGENe is 
installed on the same client as Mutation Surveyor, the default installation directory for 
the reference files is automatically created and set to the NextGENe default reference 
directory. 

C:\Program Files (x86)\SoftGenetics\NextGENe\References

Figure 9-47:  NextGENe Reference Setup Wizard, Reference Selection page

3. Optionally, click Browse to open the Browse for Folder dialog box, and then browse to 
and select a different installation folder.
322 Mutation Surveyor User’s Manual



Chapter 9
Mutation Surveyor Tools
4. If you are downloading a preloaded reference file from SoftGenetics’s ftp site, continue 
to Step 5; otherwise, if you are importing a preloaded reference file from a DVD, 
continue to Step 6.

5. To view all the available reference genomes on SoftGenetics’s ftp server, click List.

The References on FTP pane is populated with a list of all the available reference 
genomes.

6. Select the reference file that is to be imported, or CTRL-click to select multiple 
non-continuous reference files, or SHIFT-click to select multiple continuous reference 
files.

7. Continue to “To confirm that MySQL is installed” below.

To confirm that MySQL is installed

1. Click Next.

The MySQL Settings page opens. If MySQL has been installed correctly, and the 
connection to the database is successful, then “MySQL installed” and “MySQL 
connection successful. Ready to Import” are displayed on the page, and you can continue 
to Step 3; otherwise, if either or both of these messages are not displayed, then continue 
to Step 2.

Figure 9-48:  NextGENe Reference Setup Wizard, MySQL Settings page

2. Do one or both of the following:

• If “MySQL installed” is not displayed on the page, then click Install MySQL. 

If the genome that you want to import is not available, you can contact 
SoftGenetics and request a custom genome.
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If MySQL cannot be installed successfully, contact tech_support@softgenetics.com.

• If “MySQL installed” is displayed, but “MySQL connection successful. Ready to 
Import” is not displayed, then click Check Connection. 

If the message MySQL Connection Successful is displayed, then continue to Step 3; 
otherwise, contact tech_support@softgenetics.com.

3. Click Install.

The Installing page opens. The page shows the status of downloading each referenced 
index file. 

Figure 9-49:  NextGENe Reference Setup Wizard, Installing page

After all the selected preloaded reference files have been successfully downloaded and 
imported into Mutation Surveyor, the Installing page is updated with an Installation 
complete message. See Figure 9-50 on page 324.

Figure 9-50:  NextGENe Reference Setup Wizard, Installing page
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4. Click Close.

The NextGENe Reference Setup Wizard remains open. The preloaded reference files are 
now available for use in Mutation Surveyor.

5. Repeat both “To download and/or import preloaded reference files” on page 321 and “To 
confirm that MySQL is installed” on page 323 as many times as needed to download and 
import all your required preloaded reference files.

6. After you have downloaded and imported all your needed preloaded reference files, click 
Cancel to close the NextGENe Reference Setup Wizard and continue with your work in 
Mutation Surveyor.

If you encounter any problems during the downloading and importing of the 
selected reference files, contact tech_support@softgenetics.com.
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Chapter 10
Mutation Surveyor Specialized 
Applications

In addition to the specific functions for which Mutation Surveyor is designed, you can use 
Mutation Surveyor for some specialized applications. 

This chapter covers the following topics:

• “Methylation Detection” on page 329.

• “Mutation Quantifier Function” on page 331.
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Methylation Detection
A variety of options are available for analyzing methylated DNA. Mutation Surveyor is 
designed specifically for analyzing methylated DNA that has undergone bisulfite treatment. 
When you use Mutation Surveyor to analyze methylated DNA that has undergone bisulfite 
treatment, the following caveats apply:

• You must use a GenBank SEQ file as the reference file.

• You must use the SEQ File Editor tool to convert the reverse complement sequence for 
the GenBank file to the forward strand orientation and then save the file as a reverse 
complement. See “SEQ File Editor Tool” on page 257.

• You must select Methylation on the Others tab on the Mutation Surveyor Project Settings 
dialog box and you must specify whether the method of detection is to be 
Automethylation or Set by User. See “Others tab” on page 70.

Bisulfite treatment of single-stranded DNA followed by PCR converts unmethylated 
cytosines that are outside of CpG islands to uracil. Unmethylated cytosines that are in CpG 
islands are also converted to uracil. Methylated cytosines are not converted. When 
evaluating bisulfite-treated DNA, Mutation Surveyor reads the cytosines that have been 
converted to uracils as thymines and methylated cytosines simply as cytosines. 

Figure 10-1:  Bisulfite treatment and PCR of methylated DNA

Because unmethylated sample positions in the comparison region are read as thymine, these 
sample positions align to the reference file and Mutation Surveyor does not call mutations at 
these positions. Mutation Surveyor instead calls mutations in the comparison region only at 
positions where there is partial or complete methylation.

Typically, Automethylation is the preferred option. When this option is selected, 
Mutation Surveyor optimizes the conditions for methylation detection which 
minimizes the number of mutations that are detected. By minimizing the number of 
detections, the analysis is simplified but its accuracy is maintained.
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Figure 10-2 is an example of a GAD for a methylation detection analysis. The top pane is the 
reference trace that was synthesized from the derivative GenBank file. The horizontal blue 
lines indicates positions where the reference file was originally a cytosine. The middle pane 
is the sample trace. The bottom pane is the mutation detection trace.

Figure 10-2:  GAD for methylation detection

How Mutation Surveyor calls mutations for methylated DNA assumes 100% 
conversion of the unmethylated cytosines to uracil during bisulfite treatment. To 
visually evaluate and confirm this assumption, a Methylation report is available. 
See “Methylation report” on page 205.
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Mutation Quantifier Function
The Mutation Quantifier function quantifies the allele ratios (normal allele and mutant allele) 
of Sanger sequencing traces at specific locations in the genome. You can use software 
determined standards or set your own standards for calculating the mutant peak percentage 
according to the following formula: 

100 x [Mutant peak intensity/(Mutant peak intensity + Normal peak intensity)]

To run the Mutation Quantifier function

1. After running a Mutation Surveyor project, open the GAD for the project.

2. On the GAD toolbar, click the Mutation Quantifier button .

The Mutation Quantifier dialog box opens. This dialog contains a tab for every contig in 
the Mutation Surveyor project.

Figure 10-3:  Mutation Quantifier dialog box

3. Select the method by which to run the quantification—Standardized Allele Ratio or 
Simplified Allele Ratio.

4. If you selected Standardized Allele Ratio, continue to Step 5; otherwise, continue to Step 
6.

     

The information that is displayed in the Mutation Quantifier report is completely 
different based on the method that you select. To see how two alleles vary with one 
sample trace, select Simplified Allele Ratio. To see how two alleles vary as 
compared to two Standard traces, select Standardized Allele Ratio.
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5. For each contig in the project, do the following:

• Standard 1—The Standard 1 dropdown list is a list of all the sample files contained 
in the selected contig. Standard 1 serves as one of the control files for the mutation 
quantification calculation. Ideally, the sample file should show a mutation peak 
percentage of 0%, meaning that only the normal peak is present in the sample. You 
can select a sample file from the Standard 1 dropdown list, or leave the Standard 1 
field blank to have Mutation Surveyor select the standard file.

• Standard 2—The Standard 2 dropdown list is a list of all the sample files contained 
in the selected contig. Standard 2 serves as one of the control files for the mutation 
quantification calculation. Ideally, the sample file should show a mutation peak 
percentage of 100%, meaning that the normal peak is not present in the sample. You 
can select a sample file from the Standard 2 dropdown list, or leave the Standard 2 
field blank to have Mutation Surveyor select the standard file.

6. Select the options for the quantification.

7. Click OK.

The Mutation Quantifier report window opens. The information that is displayed in the 
report and the toolbar buttons that are available depend upon the option that you selected 
in Step 3—Standardized Allele Ratio or Simplified Allele Ratio. In addition, the buttons 
that are available on the toolbar are different. See:

• “Mutation Quantifier report, Standardized Allele Ratio selected” on page 333.

• “Mutation Quantifier report, Simplified Allele Ratio selected” on page 335.

     

Ideally, the sample file should show a mutation peak percentage of 100% however, 
if necessary, you can select a heterozygous sample file that shows a mutation peak 
percentage of 50%.

Option Description

Process Mutations Select this option to quantify substitution mutation peaks.

Process 2D Small 
Peaks

Select this option to quantify 2D small peaks that have been identified 
by Mutation Surveyor. 

Note: You can select this option only if Check 2D Small Peaks 
(Mosaic) was selected for the project. See “Check 2D Small 
Peaks (Mosaic)” on page 69.

Points of Interest Select this option to enter specific loci for quantification of mutation 
peaks.
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Mutation Quantifier report, Standardized Allele Ratio selected

With Standardized Allele Ratio selected, the Mutation Quantifier report displays the percent 
decrease in intensity for the normal nucleotide peak relative and the percent increase in 
intensity for the mutant nucleotide peak for all identified mutations in the sample files. The 
report also contains a toolbar with buttons that are specific for working with the report and 
for changing the information that is displayed in the report. 

Figure 10-4:  Mutation Quantifier report, Standardized Allele Ratio selected

Column Description

Contig Contig number for the sample file and the direction of the sample file.

Sample Sample filename.

GenBank The SEQ/GBK reference file to which the sample file was compared.

Base Seq The genomic position of the mutation in the sample file.

Standard1 The sample file used for Standard 1.

Standard2 The sample file used for Standard 2.

Mutation The mutation shown as Normal Base > Mutant Base.

Note: If the mutation is heterozygous, for example, G > GA, then only 
the mutant allele (in this example, A) is displayed in the 
Mutation Quantifier report.

SC Drop Single Color Drop. Measures the drop in peak intensity at the normal 
position by normalizing the peak intensity between the reference peak 
from Standard 1 and the sample peak at the first four positions on both 
sides of the normal peak that are located greater than 1 bp away from 
the normal peak (referred to as the local area) and that have the same 
color as the mutant peak.

SC Gain Single Color Gain. Measures the increase in peak intensity at the 
mutant position by normalizing the peak intensity between the reference 
peak from Standard 2 and the sample peak at the first four positions on 
both sides of the variant that are located greater than 1 bp away from 
the mutant peak (referred to as the local area) and that have the same 
color as the mutant peak.

Note: Neighboring peaks at +/- 1 bps are not used for the measurement because their intensities 
are often affected by the mutation. Single color peaks that might contain mosaic or 
heterozygous mutations are also not used for the measurement. If such a peak is found in 
the local area, then drop or gain cannot be calculated.

Note: A question mark (?) indicates inconclusive data that was the result of poor standards or 
poor peaks in the local area, such as mosaic or heterozygous mutations.
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The report is interactive:

• To sort the report results, click any column heading.

• To view the electropherogram for a mutation compared to the electropherograms for the 
standards, double-click the mutation. The mutation is marked with a red dot in the display. 

Figure 10-5:  Display for mutation quantification, Standardized Allele Ratio selected

     

In Figure 10-5, the horizontal red bars were manually added to assist you with 
visualization. They do not normally appear in the display. For the drop in “C,” 
compare the Cs between Standard 1 and the sample. For the increase in “T,” 
compare the Ts between Standard 2 and the sample. The sample drop displays a 
“?” because the Cs in the local area of the sample peak are heterozygous, and 
reliable determination of the drop is not possible.
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Mutation Quantifier report, Simplified Allele Ratio selected

With Simplified Allele Ratio selected, the Mutation Quantifier report displays all peak 
values in RFUs rather than as percentages. The report also contains a toolbar with buttons 
that are specific for working with the report and for changing the information that is 
displayed in the report.

Figure 10-6:  Mutation Quantifier report, Simplified Allele Ratio selected

     

Column Description

Contig Contig number for the sample file and the direction of the sample file.

Sample Sample filename.

Position The genomic position of the mutation in the sample file.

Normal The normal base as reported for the reference.

Mutation The mutant base as reported in the GAD. 

Note: If the mutation is heterozygous, for example, G > GA, then only 
the mutant allele (in this example, A) is displayed in the 
Mutation Quantifier report.

Norm_Height The peak height (in RFUs) of the normal allele.

Mut_Height The peak height (in RFUs) of the mutant allele.

Norm_Neighbors Average peak height (in RFUs) for the first four base positions on both 
sides of the normal peak that are located greater than 1 bp away from 
the normal peak (referred to as the local area) and that have same color 
as the mutant peak.

Mut_Neighbor Average peak height (in RFUs) for the first four base positions on both 
sides of the mutant peak that are located greater than 1 bp away from 
the mutant peak (referred to as the local area) and that have same color 
as the mutant peak.

Norm_Percent Normal peak percentage.

Mut_Percent Mutant peak percentage.
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The report is interactive:

• To sort the report results, click any column heading other than Mut_Height, 
Norm_Neighbor, Mut_Neighbor, or Mut_Percent.

• To view the electropherogram for a mutation, double-click the mutation. The mutation is 
marked with a red dot in the display. 

Figure 10-7:  Display for mutation quantification, Simplified Allele Ratio selected

Mutation Quantifier toolbar

The Mutation Quantifier report toolbar contains buttons that are specific for working with 
the report and for changing the information that is displayed in the report.

Figure 10-8:  Mutation Quantifier report toolbar

Button Description

Quantify—Opens the Mutation Quantifier dialog box. See “To run the 
Mutation Quantifier function” on page 331.

Edit Groups—Available only when Standardized Allele Ratio is selected. 
Opens the Quantification Group Editor dialog box You can use the 
functions on this dialog box to manually select the sample files for 
Standard 1 and Standard 2 and recalculate the mutation quantification 
based on the settings (Process Mutations, and so on) that you 
previously selected in the Mutation Quantifier dialog box. See 
“Quantification Group Editor dialog box” on page 337.
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Quantification Group Editor dialog box

You can use the functions on the Quantification Group Editor dialog box to manually select 
the sample files for Standard 1 and Standard 2 and recalculate the mutation quantification 
based on the settings (Process Mutations, and so on) that you previously selected in the 
Mutation Quantifier dialog box.

Figure 10-9:  Quantification Group Editor dialog box

     

Report Settings—Available only when Standardized Allele Ratio is 
selected. Opens the Quantifier Report Settings dialog box which 
contains options for filtering the information that is to be displayed in the 
report. See “Mutation Quantifier report settings dialog box” on page 338.

Display Mutations with 1D/2D Settings—Toggles the GAD between the 
1D and 2D views.

Note: With 1D settings selected, more low confidence mutation calls 
might be included in reports.

Save Report—Opens the Save Report As dialog box in which you can 
specify a name and location for saving the report as a .txt file. 

Button Description
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1. In the Seq Index field, enter the genomic position of a known mutation in the selected 
mutation project and press [Enter].

Mutation Surveyor automatically identifies the base change and in the Samples pane, 
displays and highlights all the sample files that contain the specific mutation. Mutation 
Surveyor also automatically identifies the GenBank file to which the sample files were 
compared and selects the sample files for Standard 1 and Standard 2.

2. Do one of the following:

Mutation Quantifier report settings dialog box

The Quantifier Report Settings dialog box contains options for filtering the information that 
is to be displayed in the report.

Figure 10-10:  Quantifier report settings dialog box

If you are satisfied with Mutation Surveyor’s 
automatic selections:

1. Click Add to update the Mutation Quantifier 
table with these selections.

2. Click OK to recalculate the mutation 
quantifications based on the settings that you 
previously selected in the Mutation Quantifier 
dialog box.

If you are not satisfied with Mutation Surveyor’s 
automatic selections:

1. Make any changes as needed (for example, 
select a different sample file for Standard 1).

2. Click Update to update the Mutation 
Quantifier table with these selections.

3. Click OK to recalculate the mutation 
quantifications based on the settings that you 
previously selected in the Mutation Quantifier 
dialog box.

Option Description

Report Filter tab

Show Standards Show the sample files used for Standard 1 and Standard 2 in the report.
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Shown Sample 
Threshold

• SC Drop—Show only those samples with an SC Drop greater than or 
equal to the indicated value.

• SC Gain—Show only those samples with an SC Gain greater than or 
equal to the indicated value.

Note: A sample must meet both of the specified thresholds to be 
displayed in the report.

• For Each 2D Sample—Selected by default. The quality of the sample 
pair at the same position is checked. When the SC Drop and the SC 
Gain of both pairs is met, then both values are displayed; otherwise, 
both values are hidden.

Columns tab—Select which columns are to be displayed in the Mutation Quantifier report.

Option Description
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Mutation Surveyor also provides the capabilities for modifying existing projects, and for 
working with multiple projects. For example, you might need to merge multiple projects into 
one project for comparison purposes, or you might need to carry out batch processing of 
multiple projects.

This chapter covers the following topics:

• “Modifying Mutation Surveyor Projects” on page 343.

• “The Log File Wizard in the Mutation AutoRun Tool” on page 345.

• “The Mutation AutoRun Tool” on page 352.
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Modifying Mutation Surveyor Projects
The Modify Mutation Projects function is available on the Mutation Surveyor main menu 
(File > Modify Mutation Projects) and it is also available from a button on the Project 
Display subreport toolbar. (See “Project Display subreport toolbar” on page 117.) The 
Modify Mutation Projects function provides the capabilities for modifying single or multiple 
projects in Mutation Surveyor. For example, you can use the Modify Mutation Projects 
function for the following purposes:

• To open a single project with the GenBank file that was initially used, so that you can 
specify sample grouping options and rerun the project. 

• To select a different isoform for a single project so that you can apply the gene annotations 
relative to the new isoform to all mutation calls. This allows you to complete the analysis 
of the same project with a different isoform without needing to review your mutation calls 
a second time.

• To merge multiple projects into one project for comparison purposes and view the project 
results in a single report.

Figure 11-1:  Modifying Mutation Projects window
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Field Description

GenBank Sequence 
Files (Optional)

Use the options in this pane to load a different GenBank file than what 
was loaded for the original project. The new GenBank file must have the 
same nucleotide sequence as the original GenBank file, but it can have 
different annotations. 

SGP files Use the options in this pane to add one or more mutation projects that 
are being analyzed. Multiple projects are merged into a single project 
and the project results are contained in a single report.

Note: If you load multiple projects and the total number of samples is 
< 400, then you can view the project results in the GAD and 
generate reports for the project. If the you load multiple projects 
and the total number of samples is > 400, then you cannot view 
the project results in the GAD. You can only generate reports for 
the project.

Sample Grouping File 
(Optional)

Use the options in this pane to load a Sample Grouping file which is a 
text file that defines how your sample files should be paired in your 
Mutation Surveyor project. See “2D Filename Match Editor tool” on page 
271.
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The Log File Wizard in the Mutation AutoRun 
Tool

You use the Mutation AutoRun tool to carry out the batch analysis of multiple projects, 
where each project is referred to as a job. The tool scans for queued files at a user-set 
interval. The parameters for processing the projects are specified in a log file that you create 
using the Log File Wizard. You can create a job to process samples that have already been 
generated by your capillary electrophoresis instrument or you can create a job to process 
samples that have not yet generated by your capillary electrophoresis instrument.

To open the Log File Wizard

1. On the Mutation Surveyor main menu, click Tools > Mutation AutoRun to open the 
Mutation AutoRun window.

Figure 11-2:  Mutation AutoRun window

2. On the Mutation AutoRun menu, click Tool > Log File Wizard to open the Log File 
Wizard. The first page that opens is the Progress page. See Figure 11-3 on page 346.
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Figure 11-3:  Log File Wizard, Progress page

The Log File Wizard is a standard wizard consisting of multiple pages that are linked by 
Next and Back buttons. Each page contains instructions to guide you through the creation of 
a log file. After you complete the steps on a page, you click Next to move to the next page. 
At anytime, you can click Back as many times as needed and modify your selections for a 
previously completed step or steps. In addition to the standard Next and Back buttons, the 
Log File Wizard has page-specific links on the Progress Pane that you can double-click to 
open the indicated page. (These links are listed in the same order in which the pages open 
when you click Next.) To the right of the Progress Pane is a Jobs dropdown list of all the job 
files that are contained in a selected log file. Checkmarks are displayed next to the page links 
on the Progress Pane if the indicated information has been added for a selected job. For 
example, if report setting files have been added for a selected job, then a checkmark is 
displayed next to the Reports link.

You have two options for creating a log file to use with the Mutation AutoRun tool:

• You can set up a new log file. See “To set up a new log file” below.

• You can load a previously saved log file and modify it as needed. See “To modify a log 
file” on page 350.

To set up a new log file

1. On the Jobs dropdown list that is to the right of the Progress Pane, select New Job.

2. Click Modify.

3. At the prompt, enter the name for the new job. 
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4. Click Next.

You can now continue setting up the log file from scratch. You are prompted to enter 
files for a project in the following order—GenBank, Reference, and Sample. Sample 
files are always required for a project. GenBank files and reference files are both 
optional files for a job. You can add just a GenBank file, just a reference file, both files, 
or neither file. If you do not add either a GenBank file or a reference file, Mutation 
Surveyor connects to the GenBank database and searches for a GenBank file that has a 
sequence that matches the project’s sample files. Adding GenBank files, reference files 
or sample files, or any other type of file (for example, custom report settings files) 
involves the same general series of steps: 

5. Click the Browse button  on the Load Files page to open the Browse for Folder 

dialog box and browse to and select the folder that contains the files that are to be added 
to the job.

All the files that are in the selected folder are displayed in the Available Local Files pane. 
After you select the folder that contains the files that you want to add, the Local Path 
field is populated with the full directory path to the files. You can click Copy Path to 
copy this information to your clipboard and you can then paste it into the Local Path 
field in other windows if needed. 

6. Do one of the following to add the necessary files to the job:

• Double-click each file that you want to add.

• CTRL-click to select multiple non-contiguous files or SHIFT-click to select multiple 
contiguous files, and then click Add > Selected.

• Click Add > All to add all the files in a single step.

     

You can create a job to process samples that have not yet been generated by your 
capillary electrophoresis instrument. By specifying the path where the sample files 
are to be located followed by *.*, all files within the folder will be processed. 
Because you can configure the Mutation AutoRun function to process log files at 
different time intervals, you can set the interval to a time that occurs after the 
sample files are ready for processing. For more information about delaying the 
start of Mutation AutoRun, see the Time option detailed in “To use the Mutation 
AutoRun tool” on page 352.

When Add > All is selected, the Selected Folders/Files field contains an entry that 
includes the path to the folder followed by “*.<extension>.” This indicates that 
all contents from this folder of the appropriate file type are to be used in the 
analysis. If you add new files to this folder prior to running the job, the new files 
are also processed.
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7. After have added all the necessary files for the project, click Next. 

The Input Project Settings page opens.

Figure 11-4:  Input Project Settings page

8. Click the Browse button  page to open the Browse for Folder dialog box and browse 

to and select the folder that is to contain the processed SGP project file, and then click 
Add. Any automatically generated reports are also saved to this location. 

9. Optionally, you can also do one or more of the following:

• In the Project name field, enter a name for the project. 

• Click Advanced to open the Load Process Settings dialog box, and then click the 

Browse button  page to open the Load Project Settings dialog box and browse to 

and select the settings file (.ini) file that specifies the settings that you want to use for 
the project.

Figure 11-5:  Load Project Settings dialog box
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• Click Export Mutation Surveyor Process Settings with Project. 

10. Click OK to close the Process Settings dialog box, and then click Next.

The Input Report Information page opens.

Figure 11-6:  Input Report Information page

11. Optionally, do one or more of the following:

• If you want to generate one or more custom reports for the project, add the 
appropriate custom report settings files (.ini) to the project.

• Click Export Custom Report Settings with Project.

• Select the format (TXT or XLS) for the other reports (Two Directional, Advanced 
Two Direction, or JHU) that you want to generate for the project.

Although specifying project settings is optional, if you do not specify any settings 
for the project, then Mutation Surveyor processes all the projects in the job 
according to the settings that were last used by Mutation Surveyor. Unless you 
modify the values again, all new projects are carried out according to the options 
that you have specified. If you load an existing project, the options revert to those 
set for the project. If you run a new project after loading an existing project, the 
new project is carried out according to the existing project settings.

If you want to create a custom report for the project, but want to use the default 
settings in the MutationSurveyor_Settings.ini file, then you do not need to add any 
settings files to the project. Instead, you can simply select the format (TXT or XLS) 
for the custom report.
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12. Click Finished.

You return to the Progress Page.

13. Click Save.

The Save Log File dialog box opens.

14. Specify a name and location for the job’s log file.

To modify a log file

When you modify a log file, you can modify the information for an existing job in the log 
file, you can add a new job to the log file, and you can remove a job from the log file.

1. On the Log File Wizard main menu, click File > Open.

The Open Log File dialog opens. 

2. Select the log file that is to be modified, and then click Open.

You return to the Progress page. By default, the first job in the log file is loaded into the 
Log File Wizard. Checkmarks are displayed next to the page links if the information has 
been added for the job. For example, if report setting files have been added for the first 
job, then a checkmark is displayed next to the Reports link.

3. Continue to one of the following:

• “To modify an existing job in the log file.”

• “To add a new job to a log file” on page 351.

• “To remove a job from a log file” on page 351.

To modify an existing job in the log file 

1. On the Jobs dropdown list that is to the right of the Progress Pane, select the job that is to 
be modified. 

The job is loaded into the Log File Wizard. A checkmark is displayed next to a page link 
if the information has been added for the job. For example, if report setting files have 
been added for the selected job, then a checkmark is displayed next to the Reports link.

2. Modify the information as needed for the loaded job.

The log file has the extension.log and you cannot change this.

To modify the name for the job, click Modify on the Progress page, and at the 
prompt, modify the name for the job. You can use the Next and Back buttons to 
move through the necessary pages for modifying the job, or you can double-click a 
page link in the Progress Pane to open the indicated page.
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3. After you have modified the information for the job, click OK on any page in the Log 
File Wizard. 

You return to the Progress page.

4. Click Save on the Progress page to save the modifications to the job.

To add a new job to a log file

1. On the Jobs dropdown list that is to the right of the Progress Pane, select New Job.

2. Click Modify.

3. At the prompt, enter the name for the new job. 

4. Click Next.

5. Add the information for the new job. 

6. After you have added the information for the new job, click OK on any page in the Log 
File Wizard. 

You return to the Progress page.

7. Click Save on the Progress page to save the new job to the log file.

To remove a job from a log file

1. On the dropdown list that is to the right of the Progress Pane, select the job that is to be 
deleted. 

2. Click Remove.

3. Click Yes at the prompt about removing the log file.

You return to the Progress page.

4. Click Save on the Progress page to save the changes to the log file.
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The Mutation AutoRun Tool
You use the Mutation AutoRun tool to carry out the batch analysis of multiple projects, 
where each project is referred to as a job. The function scans for queued files at a user-set 
interval. With this function, Mutation Surveyor can analyze up to 8 billion base pairs of data 
in eight hours.

To use the Mutation AutoRun tool

1. On the Mutation Surveyor main menu, click Tools > Mutation AutoRun 

The Mutation AutoRun window opens.

Figure 11-7:  Mutation AutoRun window

2. On the Mutation AutoRun toolbar, click the Settings icon .

The Mutation AutoRun Settings dialog box opens.

Figure 11-8:  Mutation AutoRun Settings dialog box

     

Remember, you can also use the Mutation AutoRun tool to schedule the processing 
of a project where the sample files have not yet been created. See “The Log File 
Wizard in the Mutation AutoRun Tool” on page 345.
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3. Specify the settings for the autorun.

4. Click OK to close the Mutation AutoRun Settings dialog box.

5. Click File > Detect.

On the specified date and time, Mutation Surveyor begins looking for unprocessed log 
files. It looks for these log files according to the specified time intervals, for example, 
every 10 minutes. When an unprocessed log file is detected, Mutation Surveyor opens 
the file and processes the project data according to the instructions detailed in the log 
file. Mutation Surveyor saves the data to the designated output (Work) folder.

Option Description

Log File Detecting 
Directory

The directory in which you saved the log file. See Step 7 and Step 8 of 
“To set up a new log file” on page 346 in “The Log File Wizard in the 
Mutation AutoRun Tool” on page 345.

Local Work Folder The temporary directory in which the analyzed data is being processed.

Time • Detect Time Interval—The time interval between searches. (When 
Mutation Surveyor searches for log files to process.)

• Start Detecting Time—The starting date and time for the search.

Minimize to Taskbar When the Mutation AutoRun function starts, it opens Mutation Surveyor. 
Select this option to automatically minimize the Mutation Surveyor 
window after it opens to the taskbar.
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Reviewing and Editing Mutation 
Projects

Mutation Surveyor automatically identifies mutations calls at positions where the variation 
between the reference trace and the sample trace meet or exceed detection thresholds. 
Mutation Surveyor also sometimes deletes mutation calls at positions that do not meet 
specific criteria. As a user, however, you have the option of manually adding or editing 
mutation calls in your mutation project, and you also have the option of overriding Mutation 
Surveyor’s automatic actions. You can also create a custom database of known deletions that 
are based on the variants in a selected mutation project, and you can then use this database in 
other mutation projects.

This chapter covers the following topics:

• “Adding Mutation Calls” on page 357.

• “Editing Mutation Calls” on page 364.

• “Annotating Reported Variations” on page 370.

• “Creating a User Knowledge Database for Known Deletions” on page 371.

• “Viewing the Edit History (Audit Trail) for a Mutation” on page 373.
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Adding Mutation Calls
Mutation Surveyor automatically identifies mutations calls at positions where the variation 
between the reference trace and the sample trace meet or exceed detection thresholds. 
Options are also available, however, for you to manually add mutation calls to a mutation 
trace. You can add substitution mutation calls, you can add homozygous mutation calls, and 
you can add heterozygous mutation calls.

To add a substitution

1. Open the mutation project in the GAD or in the Project Reviewer.

2. Right-click the mutation trace, and on the menu that opens, click Add Substitution.

The Add Substitution dialog box opens.

Figure 12-1:  Add Substitution dialog box

3. In the Mutation field, enter the mutation, and optionally, add comments for the added 
mutation.

Mutation Surveyor automatically calculates the optimal values for the mutation 
parameters such as intensity, area, and so on for the mutation based on the 
position of the mutation and you should not modify these values. When you add a 
substitution, it can be heterozygous (for example, A > AT), or it can be 
homozygous (for example, A > T).
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4. Optionally, to add multiple tags for the substitution, right-click anywhere in the db_xref 
pane, and on the context menu that opens, click Add Line. A new blank line for a tag and 
identifier is added to the pane. 

5. Click OK. 

The mutation trace is updated with the substitution. The Mutation table in the GAD and 
in the Project Reviewer are also updated to show this new mutation.

To add a homozygous indel call

1. Open the mutation project in the GAD.

2. Press and hold the [Ctrl] key, and then click the mobility line at the position of the indel 
in the mutation trace.

The Add Indel dialog box opens.

Figure 12-2:  Add Indel dialog box

3. Add the Indel call as appropriate.

• If you are adding a homozygous insertion, select Insertion on the Mutation Type 
dropdown list, and then in the Start of GenBank Index field, enter the positions that 
flank the insertion as two numbers delimited by an underscore. For example, 
30746_30747 means that an insertion exists between base 30746 and base 30747. 
The length of the insertion is determined by the Mutation Letters parameter.

• If you are adding a homozygous deletion, then in the Start of GenBank Index field, 
enter the actual positions of the deletion. For example, 30746_30748 means that 
three bases were deleted from the sample—the base at position 30746, the base at 
position 30747, and the base at 30748.
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4. Click OK. 

The mutation trace is updated with the homozygous indel. The Mutation table in the 
GAD is updated to show this new mutation.

To add or edit a heterozygous indel (The Het_Indel tool)

You use the Heterozygous Indel Detection tool (Het_Indel tool) to add or edit heterozygous 
mutation calls to a mutation trace. You can open the Het_Indel tool in one of two ways:

• Click the Detect Heterozygous Indels button  on the GAD toolbar. 

• Press and hold the [Ctrl] key, and then click the mobility line at the position of the indel 
in the mutation trace in the GAD to open the Add Indel dialog box, and then on the Add 
Indel dialog box, click Heterozygous Indel.

Figure 12-3:  Heterozygous Indel Detection window

The Heterozygous Indel Detection tool deconvolutes the mixed mutation trace into two clean 
traces. The Conserved trace shows the allele within the mixed trace that matches to the 
reference trace. The Mutant trace shows the allele within the mixed trace that does not match 
to the reference trace. The tool then estimates the percent contribution of conserved allele 

If you add a homozygous insertion and the bases that are inserted are identical the 
bases that precede them, then the mutation code is corrected in the Mutation table 
to reflect this duplication. See “Insertion, duplication, and deletion mutation 
codes” on page 133.
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and mutant allele. Mutation Surveyor uses several ideal peaks within the sample trace, 
determines the median height of the mutant allele at these locations and calculates the 
percent of mutant allele (M) as [M/(M+C)] and the conserved allele (C) as [C/(M+C)]. 
Finally, Mutation Surveyor repositions the mutant trace so that it aligns to the reference trace 
and then determines whether the mutation was a heterozygous insertion or a heterozygous 
deletion. The indel positions are numbered relative to the positions in the reference 
sequence, and not to the genomic positions in the GenBank file. You can use the functions 
that are available from the window’s toolbar for adding and editing heterozygous indel calls 
to the mutation trace. 

1. On the Heterozygous Indel Detection toolbar, click Mutation.

The Add/Edit Het-Indel dialog box opens.

Figure 12-4:  Add/Edit Het-Indel dialog box

2. On the Mutation Type dropdown list, select the mutation type.

     

When you add a heterozygous indel call to a trace or move the call upstream in the 
trace, the end of the comparison region is moved to the site of the heterozygous 
indel. As a result, all automatically added mutation calls that are downstream of 
the heterozygous indel are now outside of the comparison region and Mutation 
Surveyor deletes these calls. You can manually add mutation calls outside of the 
comparison region, but reliably automating these calls in these regions is not 
possible.

For a complete description of all the buttons on the Heterozygous Indel Detection 
toolbar, see “Heterozygous Indel Detection window toolbar” on page 362.
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3. Do one of the following:

• If you are adding a heterozygous insertion, then in the Start of GenBank Index field, 
enter the positions that flank the insertion as two numbers delimited by an 
underscore. For example, 135_136 means that an insertion exists between base 135 
and 136. The length of the insertion is determined by the Mutation Letters 
parameter.

• If you are adding a heterozygous deletion, then in the Start of GenBank Index field, 
enter the actual positions of the deletion. For example, 235_237 means that three 
bases were deleted from the sample—the base at position 235, the base at position 
236, and the base at position 237.

4. Click OK. 

Three results are possible:

• The mutation trace is updated with the insertion or deletion. The Mutation table in 
the GAD and in the Project Reviewer are also updated to show this new mutation.

• If Mutation Surveyor cannot deconvolute the mixed trace after you have added an 
insertion or deletion call because of poor trace quality, or because of the complexity 
of the call, then a warning message opens, indicating that Mutation Surveyor cannot 
display the mutation call as you have specified and asking you if you want to keep it. 
Click Yes to save the mutation call to the trace. The Mutation table in the GAD and 
in the Project Reviewer are also updated to show this new mutation.

• A message opens indicating that Mutation Surveyor was able to detect a different 
mutation call than the one specified and asking if you want to use Mutation 
Surveyor’s call. Click No to save the mutation call as you have specified it.

     

If you add a heterozygous insertion and the bases that are inserted are identical to 
the bases that precede them, then the mutation code is corrected in the Mutation 
table to reflect this duplication. See “Insertion, duplication, and deletion mutation 
codes” on page 133.
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Heterozygous Indel Detection window toolbar

The Heterozygous Indel Detection toolbar contains buttons that are specific for working with 
the display and for changing the information that is displayed.

Figure 12-5:  Heterozygous Indel Detection window toolbar

Option/Button Description

Zoom In—Zooms in on a region of the report for viewing.

Note: You can also manually zoom in on a region for viewing. Click and hold 
the left mouse button and draw a box from the upper left hand corner of 
the pane towards the lower right hand corner. A box is formed around the 
area that is being reduced for viewing.

Zoom Out—Zooms out from a region of the report for viewing. The magnification 
for zooming out is always 100%.

Note: You can also manually zoom out from a region for viewing. Click and hold 
the left mouse button and draw a box from the lower right hand corner of 
the pane towards the upper left hand corner. 

Show Lines—Provides options for showing all nucleotides in the traces and 
mutation traces, hiding all nucleotides in the traces and mutation traces, or 
showing only selected nucleotides in the traces and mutation traces.

Settings—Opens a menu that contains selections for the layout of the display and 
for navigating the display.

• Y auto—Clear this option to turn off the Y-axis auto-scaling for each of the 
traces.

• Mouse Zoom—Clear this option to turn off the mouse zooming functions. (You 
can use only the Zoom In and Zoom Out buttons to change the zoom level of 
the display.)

• Show Grid—Clear this option to remove the grid from the traces. 

Print Preview—Opens the Preview window, which displays a preview of what it to 
be printed for the Heterozygous Indel display. You can use the options on the 
Preview window’s toolbar to adjust variables such as the color scale and the page 
layout before you print the display.

Note: Before you click the Print Preview button, make sure to adjust the zoom 
level so that the area of the display that you want to print is displayed in 
the Preview window.

Auto Identify the Start—Runs a more rigorous detection algorithm for 
deconvoluting the mixed trace and aligning the mutant trace to the reference 
trace. 

Note: Typically, you run this algorithm if you think that Mutation Surveyor made 
an incorrect het_indel call, or that het_indel call is missing.

Mutation Opens the Add/Edit Het_Indel dialog box which contains options for adding or 
editing a het_indel call in a mutation trace. See “To add or edit a heterozygous 
indel (The Het_Indel tool)” on page 359 or “To edit heterozygous indels” on page 
366.
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Forward/
Reverse

Indicates the sample trace that is currently displayed in the window.

Option/Button Description
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Editing Mutation Calls
When you edit a mutation call, you can keep the mutation call type the same at the position, 
or you can change the call type at the position. If a mutation call of one type was made at a 
given position and you want to have a call of another type at the position, then you should 
first delete the original mutation call at the position, and then add the different type of 
mutation call at the position. You can edit substitution calls, you can edit homozygous indels, 
you can edit heterozygous indels, and you can edit Del/Ins.

To edit substitutions

You can edit a substitution call from the GAD or from the Project Reviewer.

1. Right-click the call in the Mutation table in the GAD, or in the Project Reviewer, and on 
the context menu that opens, click Edit.

The Edit Substitution dialog box opens.

Figure 12-6:  Edit Substitution dialog box

2. In the Mutation field, enter the mutation, and optionally, add comments for the modified 
mutation.

Mutation Surveyor automatically calculates the optimal values for the mutation 
parameters such as intensity, area, and so on for the mutation based on the 
position of the mutation and you should not modify these values. When you add a 
substitution, it can be heterozygous (for example, A > AT), or it can be 
homozygous (for example, A > T).
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3. Optionally, to add multiple tags for the substitution, right-click anywhere in the db_xref 
pane, and on the context menu that opens, click Add Line. A new blank line for a tag and 
identifier is added to the pane. 

4. Click OK. 

The mutation trace is updated with the substitution. The Mutation table in the GAD and 
in the Project Reviewer are also updated to show this new mutation.

To edit homozygous indels

You can edit a homozygous indel call from the GAD or from the Project Reviewer.

1. Right-click the call in the Mutation table in the GAD or in the Project Reviewer, and on 
the context menu that opens, click Edit.

The Edit Indel dialog box opens.

Figure 12-7:  Edit Indel dialog box

2. Edit the indel call as appropriate.

• If you are editing a homozygous insertion, then in the Start of GenBank Index field, 
enter the positions that flank the insertion as two numbers delimited by an 
underscore. For example, 30746_30747 means that an insertion exists between base 
30746 and base 30747. The length of the insertion is determined by the Mutation 
Letters parameter.

• If you are editing a homozygous deletion, then in the Start of GenBank Index field, 
enter the actual positions of the deletion. For example, 30746_30748 means that 
three bases were deleted from the sample—the base at position 30746, the base at 
position 30747, and the base at 30748.
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3. Click OK. 

The mutation trace is updated with the homozygous indel. The Mutation table in the 
GAD and in the Project Reviewer are also updated to show this new mutation.

To edit heterozygous indels

You use the Heterozygous Indel Detection tool (Het_Indels tool) to add or edit heterozygous 
mutation calls to a mutation trace. 

1. Do one of the following to open the Het_Indels tool:

• Double-click the het_indel call in the Mutation report to open the Heterozygous 
Detection tool.

• Click the Detect Heterozygous Indels button  on the GAD toolbar. 

• Press and hold the [Ctrl] key, and then click the mobility line at the position of the 
indel in the mutation trace in the GAD to open the Add Indel dialog box, and then on 
the Add Indel dialog box, click Heterozygous Indel.

Figure 12-8:  Heterozygous Detection window

     

If you add a homozygous insertion and the bases that are inserted are identical to 
the bases that precede them, then the mutation code is corrected in the Mutation 
table to reflect this duplication. See “Insertion, duplication, and deletion mutation 
codes” on page 133.
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2. On the Heterozygous Indel Detection toolbar, click Mutation.

The Add/Edit Het-Indel dialog box opens.

Figure 12-9:  Add/Edit Het-Indel dialog box

3. On the Mutation Type dropdown list, select the mutation type.

4. Do one of the following:

• If you are adding a heterozygous insertion, then in the Start of GenBank Index field, 
enter the positions that flank the insertion as two numbers delimited by an 
underscore. For example, 135_136 means that an insertion exists between base 135 
and 136. The length of the insertion is determined by the Mutation Letters 
parameter.

• If you are adding a heterozygous deletion, then in the Start of GenBank Index field, 
enter the actual positions of the deletion. For example, 235_237 means that three 
bases were deleted from the sample—the base at position 235, the base at position 
236, and the base at position 237.

5. Click OK. 

Three results are possible:

• The mutation trace is updated with the insertion or deletion. The Mutation table in 
the GAD and in the Project Reviewer are also updated to show this new mutation.

     

If you add a heterozygous insertion and the bases that are inserted are identical to 
the bases that precede them, then the mutation code is corrected in the Mutation 
table to reflect this duplication. See “Insertion, duplication, and deletion mutation 
codes” on page 133.
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• If Mutation Surveyor cannot deconvolute the mixed trace after you have added an 
insertion or deletion call because of poor trace quality, or because of the complexity 
of the call, then a warning message opens, indicating that Mutation Surveyor cannot 
display the mutation call as you have specified and asking you if you want to keep it. 
Click Yes to save the mutation call to the trace. The Mutation table in the GAD and 
in the Project Reviewer are also updated to show this new mutation.

• A message opens indicating that Mutation Surveyor was able to detect a different 
mutation call than the one specified and asking if you want to use Mutation 
Surveyor’s call. Click No to save the mutation call as you have specified it.

To edit Del/Ins

A Del/Ins is a combination of a deletion and an insertion at the same location. In many cases, 
you must edit such a mutation call to get the correct mutation call output. The following is a 
summary of the approaches that SoftGenetics recommends for adding and editing 
homozygous and heterozygous Del/Ins. 

To edit a homozygous Del/Ins

1. If no homozygous Indel was identified, then add the homozygous deletion as described 
in “To add a homozygous indel call” on page 358. 

2. At the same starting position, add the homozygous insertion as described in “To add a 
homozygous indel call” on page 358.

3. You might also need to delete substitutions that were falsely identified at these positions.

To edit a heterozygous Del/Ins

1. Do one of the following to pen the Heterozygous Indel Detection tool. 

• Double-click the het_indel call in the Mutation report to open the Heterozygous 
Detection tool.

• Click the Detect Heterozygous Indels button  on the GAD toolbar. 

• Press and hold the [Ctrl] key, and then click the mobility line at the position of the 
indel in the mutation trace in the GAD to open the Add Indel dialog box, and then on 
the Add Indel dialog box, click Heterozygous Indel.

2. Edit Mutation1 to the heterozygous deletion relative to reference trace positions.
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3. Add Mutation2 as the heterozygous insertion relative to reference trace positions.

Two results are possible:

• The mutation trace is updated with the insertion or deletion. The Mutation table in 
the GAD and in the Project Reviewer are also updated to show these modified 
mutations.

• If Mutation Surveyor cannot deconvolute the mixed trace after you have edited an 
insertion or deletion call because of poor trace quality, or because of the complexity 
of the call, then one of two warning messages opens:

• A warning message opens indicating that Mutation Surveyor cannot display the 
mutation call as you have specified and asking you if you want to keep it. Click 
Yes to save the mutation call to the trace. The Mutation table in the GAD and in 
the Project Reviewer are also updated to show these modified mutations.

• A warning message opens asking you if you want to use the mutation call that is 
automatically detected at the position. Click No to the save the mutation calls as 
you have specified them. The Mutation table in the GAD and in the Project 
Reviewer are also updated to show these modified mutations.

If you add a heterozygous insertion and the bases that are inserted are identical 
the bases that precede them, then the mutation code is corrected in the Mutation 
table to reflect this duplication. See “Insertion, duplication, and deletion mutation 
codes” on page 133.
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Annotating Reported Variations
You can annotate reported variations in a sample trace from the GAD or from the Project 
Reviewer report. Mutation Surveyor automatically modifies the GenBank file that is stored 
for the selected project with these annotations. 

To annotate a variation

1. Right-click the call in the Mutation table in the GAD, or in the Project Reviewer report, 
and on the context menu that opens, click Edit.

An Edit (mutation type) dialog box opens. The type of dialog box that opens depends on 
the type of mutation call that was selected for annotation (Substitution or Indel) but both 
dialog boxes have the lower db_xref pane. The pane is automatically populated with all 
the reported annotations for the position.

Figure 12-10:  db_xref pane

2. Optionally, to modify an existing annotation, select a new tag for it on the tag dropdown 
list. 

3. To add a new annotation, right-click in the pane, and on the context menu that opens, 
click Add a Line.

A new blank line is added for the annotation.

4. On the tag dropdown list, select a tag for the new annotation.

5. In the Identifier field, enter the identifier for the new annotation.

6. Click OK.

Mutation Surveyor automatically adds the new annotations to the GenBank file that is 
stored for the selected project.

Remember, a reported variant has a purple background in the Mutation table in 
the GAD and Project Reviewer report.

If you add an annotation in error, or want to delete an existing annotation, right-
click the annotation in the db_xref pane, and on the context menu that opens, click 
Delete a Line.

You can use the Extract SGP tool to export the updated GenBank file. See “Extract 
SGP Tool” on page 285.
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Creating a User Knowledge Database for 
Known Deletions

Mutation Surveyor automatically identifies mutations calls at positions where the variation 
between the reference trace and the sample trace meet or exceed detection thresholds. If, 
however, you know that a mutation is being called as the result of a false positive or a 
sequencing artifact, and the GenBank file that was used for the project contains chromosome 
information, then you can delete the called mutation and add this deletion to a User 
Knowledge database. For this User Knowledge database, a false positive and an artifact are 
defined as follows:

• A false positive is dependent on the chromosome position. As a result, this same variant 
is considered to be a false positive for all subsequent analyses.

• An artifact is dependent on not only the chromosome position, but also its relative 
location in the trace. For example, in one trace, a variant is located at the 5’ end of the 
trace, but in another trace, the same variant is located in the middle of the trace. As a 
result, if this variant is marked as an artifact in the trace where it was found at the 5’ end, 
the variant is not considered to be an artifact in the trace where it was located in the 
middle. 

You can use this custom database of known deletions in other projects. If a trace in a project 
has a mutation called at a position that has been identified as a false positive or artifact in the 
User Knowledge database, then Mutation Surveyor automatically flags the position, which 
streamlines the process of identifying variations of clinical significance for the project. 

To create a custom variant database for known deletions

1. Right-click the call in the Mutation table in the GAD or in the Project Reviewer, and on 
the context menu that opens, click Delete Mutation.

The Delete Mutation dialog box opens.

Figure 12-11:  Delete Mutation dialog box

For an artifact, the User Knowledge Database stores a range of positions, relative 
to location within a trace. This is more ideal for mutation calls that routinely 
occur at the beginning or end of an amplicon as a mutation call that is centered in 
an amplicon is more than likely to be a real mutation.
Mutation Surveyor User’s Manual 371



Chapter 12
Reviewing and Editing Mutation Projects
2. Do one of the following:

• To delete the mutation without adding it to the User Knowledge database, click OK.

• To add the mutation to the User Knowledge database, select Add to User Knowledge 
Database, and then complete the remaining steps in this procedure.

3. Leave the reason for the deletion set to the default value of False Positive, or select 
Artifact.

4. Click OK.

The Delete Mutation dialog box closes. The deleted mutation (position and reason) are 
saved to the User Knowledge database. If a trace in another project has a mutation called 
at this exact position, then Mutation Surveyor automatically flags this position.
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Viewing the Edit History (Audit Trail) for a 
Mutation

Analysis options are available for a mutation in a variety of locations in Mutation Surveyor, 
including various reports and displays and the context menus for the Mutation table and the 
GAD. Any edit action (addition, substitution, or deletion) that you carry out for a mutation is 
displayed in the Actions column for the mutation in the Mutation table and this action is also 
automatically added to the audit trail for the mutation. An option is available from all these 
locations to view the edit history for a mutation. To view the edit history for a mutation, 
right-click the mutation (for example, in the Mutation table), and on the context menu that 
opens, click View Edit History to open the Edit History dialog box.

Figure 12-12:  Edit History dialog box

The lower half of the Edit History dialog box displays all the edit operations that have been 
carried for the selected mutation. The date and time and the username for the user who 
carried out the edit is displayed for each edit. When you select an edit entry in the lower 
pane, a selected series of old and new values is displayed in the upper half of the dialog box. 
If the edit resulted in a change for a mutation value, then the old and new values are 
highlighted in red.
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